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1 S32 SDK
Introduction

This topic provides an introduction to the S32 software development kit (S32 SDK), including intended audience,
purpose and scope, and detailed sections on technical considerations.

[
Ll |

Copyright © 2016 NXP Semiconductor

Intended Audience

S32 SDK documentation is written for software developers and system engineers who have a technical background,
and a working knowledge of embedded programming. The audience for the S32 SDK are users of S32 Processors.

Purpose and Scope

The S32 SDK is a embedded oriented development kit. It allows users to
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1. Evaluate and explore the features of the S32 processors; experience how they are supported by working "out
of the box" on NXP development boards.

2. Develop embedded solutions; the NXP SDK is thoroughly tested from development to production.

S§32 SDK Architecture Overview

The S32 SDK is an extensive suite of robust hardware interface and hardware abstraction layers, peripheral drivers,
RTOS, stacks, and middleware designed to simplify and accelerate application development on NXP S32 SOCs.
The addition of Processor Expert technology for software and board configuration provides unmatched ease of use
and flexibility. Included in the S32 SDK is full source code under a permissive open-source license for all hardware
abstraction and peripheral driver software. See the Release Notes for details. The S32 SDK consists of the following
runtime software components written in C:

v
s
v
T
h=.
=

Low-level

Hardware

2 Components

Header file

Applications

D (e

Motor Control | Touch
| Sensing |

cAN | | Sacurity |

HFC
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The S32 SDK contains a device-specific header files which provide direct access to the peripheral registers. Each
supported device in S32 SDK has an overall System-on-Chip (SoC) memory-mapped header file. This header file
contains the memory map and register base address for each peripheral and the IRQ vector table with associated

vector numbers.
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Feature Header File

The PAL is designed to be reusable regardless of the peripheral configuration differences from one SOC device
to another. An overall Peripheral Feature Header File is provided for device to define the feature or configuration
differences for each SOC sub-family device.

Peripheral Abstraction Layer

The PAL provides unified interfaces for families of peripherals, allowing for cross-platform compatibility of application
code. The main goal is to provide an application programming interface that is independent of the underlying
peripheral implementation.

The PAL supports all instances of each peripheral from a certain family instantiated on the SOC by using a simple
integer parameter for the peripheral instance number.

The PAL instances should be configured bearing in mind possible limitations of the underlying peripherals - some
features may not be supported on some hardware modules. It is the user's responsibility to correctly handle hard-
ware resources, especially when porting the application to a different platform.

The PAL drivers can be found in the platform/pal directory.

Peripheral Drivers

The Peripheral Drivers are high-level drivers that implement high-level logic transactions based on an internal reg-
ister access abstraction layer, other Peripheral Drivers, and/or System Services. For example, the UART register
access abstraction layer mainly focuses on byte-level basic functional primitives, while the UART Peripheral Driver
operates on an interrupt-driven level using data buffers to transfer a stream of bytes. In general, if a driver, that
is mainly based on one peripheral, interfaces with functions beyond the register access abstraction layer and/or
requires interrupt servicing, the driver is considered a high-level Peripheral Driver.

The Peripheral Drivers support all instances of each peripheral instantiated on the SOC by using a simple integer
parameter for the peripheral instance number.The user of the Peripheral Driver does not need to know the peripheral
memory-mapped base address.

The Peripheral Drivers operate on a high-level logic that requires data storage for internal operation context handling.
However, the Peripheral Drivers do not allocate this memory space. Rather, the user passes in the memory for the
driver internal operation through the driver initialization function.

The Peripheral Drivers are designed to handle the entire functionality for a targeted use-case. An application should
be able to use only the Peripheral Driver to accomplish its purpose.

The Peripheral Drivers can be found in the platform/drivers directory.

System Services

The System Services contain a set of software entities that can be used by the Peripheral Drivers. They may be
used with PAL Drivers to build the Peripheral Drivers or they can be used by an application directly. The following
sections describe each of the System Services software entities. These System Services are in the platform/drivers
directory.

Interrupt Manager

The Interrupt Manager provides functions to enable and disable individual interrupts within the Nested Vector In-
terrupt Controller (NVIC). It also provides functions to enable and disable the ARM core global interrupt (via the
CPSIE and CPSID instructions) for bare-metal critical section implementation. In addition to providing functions for
interrupt enabling and disabling, the Interrupt Manager provides Interrupt Service Routine (ISR) registration that
allows the application software to register or replace the interrupt handler for a specified IRQ vector. The drivers do
not set interrupt priorities. The interrupt priority scheme is entirely determined by the specific application logic and
its setting is handled by the user application. The user application manages the interrupt priorities.
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Clock Manager

The Clock Manager provides centralized clock-related functions for the entire system. It can dynamically set the
system clock and perform clock gating/un-gating for specific peripherals. The Clock Manager also maintains knowl-
edge of the clock sources required for each peripheral and provides functions to obtain the clock frequency for each
supported clock used by the peripheral. The Clock Manager provides a notification framework which the software

components, such as drivers, uses to register callback functions and execute the predefined code flow during the
clock mode transition.

Power Manager
The Power Manager provides centralized power-related functions for the entire system. It dynamically sets the sys-

tem power mode. The Power Manager provides a notification framework which the software components, such as
drivers, uses to register callback functions and execute the predefined code flow during the power mode transition.

Examples

The examples provided show how to build user applications using the S32 SDK. The examples can be found in the
top-level example directory. For details please see Examples_and_Demos .

3 PAL vs PD usage

PAL - Peripheral Abstraction layer

* Interface abstraction for a family of peripherals (E.g. LPUART + LINFlexD_UART + eSCI + FlexlO_UART +
etc.)

« Single layer per SDK

« Same generic API on multiple platforms

PD - Peripheral Drivers
* |P dedicated low-level drivers

» Designed for efficiency and IP features set coverage

When to use the Peripheral Abstraction Layer (PAL)?

» Whenever an application needs a simplified, generic interface that abstracts as much as possible the under-
lying silicon features.

» Whenever developing portable higher level generic code that is meant to run on different NXP platforms. This
may include anything from low level console utility libraries to communication stacks like TCP/IP.

When to use Peripheral Drivers?

» Whenever developing for high efficiency (code size, execution speed, etc.) or planning to use specific periph-
eral features.

4 Supported Platforms

Supported board and SoC versions can be found in the Release Notes. (SDK\ReleaseNotes.pdf)
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5 Installation

Prerequisites

SDK can be used in two ways: bundled in S32 Design Studio and standalone.
S32 SDK is delivered bundled in the S32 Design Studio. In this case it's already configured and ready to use.

S32 SDK is also delivered through a standalone installer. Using the standalone installer is recommended when
using a compiler which is not supported in S32 Design Studio or when the graphical interface is not required. In this
case the installer can configure an existing S32 Design Studio to use the configuration files delivered in the installer.

If the integration with the S32 Design Studio is not needed the path to S32 Design Studio can be left empty — and
in this case only the S32 SDK will be installed and configured.

Steps

1. Start the installer S32_SDK_<ReleaseSpecifc>.exe

2. Set the destination folder for the SDK, give optional location of S32DS and install. Example of S32DS path:
C:\NXP\S32ARMv1.3

3. Start using the SDK by creating a new project or importing a project

Background
The installer does the following things in background:

+ Puts the SDK in the selected destination directory.
» Appends to S32SDK_PATH the path of the SDK.

— Note: Please make sure you uninstall previous SDK so that this variable will be empty.
» Copies necessary files into S32 Design Studio installation location.

» Overwrites existing SDK from S32 Design Studio with the version from destination directory

Uninstaller

When the SDK is installed using the standalone the installer, the user can use "uninst.exe" from the root of the
destination to uninstall the SDK.

Note: If you want to reinstall the SDK please use a clean copy of S32DS. When you uninstall this does not delete
the copied files (ex: Config_01.pez), so a clean copy is needed.

6 Build Tools

Introduction
S32 SDK supports and is tested with multiple compiler toolchains.

Note

The toolchain list, versions and their options specific for the platform and release can be found in the Release
Notes. (SDK\ReleaseNotes.pdf)
Toolchain versions and options can be found in the Release Notes. (SDK\ReleaseNotes.pdf)
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Compiler warnings disabled for $32 SDK

For Wind River DIAB Compiler the following warnings are not checked at S32 SDK build time:

« #1824: explicit cast discards volatile qualifier
Motivation: this warning has been deactivated because of false positive occurrences reported for Wind River
DIAB Compiler 5.9.4.8 under tickets TCDIAB-13994, TCDIAB-14098.

« #5387: explicit conversion of a 64-bit integral type to a smaller integral type (potential portability problem)
Motivation: this warning has been disabled because it is reported for conversions required by the internal
SDK algorithms. Intermediary results requiring high precision are stored as uint64_t variables and converted
into uint32_t variables. Checks have been put in place to ensure that the cast is only done if the value to be
converted fits on 32 bits.

» #5388: conversion from pointer to same-sized integral type (potential portability problem)
Motivation: for S32 SDK conversions between uint32_t and memory addresses are made assuming that
pointers are stored on 32bits.

Makefiles

Multiple makefile projects are provided in the 'examples' folder, for all supported compilers. These projects can be
modified by adding application code, or the makefiles can be reused in different projects, after reconfiguring the
paths/variables. Please note that these projects require the designated compiler to be already installed on the host;
also, the makefile path to compiler executable must be updated before running make utility.

$32 Design Studio

S32 Design Studio is delivered with platform specific gcc cross compiler included ("{S32_Design_Studio_install_«
path}\Cross_Tools). Eclipse plugins for gcc are already installed in S32 Design Studio IDE, so new projects for this
toolchain can be created and built directly from the IDE. To add S32 SDK source files to a clean S32 Design Studio
project, eclipse "linked resources” feature can be used: project properties->New->Folder->Advanced->'Link to
alternate location' (e.g. "{S32_SDK_PATH}"). For S32 Design Studio project with Processor Expert support, please
import a project from "{S32_SDK_PATH} Name".

7 IDE Support

$32 Design Studio

» S32 Design Studio is delivered with Processor Expert support included. Please see Configuration chapter.

+ To configure the S32 SDK path of the project, eclipse "S32 SDK Specific" feature can be used: patch project
properties->Processor Expert->S32 SDK Specific->SDK path

» Processor Expert repositories and paths can be configured as it follows: Window -> Preferences -> Proces-
sor Expert -> Repositories and Paths.

» S32 Design Studio projects can be imported from S32 SDK package. Please see Examples_and_Demos
chapter.

IAR Embedded Workbench

« NOT applicable to platforms which do not support IAR compiler. Please see Release Notes.
+ There is no configuration support for S32 SDK in IAR.

* IAR Embedded Workbench projects can be imported from S32 SDK package. Please see Examples_and«
_Demos chapter.
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8 Configuration

Processor Expert software allows generation of configuration structures for peripheral drivers from S32 SDK. With
the help of Eclipse based graphical interface where you can configure your driver and generate corresponding
configuration structure. This tool doesn't generate source code for S32 family, it only generates configurations data
structures.

Processor Expert generates configuration header files that are included by application source code. The configu-
ration data structures from these files are defined in S32 SDK. All these header files are generated by this tool in
${ProjName}/Generated_Code directory.

Peripheral drivers are not stored directly in the project directory, these drivers are stored in S32 SDK repository.
Shared peripheral drivers repository is advantageous when more projects should share the same version of pe-
ripheral drivers. In this case, peripheral drivers are not physically placed in the project directory but each project is
virtually linked with shared, common repository from S32 SDK. This way the management of the projects’ drivers
can be done in one place and any changes made in the shared repository is automatically distributed across all of
the linked projects, for example in case of bug fixing or library update and also backup or archiving of the peripheral
drivers versions is very simple.

9 Acronyms and Abbreviations

Acronym Description

CPSIE, CPSID Change Processor State Interrupt Enable / Disable
EAR Early Access Release

EVB Evaluation board

PAL Peripheral Abstraction Layer

IRQ Interrupt Request

ISR Interrupt Service Routine

LLWU Low Leakage Wakeup Unit

NVIC Nested Vector Interrupt Controller

RTOS Real Time Operating System

S32DS S32 Design Studio

SDK Software Development Kit

SOC System-on-Chip

UART Universal Asynchronous Receiver / Transmitter

10 MISRA Compliance

This section describes how the S32 SDK project addresses MISRA Compliance.
The S32 SDK SW components which are implemented to be compliant with MISRA C 2012 are:

« all drivers & PALs
+ generated driver code (including Cpu.c & .h)

* main.c (generated via graphical configurator)

Violations of MISRA C 2012 guidelines which remain not fixed, shall be documented as deviations at file level.

Other SW components included in the S32 SDK package which are not subject to MISRA C 2012 compliance:

» demo_apps & driver examples

* FreeRTOS
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11 Development guidelines

Set of guidelines to improve the usability of the S32 SDK.

Some usual guidelines on SDK programming model:

1. Driver state structures should be declared as global or static variables as they are used in the whole time
when the driver is used.

2. Driver state structures content should not be used or modified by the application code.

3. Peripheral drivers, PALs and Middleware code are not handling clock and pins initialization. Configuration of
the clock and pins driver has to be done by the application.To make sure these are properly initialized before
other modules are used, please call the corresponding initialization:

/+ Initialize and configure clocks =/
CLOCK_SYS_TInit (g_clockManConfigsArr, CLOCK_MANAGER_CONFIG_CNT,
g_clockManCallbacksArr, CLOCK_MANAGER_CALLBACK_CNT);

CLOCK_SYS_UpdateConfiguration (0U,
CLOCK_MANAGER_POLICY_AGREEMENT) ;

/+ Initialize pins */
PINS_DRV_Init (NUM_OF_CONFIGURED_PINS, g_pin_mux_InitConfigArr);

Note

The configuration structure names used in this example are the default names generated by Processor
Expert components for clock and pins. Applications not using Processor Expert might have different
names for these structures.

4. The recommended approach at development time is to add DEV_ERROR_DETECT symbol to the compiler
defines. This will enable DEV_ASSERT mechanism which can catch application code errors in the early
development stage.

5. High care should be taken to have a backup option when debug pins are routed to other functionalities.

12 Error detection and reporting

S32 SDK drivers can use a mechanism to validate data coming from upper software layers (application code) by
performing a number of checks on input parameters' range or other invariants that can be statically checked (not
dependent on runtime conditions). A failed validation is indicative of a software bug in application code, therefore it
is important to use this mechanism during development.

The validation is performed by using DEV_ASSERT macro. A default implementation of this macro is provided
in this file. However, application developers can provide their own implementation in a custom file. This requires
defining the CUSTOM_DEVASSERT symbol with the specific file name in the project configuration (for example:
-DCUSTOM_DEVASSERT="custom_devassert.h")

The default implementation accommodates two behaviors, based on DEV_ERROR_DETECT symbol:

+ When DEV_ERROR_DETECT symbol is defined in the project configuration (for example: -DDEV_ER«
ROR_DETECT), the validation performed by the DEV_ASSERT macro is enabled, and a failed validation
triggers a software breakpoint and further execution is prevented (application spins in an infinite loop) This
configuration is recommended for development environments, as it prevents further execution and allows
investigating potential problems from the point of error detection.

* When DEV_ERROR_DETECT symbol is not defined, the DEV_ASSERT macro is implemented as no-op,
therefore disabling all validations. This configuration can be used to eliminate the overhead of development-
time checks.

It is the application developer's responsibility to decide the error detection strategy for production code: one can
opt to disable development-time checking altogether (by not defining DEV_ERROR_DETECT symbol), or one can
opt to keep the checks in place and implement a recovery mechanism in case of a failed validation, by defining
CUSTOM_DEVASSERT to point to the file containing the custom implementation.
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13 Examples and Demos

Applications that show the user how to initialize the peripherals for the basic use cases

13.1 Introduction

S32 SDK examples structure:

» Demo Applications (SDK/examples/<CPU>/demo_apps), are demo applications for various IDEs and com-
pilers. Also this examples are using more advanced use-cases - FreeRTOS integration, LIN Stack, FlexCAN
usage and Clock Setup.

+ Driver Examples (SDK/examples/<CPU>/driver_examples), are simple applications which exemplify a basic
use-case for a specific driver.

13.2 Usage
13.2.1 How to build

For makefile project

There are makefile projects in all compilers supported. In order to used them:

+ Make utility (eg. GNU Make)
* Toolchain (eg. GCC Toolchain)

» Make sure the make and compiler are in Path (for Microsoft Windows : System -> Environmental
Variables)

* From command line execute the makefile: make all

The makefiles generate binary files for both RAM and FLASH configurations.
For IAR Embedded Workbench

From IAR Workbench for ARM use File > Open > Workspace and browse to the desired project. After the project
was opened you can see the files in "Workspace Files". Finally, the project can be executed from Project > Down-
load and Debug. Make sure that the debug probe you are using is selected and configured in Project options >
Debugger > Driver.

For S32 Design Studio

From S32 Design Studio (See Release notes for the S32 Design Studio version), go to File -> New -> New Project
from Example and select the example you wish to import. This will copy the example project into workspace. Next
steps:

» Examples will run without an active configuration, however if any changes are required, a configuration needs
to be generated. Use Open S32 Configuration button, make the desired changes (if any) then click on the
"Update Code" button.

» Use Project > Build to build the project

+ Use Project > Debug and launch your preferred debug configuration
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13.2.2 How to debug

This section explains how to upload and debug the binary files generated after build. This assumes that you have a
debug probe(see release notes for supported debug probes) and a debug software installed on the machine.

Generic steps:

1. Launch the debug software
2. Load the binary file into the MCU

3. Execute the application
Loading with PEmicro OpenSDA/MultiLink:

« Download and install the latest drivers and GDB server, named P&E GDB Server for Kinetis with Windows
GUI, from their site

» Download your favorite GDB client (eg. arm-none-eabi-gdb)

+ Browse to PEmicro GDB Server installation folder and launch P&E GDB Server for Kinetis
« Select the appropriate part from the device list and click on Connect

» Open the GDB client and connect to the configured port - by default localhost:7224

» Upload the file and execute (see GDB client user manual for details regarding the commands used)

The following table is a small list of commands used in GNU ARM GDB with PEmicro GDB server to connect and
run the application:

Command Description

target remote:PortNumber Connect to the remote target at a specified port.
Please replace PortNumber with the port configured
in the GDB server.

monitor reset Reset the target MCU

file ApplicationName.elf Load the file and symbols. Please change
ApplicationName with your application name

load Download the executable to the target MCU

continue Begin executing the application

13.2.3 Using terminal emulator

To run the examples that use LPUART to help you visualize data you must download a terminal emulator (eg. Putty,
Termite, TeraTerm) and configure it.

Unless otherwise noted the standard communication parameters are:

115200 baud

» One stop bit

+ No parity

+ No flow control
Example configuration for Termite using OpenSDA
1) Download Termite from their site

2) Run the installer. Wait for the installation to be completed
3) Go to Start -> All Programs -> Termite and launch the program. The window from Fig.1 will appear ...
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Disconnected - didk to connect ]- Clear | | About || Close |
Local HE EE  pemote

DTR E-'TS IJSH:

Failed to initialize the port.
Please werify the COM port settings.

window

4) Click on Settings
5) As seen in Fig.2, configure the following communication parameters:

* Port(1) : COMx - where x must be replaced with the COM port number

Baud Rate(2) : 115200

Data Bits(3) : 8

Stop Bits(4) : 1

Parity(5) : None

Flow Control(6) : None

Forward(7) : None

Serial port settings

Port configuration Transmitted text Options
Port coMis - 1 (") Append nothing [ stay on top
() Append CR Quit on Escape

Baud rate 115200 ~ 2 i@ Append LF Autocomplete edit line

Data bits 3 () Append CRAF Keep history
Local echo [] Close port when inactive

Received text

Flug-ns
L _ none | 5 poling [100 ms ] Auto Reply
covcntl [pne__=] 6 ron Flfwcionters (]

|:| Hex View
Forward naone » 7 [C]word wrap [ Highlight -
User interface language English (en) - [ Cancel ] [ Ok ]
— Settings window

6) Click OK. Now the terminal should be configured
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Note

For further help consult the terminal's documentation

13.3 Demo Applications

Applications that show more advanced use cases

Available demo applications:
Click on one of the project to see the corresponding documentation

« ADC Low Power

+ CSEC BOOT PROTECTION

» Hello World - Makefile

* FreeMASTER

* FreeRTOS

« Hello World

+ AMMCLib

« Structural Core Self Test Example

« Hello World

+ LIN MASTER

+ LIN SLAVE

13.3.1 ADC Low Power

Demonstrates ADC trigger scheme using TRGMUX and LPIT, switches the power mode to stop and sends data
using LPUART and DMA

Application description

The purpose of this demo application is to show you the usage of a subset of the peripherals found on the S32«
K144W SoC.

» The application uses LPIT to trigger ADC conversions every 100ms via TRGMUX with the CPU in sleep
mode. The ADC is using Hardware Compare feature to validate an conversion only if the value is greater than
half of the reference voltage, in this case VDD/2. This way the CPU is woken up from sleep mode only if the
condition is met.
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* When the conversion is complete the data is transformed into a bar graph and it is sent via LPUART using
DMA memory to peripheral transfer to the host PC. This way, the CPU can be put into a low power mode to
reduce the energy used.

How the example works:

» Connect to the serial port using settings found in Notes section

» The user should receive a welcome message on the terminal emulator, with application details (user can refer
the message in the main.c file)

» The value of Vref will display
» The user must press "A" or "a" for the example to run

+ The potentiometer(R44 - connected to ADC1 channel 10) must be rotated in order to generate valid ADC
conversions

» Once a valid conversion is done then a bargraph will be printed on the terminal emulator, like: "Start-
ing example ... Move potentiometer to get a bargraph and some information displayed. ADC1-CH10
[HHHHEHEHEHEHEHHEHHEHEHEHEHAEHEHE Vin=4034mV Raw=4095"

Prerequisites

To run the example you will need to have the following items:

1 XS32K14WEVB-Q064 board

» 1 Power Adapter 12V

» 1 Personal Computer

* 1 PEMicro Multilink Debugger

» 1 USB Type-B cable for UART connect to J16 on mother board

Boards supported
The following boards are supported by this application:

» Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
* Mother Board S32K-MB PCB RevA SCH RevB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION S32K14xCVD-Q064 PCB XS32K14WEVB-Q064
ADC POT ADC1 Channel 10 (PTE2) - wired ADCO Channel 9 (PTC1) - wired
on the board on the board

Make sure the following jumpers are set:

Jumper Name | S32K-MB
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JP20 Set jumper on position 1-2

JP20 Set jumper on position 4-5

JP21 Set jumper on position 1-2

Jumper Name XS32K14WEVB-Q064

J10 Set jumper on position 2-3
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New -> S32DS Project From and select adc_low_power_<«
s32k144w. Then click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration was initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs to
be generated. The initial configuration will have the same settings as the default example settings. Right click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configuration (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built RAM (Debug_RAM) or FLASH (Debug_FLASH) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description

adc_low_power_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

adc_low_power_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

Notes

For this example it is necessary to open a terminal emulator and configure it with:

115200 baud
» One stop bit
* No parity

* No flow control
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13.3.2 CSEC BOOT PROTECTION

Basic application that presents the boot protection functionality of the CSEc module

Note

This example works only for CSEc enabled parts. SIM_SDID indicates whether CSEc is available on your
device.

The first time when running the example on the board, or after a key erase, this example should be ran
from RAM.

After the user key was loaded using this example, any further full erase of the Flash requires a
Challenge-Authentication process. This can be done by setting the FLASH_MODIFY macro to 1.

After partitioning Flash for CSEc operation, using the JLink Flash configuration of any other project
will not work anymore. Workaround:

* Run csec_boot_protection example with FLASH_MODIFY 1, using PEmicro Flash debug configuration

Application description

The purpose of this demo application is to show the user how to use the boot protection feature of the Cryptographic
Services Engine module from the S32K144W MCU with the S32 SDK API.

The implementation demonstrates the following:

2.

the enablement of the CSEc module, by showing how the Flash should be partitioned (using the Flash driver);

configuring the MASTER_ECU key;

configuring the first user key, using the MASTER_ECU key as an authorization with boot protection enabled;

configuring and enabling secure boot;

availability of the user key after a secure boot when the flash was modified or not.

Erasing all the configured keys (including the MASTER_ECU key) and disabling the secure boot can be done
by changing the value of the FLASH_MODIFY macro to 1. This will place the part back into factory status
(the partition command will need to be run again).

Here is a table describing the outcome based on the value of FLASH_MODIFY and if the FLASH_TARGET
is defined:

FLASH_MODIFY FLASH_TARGET Result
0 UNDEFINED Write initial code to flash
1 UNDEFINED Write modified code to flash
0 DEFINED Write keys and enable secure
boot
1 DEFINED Erase keys and partition flash

Application usage

. The first step is to run the application from RAM having the FLASH_MODIFY macro set to 1 in order to

partition the flash. After this step, comment the #define INIT_PHASE line

Load the test program to it by setting the FLASH_MODIFY to 0 and running the application from FLASH.
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3. Run the application from RAM with the FLASH_MODIFY macro set to 0 in order to load the keys necessary
for secure boot and the test key with boot protection enabled.

4. Run the application from FLASH with the FLASH_MODIFY macro set to 0 in order to test secure boot. The
secure boot process and the encryption using the test key should be successful.

5. Run the application from FLASH with the FLASH_MODIFY macro set to 1 this time in order to modify the
flash. This will result in the secure boot to fail and the test key will be unavailable so the encryption operation
will be unsuccessful.

6. Run the application from FLASH with the FLASH_MODIFY macro set to 0 in order to successfully secure
boot. The test key is available again and the encryption operation is successful.

7. Set the FLASH_MODIFY macro to 1 and run the application from RAM in order to erase the keys and flash.

Note

If the FLASH_MODIFY is set to 1 at step 2 then the secure boots after the step 3 will be successful only
if the FLASH_MODIFY macro is set to 1 and unsuccessful if it is set to 0.

If an assert fails at step 3, start over at step 1, decommenting the #define INIT_PHASE line and setting
FLASH_MODIFY to 1.

Prerequisites

To run the example you will need to have the following items:

+ 1 XS32K14WEVB-Q064 board
» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 1 Personal Computer

* 1 PEmicro

Boards supported

The following boards are supported by this application:

+ S32K14xCVD-Q064 with S32K-MB

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION XS32K14WEVB-Q064 S32K14xCVD-Q064 with
S32K-MB

LED_RED (PTCO) LEDO - wired on the board

LED_GREEN (PTC1) LED1 - wired on the board

LED_RED (PTEO) RGB_RED - wired on the board

LED_GREEN (PTE7) RGB_GREEN - wired on the board
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How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From and select csec_boot_protection_«
s32k144w. Then click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration was initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built RAM (Debug_RAM) or FLASH (Debug_FLASH) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description
csec_boot_protection_s32k144w_debug_ram_« Debug the RAM configuration using PEMicro
pemicro debuggers
csec_boot_protection_s32k144w_debug_flash_« Debug the FLASH configuration using PEMicro
pemicro debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.3.3 Hello World - Makefile

Basic application that presents the project scenarios for S32 SDK using makefiles for various compilers

Application description

The purpose of this demo is to provide the user with an out-of-the box example application for S32K144W platform,
using S32 SDK. The demo uses Pins and Clock driver to initialize the MCU and to toggle two LEDs alternatively.

There are five projects delivered with this package:

» Makefile project (GCC compiler)
+ Makefile project (GHS compiler)
» Makefile project (IAR compiler)

» Makefile project (DCC compiler)
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+ Makefile project (ARM compiler)

Note

For information about how to run the makefile please refer to Usage

Prerequisites
To run the example you will need to have the following items:

« 1 XS32K14WEVB-Q064 board
» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 1 Personal Computer

* 1 PEmicro

Boards supported
The following boards are supported by this application:

+ XS32K14WEVB-Q064

+ S32K14xCVD-Q064 with S32K-MB

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION XS32K14WEVB-Q064 S$32K14xCVD-Q064 with
S32K-MB

LED1 (PTEO/PTCO) RGB_RED - wired on the board LED_O0 - JP49 (wired on the board)

LED2 (PTE7/PTC1) RGB_GREEN - wired on the board | LED_1 - JP50 (wired on the board)

13.3.4 FreeMASTER

Example application showing FreeMASTER Serial Communication usage

Application description
The purpose of this demo application is to show you how to use the FreeMASTER serial communication using
S32K144W on OpenSDA with this SDK.

This demo uses the FreeMASTER Run-Time Debugging Tool to visualise ADC conversions and allows the user to
monitor the ADC sampling rate for different ADC configurations (ADC sampling time and resolution can be controlled
through FreeMASTER Application Commands).

The ADC is configured to perform continous conversions and generate an interrupt after each conversion. The
LPTMR is configured to generate a periodic interrupt at 10 ms which reads the number of ADC conversions.

Prerequisites
To run the example you will need to have the following items:

« 1 S32K144W board
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* 1 Power Adapter 12V

» 1 Dupont male to male cable

» 1 Personal Computer

» Debug probe (JLink, PEmicro, OpenSDA)

» FreeMASTER host application

Boards supported
The following boards are supported by this application:

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION XS32K14WEVB-Q064
LPUART1 TX (PTC9 UART_TX - wired on the board
LPUART1 RX (PTC8 UART_RX - wired on the board
ADCO Input 9 (PTC1) POT - wired on the board

-

-

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New -> S32DS Project From and select freemaster_s32k144w.
Then click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration was initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built RAM (Debug_RAM) or FLASH (Debug_FLASH) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description
freemaster_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers
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freemaster_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Open the FreeMASTER project (freemaster_s32k144w.pmp) and set the communication parameters:

» Go to Project -> Options -> Comm, choose Direct RS232 and set the COM port and speed 9600.

+ Go to Project -> Options -> MAP Files and make sure the x.elf file of your project's current Debug Config-
uration is selected and set file format to ELF/DWARF.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

Notes

FreeMASTER host application can be downloaded from NXP's website. FreeMASTER Serial Communication is
included into the project (V2.0).

13.3.5 FreeRTOS

Demo application showing the integration of FreeRTOS and S32 SDK

Application description

The purpose of this demo application is to show you how to use the FreeRTOS with the S32 SDK for the S32K144W
MCU.

This project defines a very simple demo that creates two tasks, one queue, and one timer. It also demonstrates
how Cortex-M4 interrupts can interact with FreeRTOS tasks/timers.

The idle hook function: The idle hook function demonstrates how to query the amount of FreeRTOS heap space
that is remaining (see vApplicationldleHook() defined in this file).

The main() Function: main() creates one software timer, one queue, and two tasks. It then starts the scheduler.

The Queue Send Task: The queue send task is implemented by the prvQueueSendTask() function in this file. prv«
QueueSendTask() sits in a loop that causes it to repeatedly block for 200 milliseconds, before sending the value 100
to the queue that was created within main(). Once the value is sent, the task loops back around to block for another
200 milliseconds.

The Queue Receive Task: The queue receive task is implemented by the prvQueueReceiveTask() function in this
file. prvQueueReceiveTask() sits in a loop that causes it to repeatedly attempt to read data from the queue that
was created within main(). When data is received, the task checks the value of the data, and if the value equals
the expected 100, toggles LEDO. The 'block time' parameter passed to the queue receive function specifies that the
task should be held in the Blocked state indefinitely to wait for data to be available on the queue. The queue receive
task will only leave the Blocked state when the queue send task writes to the queue. As the queue send task writes
to the queue every 200 milliseconds, the queue receive task leaves the Blocked state every 200 milliseconds, and
therefore toggles LEDO every 200 milliseconds.

The LED Software Timer and the Button Interrupt: The user button BTNO is configured to generate an interrupt
each time it is pressed. The interrupt service routine switches LED1, and resets the LED software timer. The LED
timer has a 5000 millisecond (5 second) period, and uses a callback function that is defined to just turn the LED off
again. Therefore, pressing the user button will turn the LED on, and the LED will remain on until a full five seconds
pass without the button being pressed.
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Prerequisites

To run the example you will need to have the following items:

1 S32K144W board

» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 2 Dupont male to male cable

» 1 Personal Computer

* 1 PEMicro Multilink Debugger (optional, users can use Open SDA)

Boards supported
The following boards are supported by this application:

+ XS32K14WEVB-Q064

+ S32K14xCVD-Q064 with S32K-MB

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION

XS32K14WEVB-Q064

S§32K14xCVD-Q064

S32K-MB

LEDO (PTD15)

RGB_RED - wired on

LEDO - wired on the

JP49.1 - JP49.2

board board
LED1 (PTD16) RGB_GREEN - wired on | LED1 - wired on the JP50.1 - JP50.2
board board

BTNO (PTC13)

SW2 - wired on board

BTNO - wired on the
board

JP39.1 - JP39.2 and
J70.1 - J70.2 and J69.2 -

J69.3

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New -> S32DS Project From and select freertos_s32k144w.
Then click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration to be initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code"

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.
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4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:
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Configuration Name Description

freertos_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

freertos_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.3.6 Hello World

Basic application that presents the project scenarios for S32 SDK

Application description

The purpose of this demo is to provide the user with an out-of-the box example application for S32K144 platform,
using S32 SDK. The demo uses hardware abstraction layer primitives for PCC and PORT modules in order to toggle
two LEDs alternatively.

Prerequisites

To run the example you will need to have the following items:

1 XS32K14WEVB-Q064 board

+ 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 1 Personal Computer

* 1 PEmicro

Boards supported

The following boards are supported by this application:

+ XS32K14WEVB-Q064

+ S32K14xCVD-Q064 with S32K-MB

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION XS32K14WEVB-Q064 S32K14xCVD-Q064 with
S32K-MB

LED1 (PTEO/PTCO) RGB_RED - wired on the board LED_0 - JP49 (wired on the board)

LED2 (PTE7/PTC1) RGB_GREEN - wired on the board | LED_1 - JP50 (wired on the board)
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How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New -> S32DS Project From and select hello_world_s32k144w.
Then click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration was initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built RAM (Debug_RAM) or FLASH (Debug_FLASH) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description

hello_world_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

hello_world_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.3.7 AMMCLib

Provides an example of integration of AMMCLib and S32 SDK

Application description

The purpose of this demo application is to show you how to integrate the S32 SDK with AMMCLib.

The application starts by sending a welcome message to the terminal with instructions regarding how to select
between the two parts:

1. The first part:
» The board sends a welcome message to the console with the supported operations and how to return
to the menu.
* It uses LPUART to communicate with the user and get the simple mathematical expressions.

» The received expression is then interpreted and the result is calculated using mathematical functions
from AMMCLIib and then sent back to the terminal as a floating point with a precision of 4.

Generated on Fri Jun 11 2021 08:14:09 for S32SDK User Manual by Doxygen



13.3 Demo Applications 25

2. The second part:

» The board sends a welcome message to the console with further instructions and how to return to the
menu.

« It uses LPTMR to generate samples of a sinusoidal signal, once every 1 ms, using trigonometric func-
tions from the AMMCLib.
The sinusoidal signal can be seen using the FreeMASTER host application.
Calculated signal samples are then scaled to be in the range of the FTM PWM duty cycle and are used
to change the intensity of the RGB leds.
The frequency of each sine can be controlled with the command set_ RGB_frequency() from FreeMA«~
STER project. The frequency sent is in mHz and the default value is 0,25Hz.

« Also, it implements an exponential moving average filter using the Potentiometer on ADC channel 12 as
input.
The output of the filter can be seen using the FreeMASTER host application.
The filter's smoothing factor (lambda) can be controlled using the command set_FilterMA_lambda() from
FreeMASTER project.

Note

For more detailed information on the AMMCLib's functions please consult the available documentation.

Prerequisites

To run the example you will need to have the following items:

1 XS32K14WEVB-Q064 board

» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 1 Personal Computer

* 1 PEmicro

* FreeMASTER host application

» UART to USB converter if it is not included on the target board. (Please consult your boards documentation
to check if UART-USB converter is present).

Boards supported

The following boards are supported by this application:

+ S32K14xCVD-Q064 with S32K-MB

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION

S32K14xCVD-Q064 with
S32K-MB

XS32K14WEVB-Q064

FTM1 Channel 0

D10 - wired on the board

RGB_RED J2.6 - J3.8

FTM1 Channel 1

D19 - wired on the board

RGB_GREEN J2.5 - J3.6

FTM1 Channel 2

D20 - wired on the board

RGB_BLUE J5.9 - J3.14

ADC1 Input 11 (PTE6)

R45(POT) - wired on the board

R13(POT) - wired on the board
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How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New -> S32DS Project From and select ammclib_s32k144w.
Then click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration was initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click
on the current project, then click "Open S32 Configuration" (it has blue chip symbol on the top of the toolbar). In
S32 Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of
those will generate all the components. Pay attention to any error and warning message. If any configured value is
invalid, they will be shown for user. Make the desired changes (if any) then click "Update Code". Wait for the code
generation to be completed before continuing to the next step.

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) by left clicking on the downward arrow corresponding
to the build button(. Wait for the build action to be completed before continuing to the next step.

4. Running the project

Go to Run and select Debug Configurations. There will be one debug configuration for this project:

Configuration Name Description
ammclib_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

A terminal emulator configured with the following communication parameters is needed by this application:

+ 9600 Baud rate
+ 8 Data bits

» 1 Stop bit

* No parity

* No flow control

For the first part of the application follow the instructions in the terminal.
For the second part of the application you need to:

1. exit the mathematical section by typing exit in the terminal
2. select second section by typing 2 in the terminal

3. disconnect the terminal and start FreeMASTER.
Open the FreeMASTER project (ammclib.pmp) and set the communication parameters:

+ Go to Project -> Options -> Comm, choose Direct RS232 and set the COM port and speed 9600.

» Go to Project -> Options -> MAP Files and make sure the x*.elf file of your project's current Debug Config-
uration is selected and set file format to ELF/DWARF.
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Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

Notes

FreeMASTER host application can be downloaded from NXP's website.
FreeMASTER Serial Communication is included into the project (V2.0).

13.3.8 Structural Core Self Test Example

Basic application that presents the project scenarios for S32 SDK

Application description

The purpose of this demo application is to show you how to integrate the S32 SDK with sCST.

+ The application will run the core self tests from the Structural Core Self Test library and will report the result
using the user leds.
» Please consult the sCST manual for more information about the library.

Note

This application uses a modified version of the linker file which defines the section used by the library.
As a consequence, the application will only run in flash.

Verification:

« If the tests do not find any error, LED2 will be turned on. Otherwise LED1 will be turned on.

Prerequisites

To run the example you will need to have the following items:

1 XS32K14WEVB-Q064 board
» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 1 Personal Computer

» Debug probe (PEmicro)

Boards supported
The following boards are supported by this application:

+ XS32K14WEVB-Q064
+ S32K14xCVD-Q064 with S32K-MB

Hardware Wiring

The following connections must be done to for this example application to work:
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PIN FUNCTION XS32K14WEVB-Q064 S32K14xCVD-Q064 with
S32K-MB
LED1 (PTEO) RGB_RED - wired on board D17 - wired on the board
LED2 (PTE7) RGB_GREEN - wired on board D18 - wired on the board
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File ->> New S32DS Project From... and select scst_s32k144w. Then
click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration was initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) by left clicking on the downward arrow corresponding
to the build button(. Wait for the build action to be completed before continuing to the next step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description
scst_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.3.9 Hello World

Basic application that presents the project scenarios for S32 SDK

Application description

The purpose of this demo application is to show you the usage of the FlexCAN module configured to use Flexible
Data Rate and the CSEc module from the S32K144W CPU using the S32 SDK API.

« In the first part, the application will setup the board clocks, pins and other system functions such as SBC if
the board uses this module as a CAN transceiver.

 Then it will configure the FlexCAN module features such as FD, Bitrate and Message buffers

» The application will wait for frames to be received on the configured message buffer or for an event raised by
pressing one of the two buttons which will trigger a frame send to the recipient.
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Pressing SW3 2 button of board 1 shall trigger a CAN transfer that results in toggling the BLUE led on board
2.

Pressing SW2 1 button of board 1 shall trigger a CAN transfer that results in toggling the GREEN led on board
2.

Pressing both SW3 2 and SW2 1 buttons shall enable the encrypted communication. This event is signaled
by the RED led toggling.

The frames are sent in plain text by default.

This demo application requires two boards, one configured as master and the other one configured as slave
(see MASTER/SLAVE defines in application code).

NOTE: Red led will turn on when init ,so when Pressing SW3 2 or SW2 1 buttons the light on can be a mix of
red and green, blue lights.

Prerequisites

To run the example you will need to have the following items:

Boar

The

1 S32K144EVB-Q100(or another S32K EVB board which supports FLEXCAN)

1 XS32K14WEVB-Q064
1 Power Adapters 12V (if the board cannot be powered from the USB port)
1 Personal Computer

1 PEMicro Debugger (optional, users can use Open SDA)

ds supported
following boards are supported by this application:

+ S32K14xCVD-Q064 with S32K-MB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:
PIN FUNCTION XS32K14WEVB-Q064 S32K144EVB-Q100
CAN HIGH () CAN HIGH - J109.8 CAN HIGH - J13.1
CAN LOW (x) CAN LOW - J109.7 CAN LOW - J13.2
GND (GND) GND - J109.6 GND - J13.4

BUTTON 1 (PTD2)

SW2 - wired on the board SW2 - wired on the board

BUTTON 2 (PTD3)

SWS3 - wired on the board SW3 - wired on the board

RED_LED (PTEO)

RGB_RED - wired on the board

RGB_RED - wired on the board

GREEN_LED (PTE3)

RGB_GREEN - wired on the board

RGB_GREEN - wired on the board

BLUE_LED (PTE?)

RGB_BLUE - wired on the board

RGB_BLUE - wired on the board

(x) Those lines must be modulated using a transceiver, if it is not specified the boards already include the
CAN transceiver. The CAN transceiver should be in Forced Normal Mode operation (default mode). To
reset the CAN transceiver to default mode connect the SBC transceiver in next configuration with the board

XS3
T(J1
This

2K14WEVB-Q064 power off : « pin RSTN from SBC is held LOW - CANH(J109.8) is pulled up to VBA—
09.5) - CANL(J109.7) is pulled down to GND(J109.6) Power on the board with external supply 12V (J16)
project only applies to S32K14W board. For S32K144EVB board or other S32K EVB boards, please refer

corresponding example to get the right way to setup hardware correctly.
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How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New -> S32DS Project From and select hello_world_s32k144w.
Then click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration was initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs to
be generated. The initial configuration will have the same settings as the default example settings. Right click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built RAM (Debug_RAM) or FLASH (Debug_FLASH) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description
flexcan_encrypted_s32k144w_debug_flash_« Debug the FLASH configuration using PEMicro
pemicro debuggers
flexcan_encrypted_s32k144w_debug_ram_« Debug the RAM configuration using PEMicro
pemicro debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.3.10 LIN MASTER

Example that shows the usage of the LIN driver in master mode

Application description

This example demonstrates the LIN communication between S32K144W Master and Slave using unconditional
frames.

* The Master SeatECU is in NormalTable schedule table and it uses the LIN frame Motor1State_Cycl to re-
ceive temperature signal Motor1Temp from Slave Motor1 and send selection signal Motor1Selection to Slave
Motor1 by frame Motor1Control. The first turn on GREEN_LED, then 5s GREEN_LED and BLUE_LED will
toggle alternately.

« If value of temperature signal is higher than MOTOR1_OVER_TEMP value, Master SeatECU will send STOP
command through Motor1Selection signal to stop motor and turn on RED_LED.
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« If value of temperature signal is in range from MOTOR1_MAX_TEMP value to MOTOR1_OVER_TEMP value,
master SeatECU will send DECREASE MOTOR SPEED command through Motor1Selection signal to reduce
motor speed and turn on BLUE_LED.

« If value of temperature signal is lower than MOTOR1_MAX_TEMP value, master will send INCREASE MO«
TOR SPEED command through Motor1Selection signal to increase motor speed and turn on GREEN_LED.

» When users press button BUTTON 0 on the Master board, the Master SeatECU switches its schedule table
to go-to-sleep table. So the Slave and Master enter sleep mode, RGB LEDS are off.

* When LIN cluster is in sleep mode, users press button BUTTON 1 on the Master board, the Master board
sends a wakeup signal to wakeup slave nodes, then switches its table to NormalTable.

Prerequisites

To run the example you will need to have the following items:

+ 2 XS32K14WEVB-Q064 boards
» 1 Power Adapter 12V
+ 2 Dupont female to female cable

» 1 Personal Computer

» 1 Jlink Lite Debugger (optional, users can use Open SDA)

Boards supported

The following boards are supported by this application:

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION

XS32K14WEVB-Q064-Slave

XS32K14WEVB-Q064-Master

BUTTON 0 (PTD2)

SW2 - wired on the board

SW2 - wired on the board

BUTTON 1 (PTD3)

SW3 - wired on the board

SW3 - wired on the board

RED_LED (PTE?)

RGB_RED - wired on the board

RGB_RED - wired on the board

GREEN_LED (PTEO)

RGB_GREEN - wired on the board

RGB_GREEN - wired on the board

BLUE_LED (PTE3)

RGB_BLUE - wired on the board

RGB_BLUE - wired on the board

LIN (%)

J11-1 - LIN

J11-1 - LIN

GND (GND)

J11-4 - GND

J11-4 - GND

(x) Those lines must be modulated using a transceiver, if it is not specified the boards already include the

LIN transceiver

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select lin_master_s32k144w.

Then click on Finish.

The project should now be copied into you current workspace.
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2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. First go to
Project Explorer View in S32 DS and select the current project(lin_master_s32k144w). Select the "ConfigTools"
menu then click on the desired configuration (Pins, Clocks, Peripherals etc...). Clicking on any one of those will
generate all the components. Make the desired changes(if any) then click on the "ConfigTools->Update Code"
button.

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be four debug configurations for this project:

Configuration Name Description

lin_master_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

lin_master_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.3.11 LIN SLAVE

Example that shows the usage of the LIN driver in slave mode

Application description

This example demonstrates the LIN communication between S32K144W Master and Slave using unconditional
frames.

» The Master SeatECU is in NormalTable schedule table and it uses the LIN frame Motor1State_Cycl to re-
ceive temperature signal Motor1Temp from Slave Motor1 and send selection signal Motor1Selection to Slave
Motor1 by frame Motor1Control. The first turn on GREEN_LED, then 5s GREEN_LED and BLUE_LED will
toggle alternately.

* When user press button BUTTON 0 on the Slave board, value of temperature signal (Motor1_temp) will be
increased 60 unit.

» When user press button BUTTON 1 on the Slave board, value of temperature signal will be set to value which
is lower MOTOR1_MAX_TEMP value and turn on GREEN_LED.

« If value of temperature signal is higher than MOTOR1_OVER_TEMP value, Master SeatECU will send STOP
command through Motor1Selection signal to stop motor and turn on RED_LED.

« If value of temperature signal is in range from MOTOR1_MAX_TEMP value to MOTOR1_OVER_TEMP value,
master SeatECU will send DECREASE MOTOR SPEED command through Motor1Selection signal to reduce
motor speed and turn on BLUE_LED.
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« If value of temperature signal is lower than MOTOR1_MAX_TEMP value, master will send INCREASE MO«
TOR SPEED command through Motor1Selection signal to increase motor speed and turn on GREEN_LED.

* When users press button BUTTON 0 on the Master board, the Master SeatECU switches its schedule table
to go-to-sleep table. So the Slave and Master enter sleep mode, all LEDs are off.

* When LIN cluster is in sleep mode, users press button BUTTON 1 on the Master board, the Master board
sends a wakeup signal to wakeup slave nodes, then switches its table to NormalTable.

Prerequisites

To run the example you will need to have the following items:
+ 2 XS32K14WEVB-Q064 boards
» 1 Power Adapter 12V
» 2 Dupont female to female cable
» 1 Personal Computer

» 1 Jlink Lite Debugger (optional, users can use Open SDA)

Boards supported

The following boards are supported by this application:

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION

XS32K14WEVB-Q064-Slave

XS32K14WEVB-Q064-Master

BUTTON 0 (PTD2)

SW2 - wired on the board

SW2 - wired on the board

BUTTON 1 (PTD3)

SWS3 - wired on the board

SWS3 - wired on the board

RED_LED (PTE?)

RGB_RED - wired on the board

RGB_RED - wired on the board

GREEN_LED (PTEO)

RGB_GREEN - wired on the board

RGB_GREEN - wired on the board

BLUE_LED (PTE3)

RGB_BLUE - wired on the board

RGB_BLUE - wired on the board

LIN (+)

J11-1 - LIN

J11-1 - LIN

GND (GND)

J11-4 - GND

J11-4 - GND

(x) Those lines must be modulated using a transceiver, if it is not specified the boards already include the
LIN transceiver

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select lin_slave_s32k144w.
Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. First go to
Project Explorer View in S32 DS and select the current project(lin_slave_s32k144w). Select the "ConfigTools"
menu then click on the desired configuration (Pins, Clocks, Peripherals etc...). Clicking on any one of those will
generate all the components. Make the desired changes(if any) then click on the "ConfigTools->Update Code"
button.
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3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be four debug configurations for this project:

Configuration Name Description

lin_slave_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

lin_slave_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4 Driver Examples

Applications that show the user how to initialize the peripherals for the basic use cases

There are currently examples for the following categories:
Click on one of the categories to see the available projects

» Analog Driver Examples
« Communication Driver Examples
+ System Driver Examples

» Timer Driver Examples

13.4.1 Analog Driver Examples

Applications that show the user how to initialize the analog peripherals

There are currently driver examples with the following modules:
Click on one of the module to see the available projects

+ ADC Hardware Trigger

ADC PAL example

« ADC Software Trigger

CMP DAC
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13.4.2 ADC Hardware Trigger

How to trigger the ADC by hardware

Application description

The purpose of this demo application is to show you the usage of the ADC module triggered in hardware by the
Programmable Delay Block from the S32K144W CPU using the S32 SDK API.

» The application uses PDB to trigger ADC conversions every 1s.

» When the conversion is complete the data is sent to the host PC using LPUART.
How the example works:

» Connect to the serial port using settings found in Notes section

» The user should receive a welcome message on the terminal emulator, with application details (user can refer
the message in the main.c file)

+ The potentiometer(R44 - connected to ADC1 channel 10) must be rotated in order to generate valid ADC
conversions

» Once a valid conversion is done then converted value will be printed on the terminal emulator, like: "ADC
result: 1.8371 V ADC result: 1.8372 V ADC result: 1.8420 V"

Prerequisites
To run the example you will need to have the following items:

« 1 XS32K14WEVB-Q064 board

» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 1 Personal Computer

» 1 PEmicro debugger

» 1 USB Type-B cable for UART

Boards supported
The following boards are supported by this application:

+ Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
* Mother Board S32K-MB PCB RevA SCH RevB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

" PIN FUNCTION | S32K14xCVD-Q064 PCB [ XS32K14WEVB-Q064
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ADC POT ADC1 Channel 10 (PTE2) - wired ADCO Channel 9 (PTC1) - wired
on the board on the board
Make sure the following jumpers are set:
Jumper Name S32K-MB
JP20 Set jumper on position 1-2
JP20 Set jumper on position 4-5
JP21 Set jumper on position 1-2
Jumper Name XS32K14WEVB-Q064
J10 Set jumper on position 2-3
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New -> S32DS Project From and select adc_hwtrigger_«
s32k144w. Then click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration to be initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration" (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built RAM (Debug_RAM) or FLASH (Debug_FLASH) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4, Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description

adc_hwtrigger_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

adc_hwtrigger_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

Notes
For this example it is necessary to open a terminal emulator and configure it with:

+ 115200 baud
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» One stop bit
+ No parity

* No flow control

13.4.3 ADC PAL example

Example for ADC PAL usage

Application description

The purpose of this demo application is to present the basic functionality of the Analog to Digital Converter Periph-
eral Abstraction Layer (ADC PAL) on S32K14x MCU.

The application uses ADC PAL to trigger multiple executions of two groups of ADC conversions: first group con-
figured for SW triggering and second group for HW triggering. For each execution of a group of conversions, an
average conversion value is computed in SW, and the average value is printed on UART.

example is divided in 2 parts:

 Part 1: SW triggered group of conversions
After each complete execution of the group, results are read, the average value is calculated and printed to
console. A delay is inserted and then the SW group is triggered again. The process is repeated for a fixed
number of iterations.

» Part 2: HW triggered group of conversions
LPTMR is configured to provide a trigger event with a fixed periodicity. The selected HW group is enabled.
After each complete execution of the group, results are read, the average value is calculated and printed to

console. After a fixed number of iterations, the HW trigger group of conversions is disabled, and the LPTMR
is stopped.

How the example works:

» Connect to the serial port using settings found in Notes section
» The user should receive a welcome message on the terminal emulator, with application details

» A message announcing part 1 will be displayed followed by the values gathered from the software triggered
conversions

» A message announcing part 2 will be displayed followed by the values gathered from the hardware triggered
conversions

» The potentiometer(R44 - connected to ADC1 channel 10) can be rotated to change the value being read by
the ADC module

« After the fixed number of iterations of the part 2 of the example, a message will be displayed announcing that
the execution finished

» The user can refer to these messages in the main.c file

Note: both HW and SW triggered groups are configured to run all conversions on a single ADC InputChannel(A«
DC1 channel 10) because it is connected to a potentiometer(R44 on S32K-MB). However, the ADC PAL supports
different InputChannels to be used in the same group. For more details please refer to the ADC PAL documentation.
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Prerequisites
To run the example you will need to have the following items:

« 1 XS32K14WEVB-Q064 board

» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 1 Personal Computer

* 1 PEMicro Multilink Debugger

» 1 USB Type-B cable for UART

Boards supported
The following boards are supported by this application:

+ Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
+ Mother Board S32K-MB PCB RevA SCH RevB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION S32K14xCVD-Q064 PCB XS32K14WEVB-Q064
ADC POT ADC1 Channel 10 (PTE2) - wired ADCO Channel 9 (PTC1) - wired
on the board on the board

Make sure the following jumpers are set:

Jumper Name S32K-MB

JP20 Set jumper on position 1-2

JP20 Set jumper on position 4-5

JP21 Set jumper on position 1-2

Jumper Name XS32K14WEVB-Q064

J10 Set jumper on position 2-3
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New -> S32DS Project From and select adc_pal_s32k142w.
Then click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration to be initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code"
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3. Building the project

Select the configuration to be built RAM (Debug_RAM) or FLASH (Debug_FLASH) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description

adc_pal_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

adc_pal_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

Notes

For this example it is necessary to open a terminal emulator and configure it with:

+ 115200 baud
» One stop bit
+ No parity

* No flow control

13.4.4 ADC Software Trigger

How to trigger ADC by software

Application description

The purpose of this demo application is to show you the usage of the ADC module triggered by software from the
S32K144 CPU using the S32 SDK API.

» The application measures the value generated by the potentiometer(R44 on S32K-MB) connected to ADC1
Channel 10.

» The application uses software to trigger ADC conversions every 1s.

» When the conversion is complete the data is sent to the host PC using LPUART.
How the example works:

» Connect to the serial port using settings found in Notes section

» The user should receive a welcome message on the terminal emulator, with application details (user can refer
the message in the main.c file)

» The value read from the ADC value, converted in volts will be displayed

» The potentiometer(R44 - connected to ADC1 channel 10) can be rotated to change the value being read by
the ADC module
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Prerequisites

To run the example you will need to have the following items:

« 1 XS32K14WEVB-Q064 board

» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 1 Personal Computer

* 1 PEMicro Multilink Debugger

» 1 USB Type-B cable for UART

Boards supported
The following boards are supported by this application:

+ Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
+ Mother Board S32K-MB PCB RevA SCH RevB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION S32K14xCVD-Q064 PCB XS32K14WEVB-Q064
ADC POT ADC1 Channel 10 (PTE2) - wired ADCO Channel 9 (PTC1) - wired
on the board on the board

Make sure the following jumpers are set:

Jumper Name S32K-MB

JP20 Set jumper on position 1-2

JP20 Set jumper on position 4-5

JP21 Set jumper on position 1-2

Jumper Name XS32K14WEVB-Q064

J10 Set jumper on position 2-3
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New -> S32DS Project From and select adc_swtrigger_«
s32k144w. Then click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration to be initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration" (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".
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3. Building the project

Select the configuration to be built RAM (Debug_RAM) or FLASH (Debug_FLASH) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description

adc_swtrigger_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

adc_swtrigger_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

Notes

For this example it is necessary to open a terminal emulator and configure it with:

115200 baud
» One stop bit
* No parity

* No flow control

13.45 CMP DAC

Driver examples showing the basic usage scenario of the CMP

Application description

The purpose of this demo application is to show you how to use the Analog Comparator of the S32K144W MCU
using the S32 SDK API.

The Comparator is configured to compare analog input 0(AINO) with half the reference voltage generated with the
internal DAC. Based on the input from the potentiometer the LEDs light by the following rules:

+ 1) Vin < DAC voltage : RED on, GREEN off
+ 2) Vin > DAC voltage : RED off, GREEN on

+ 3) Unknown state : RED on, GREEN on

Prerequisites
To run the example you will need to have the following items:

+ 1 XS32K14WEVB-Q064 board or S32K-MB
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» 1 Power Adapter 12V
» 1 Personal Computer

» 1 PEmicro Debugger

Boards supported
The following boards are supported by this application:

+ S32K-MB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION XS32K14WEVB-Q064 S32K144W-MB

LEDO (PTC2 MB) RGB_RED - wired on the board JP51.1 -JP51.2

LED1 (PTC3 MB) RGB_GREEN - wired on the board | JP52.1 - JP52.2

CMP Input 0 (PTAO) J5.4-UJ5.7 J21.1 - J9.31
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select cmp_dac_s32k144w.
Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 Configuration

The example will run without an active configuration, however if any changes are required, a configuration needs to
be generated.

The initial configuration will have the same settings as the default example settings. Right click on the current
project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar).

In S32 Configuration menu, click on the desired configuration (Pins, Clock, Peripherals, etc.). Clicking on any one
of those will generate all the components.

Pay attention to any error and warning message. If any configured value is invalid, they will be shown for user.
Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description
cmp_dac_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers
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cmp_dac_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.6 Communication Driver Examples

Applications that show the user how to initialize the communication peripherals

There are currently driver examples with the following modules:
Click on one of the module to see the available projects

* LIN MASTER BAREMETAL

« LIN SLAVE BAREMETAL

+ LPI2C MASTER

« LPI2C SLAVE

« LPSPI Transfer

« LPSPIDMA

« SPIPAL

« UART PAL

* LPUART

« 12C PAL

+ 12S PAL MASTER

+ 12S PAL SLAVE

« FLEXIO I12C

« FLEXIO 12S MASTER

« FLEXIO SPI
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« FLEXIO I12S SLAVE

« FLEXIO UART

« CAN PAL

13.4.7 LIN MASTER BAREMETAL

Example that shows the usage of the LIN driver in master mode

Application description

This example demonstrates the LIN communication between S32K144W Master and Slave using LIN driver without
LIN Stack

» A frame contains header and data. The Master node can send header and data, but Slave node only can
send data. Base on header, Master node or Slave node will take corresponding action. On Master node:

* Press BUTTON 0:

— For the first time, Master node sends FRAME_MASTER_RECEIVE_DATA header and require slave
node responds by sending data (txBuff2).

— For the second time, Master sends FRAME_SLAVE_RECEIVE_DATA header, then continue sending
data (txBuff1) and slave node will receive the data.

— If node successful receives data, this node will turn on LED2/GREEN_LED, otherwise turn on LED1/«
RED_LED.

* Press BUTTON 1:
— Master node will check current node state. If the state is LIN. NODE_STATE_SLEEP_ MODE, Master
node will send wakeup signal and LEDO/BLUE_LED will be turned on both nodes, otherwise Master

node will send header to set Master node and Slave node to sleep mode and all LED will be turned off
both nodes.

Prerequisites
To run the example you will need to have the following items:

+ 1 Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W

+ 1 Mother Board S32K-MB PCB RevA SCH RevB

1 XS32K14WEVB-Q064 Board
» 1 Power Adapter 12V

4 Dupont female to female cable
» 1 Personal Computer

* 1 PEmicro Debugger
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Boards supported
The following boards are supported by this application:

» 1 Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W

« 1 Mother Board S32K-MB PCB RevA SCH RevB

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION S32K-MB XS32K14WEVB-Q064
BUTTON 0 (PTB12/PTD2) BUTTON 0 - wired on the SwW2
board(set J39, J70 1-2, J69 2-3)
BUTTON 1 (PTB13/PTD3) BUTTON 1 - wired on the SW3
board(set J38, J68 1-2, J67 2-3)
LEDO (PTCO/PTCD3) LEDO - wired on the board(set BLUE_LED
JP49)
LED1 (PTC1/PTCD7?) LED1 - wired on the board(set RED_LED
JP50)
LED2 (PTC2/PTCDO) LED2 - wired on the board(set GREEN_LED
JP51)
GND (GND) J6 - Slave GND J11.4 - Slave GND
LIN () J48.4 - Slave LIN(set J51(2-3,5-6), | J11.1 - Slave LIN
J26(1-2), JP31(2-3), JP53(1-2))

(x) Those lines must be modulated using a transceiver, if it is not specified the boards already include the
LIN transceiver

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select lin_master_baremetal«
_832k144w. Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. First go to
Project Explorer View in S32 DS and select the current project(lin_master_baremetal_s32k144w). Select the
"ConfigTools" menu then click on the desired configuration (Pins, Clocks, Peripherals etc...). Clicking on any one of
those will generate all the components. Make the desired changes(if any) then click on the "ConfigTools->Update
Code" button.

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be four debug configurations for this project:

Generated on Fri Jun 11 2021 08:14:09 for S32SDK User Manual by Doxygen



46 CONTENTS

Configuration Name Description
lin_master_baremetal_s32k144w_debug_ram_« Debug the RAM configuration using PEMicro
pemicro debuggers
lin_master_baremetal_s32k144w_debug_flash_« Debug the FLASH configuration using PEMicro
pemicro debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.8 LIN SLAVE BAREMETAL

Example that shows the usage of the LIN driver in slave mode

Application description

This example demonstrates the LIN communication between S32K144W Master and Slave using LIN driver without
LIN Stack

» A frame contains header and data. The Master node can send header and data, but Slave node only can
send data. Base on header, Master node or Slave node will take corresponding action.

« If Slave node receives FRAME_MASTER_RECEIVE_DATA header, Slave node will respond by sending data
(txBuff2).

« If Slave node receives FRAME_SLAVE_RECEIVE_DATA header, Slave node will receive and check data. If
data is success, Slave node will turn on LED2/GREEN_LED, otherwise turn on LED1/RED_LED

« If Slave node receives FRAME_GO_TO_SLEEP header, Slave node will go to sleep mode and turn off all
led.

« If Slave node receives a wakeup signal, it will check current node state, if the node state is sleep mode, Slave
node will wakeup and turn on LEDO/BLUE_LED, otherwise wakeup signal is aborted and keep the previous
state.

Prerequisites

To run the example you will need to have the following items:

+ 1 Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W

* 1 Mother Board S32K-MB PCB RevA SCH RevB

1 XS32K14WEVB-Q064 Board
» 1 Power Adapter 12V

* 4 Dupont female to female cable
» 1 Personal Computer

» 1 PEmicro Debugger
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Boards supported
The following boards are supported by this application:

» 1 Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W

« 1 Mother Board S32K-MB PCB RevA SCH RevB

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION S32K-MB XS32K14WEVB-Q064
BUTTON 0 (PTB12/PTD2) BUTTON 0 - wired on the board( SW2
set J39, J70 1-2, J69 2-3)
BUTTON 1 (PTB13/PTD3) BUTTON 1 - wired on the board( SW3
set J38, J68 1-2, J67 2-3)
LEDO (PTCO/PTCD3) LEDO - wired on the board(set BLUE_LED
JP49)
LED1 (PTC1/PTCD7?) LED1 - wired on the board(set RED_LED
JP50)
LED2 (PTC2/PTCDO) LED2 - wired on the board(set GREEN_LED
JP51)
GND (GND) J6 - Master GND J11.4 - Master GND
LIN (x) J48.4 - Master LIN(set J11.1 - Master LIN
J51(2-3,5-6), J26(1-2), JP31(2-3),
JP53(1-2))

(x) Those lines must be modulated using a transceiver, if it is not specified the boards already include the
LIN transceiver

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select lin_slave_baremetal_<«
s32k144w. Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. First go
to Project Explorer View in S32 DS and select the current project(lin_slave_baremetal_s32k144w). Select the
"ConfigTools" menu then click on the desired configuration (Pins, Clocks, Peripherals etc...). Clicking on any one of
those will generate all the components. Make the desired changes(if any) then click on the "ConfigTools->Update
Code" button.

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be four debug configurations for this project:
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Configuration Name Description
lin_slave_baremetal_s32k144w_debug_ram_« Debug the RAM configuration using PEMicro
pemicro debuggers
lin_slave_baremetal_s32k144w_debug_flash_« Debug the FLASH configuration using PEMicro
pemicro debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note
For more detailed information related to S32 Design Studio usage please consult the available documentation.
13.4.9 LPI2C MASTER

Driver example that will show the LPI2C Master functionality

Application description

The purpose of this demo application is to show you the usage of the LPI2C module available on the S32K144W
MCU as a master using S32 SDK.

» The application uses S32 SDK API to initialize the LPI12C module as a master node and in Fast operation
speed after configuring the clocks and pins needed to use the 12C. The example sends to requests to a slave,
found at the configured address, the first being a TX request, while the other being a RX request. Run Slave
first, after that Run Master. The master buffers will be checked after each transfer by the application, RED
or GREEN led will be turn on or turn off depending on the check result. Red led will turn on if data does not
match. Green led will turn on if then data is transfered correctly.

Prerequisites

To run the example you will need to have the following items:

1 S32K14xCVD-Q064 with S32K-MB

1 S32K144WEVB-Q064
» 3 Dupont cables (male to male or female to female depending on the boards)
» 1 Personal Computer

* 1 PEmicro

Boards supported

The following boards are supported by this application:

+ S32K14xCVD-Q064 with S32K-MB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:
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PIN FUNCTION S32K14xCVD-Q064 with XS32K14WEVB-Q064
S32K-MB
LPI2C SCL (PTA3) J9-30 - Slave SCL J1.2 - Slave SCL
LPI2C SDA (PTA2) J9-29 - Slave SDA J1.1 - Slave SDA
GND (GND) J6 - Slave GND J2.7 - Slave GND
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New -> S32DS Project From and select Ipi2c_master_s32k144w.
Then click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration was initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built RAM (Debug_RAM) or FLASH (Debug_FLASH) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be four debug configurations for this project:

Configuration Name Description

Ipi2c_master_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

Ipi2c_master_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.10 LPI2C SLAVE

Driver example that will show the LPI2C Slave functionality

Application description

The purpose of this demo application is to show you the usage of the LPI2C module available on the S32K144W
MCU as a slave using S32 SDK.

+ The application uses S32 SDK API to initialize the LPI2C module as a slave node and in Fast operation speed
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after configuring the clocks and pins needed to use the 12C. example uses the LPI2C callback to respond to
requests such as:

— data receive
— data transmit

— buffer full or empty. Run Slave first, after that Run Master. The slave buffers will be checked after each
transfer by the application, RED or GREEN led will be turn on or turn off depending on the check result.
Red led will turn on if data does not match. Green led will turn on if then data is transfered correctly.

Prerequisites

To run the example you will need to have the following items:

S32K14xCVD-Q064 with S32K-MB

+ XS32K14WEVB-Q064

» 3 Dupont cables (male to male or female to female depending on the boards)
» 1 Personal Computer

* 1 PEmicro

Boards supported
The following boards are supported by this application:

+ S32K14xCVD-Q064 with S32K-MB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION

S32K14xCVD-Q064 with
S32K-MB

XS32K14WEVB-Q064

LPI2C SCL (PTA3)

J9-30 - Master SCL

J1.2 - Master SCL

LPI2C SDA (PTA2) J9-29 - Master SDA J1.1 - Master SDA
GND (GND) J6 - Master GND J2.7 - Master GND
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File ->> New -> S32DS Project From and select Ipi2c_slave_s32k144w.
Then click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration was initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".
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3. Building the project

Select the configuration to be built RAM (Debug_RAM) or FLASH (Debug_FLASH) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be four debug configurations for this project:

Configuration Name Description

Ipi2c_slave_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

Ipi2c_slave_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note
For more detailed information related to S32 Design Studio usage please consult the available documentation.
13.4.11 LPSPI Transfer

Driver example that will show the LPSPI Master and Slave functionalities

Application description

The purpose of this application is to show the user how to use the Low Power Serial Peripheral Interface on the
S32K144W using the S32 SDK API.

» The application uses two on board instances of LPSPI, one in master configuration and the other one is slave
to communicate data via the SPI bus. Data will be gathered periodically from the ADC input and will be sent

to the master device which transforms it into a PWM signal. In this way the potentiometer controls the LED
intensity.

Prerequisites

To run the example you will need to have the following items:

1 XS32K14WEVB-Q064 board
» 1 Power Adapter 12V

» 6 Dupont male to male cables
» 1 Personal Computer

» 1 PEmicro Debugger

Boards supported
The following boards are supported by this application:

+ S32K-MB
+ XS32K14WEVB-Q064
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Hardware Wiring

The following connections must be done to for this example application to work:
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PIN FUNCTION XS32K14WEVB-Q064 S32K-MB
LPSPIO CS (PTB5) J2.3-J5.8 J10.28 - J13.32
LPSPIO SCK (PTD15) J1.3-J2.2 J12.18 - J12.31
LPSPI0O MOSI (PTB4) J2.4 -J2.1 J10.27 - J12.32
LPSPI0O MISO (PTD16) J1.4-J3.6 J12.15-J13.31
LPSPI1 CS (PTE1) J2.3-J5.8 J13.32-J10.28
LPSPI1 SCK (PTDO) J1.3-J2.2 J12.31-J12.18
LPSPI1 MOSI (PTD1) J2.4-J21 J12.32 - J10.27
LPSPI1 MISO (PTEO) J1.4-J3.6 J13.31 - J12.15
ADCO Input 9 (PTC1) wired on the board J21.1-J11.32
FTMO Chn 7 (PTE7) wired on the board J13.26 - J5.1

Note that on the EVB, the Green LED is connected to PTEO so you will see it lights up. In which case, on a
successful transfer, the Red LED will lights up after, resulting a yellow-ish light

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select Ipspi_transfer_s32k144w.
Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 Configuration

The example will run without an active configuration, however if any changes are required, a configuration needs to
be generated.

The initial configuration will have the same settings as the default example settings. Right click on the current
project, then click "Open S32 Configuration" (it has blue chip symbol on the top of the toolbar).

In S32 Configuration menu, click on the desired configuration (Pins, Clock, Peripherals, etc.). Clicking on any one
of those will generate all the components.

Pay attention to any error and warning message. If any configured value is invalid, they will be shown for user.
Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description

Ipspi_transfer_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

Ipspi_transfer_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.
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Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.12 LPSPIDMA

Driver example that will show the LPSPI Master and Slave functionalities

Application description
The purpose of this application is to show you how to use the Low Power Serial Peripheral Interface on the S32«
K144W using the S32 SDK API.

The application uses two on board instances of LPSPI, one in master configuration and the other one is slave to
communicate data via the SPI bus using DMA.

To check if the transmission is successful the user has to verify that the data sent is the same as the received data.
If transfer is successful, RED led will be on, otherwise it will be off.

Prerequisites

To run the example you will need to have the following items:

1 XS32K14WEVB-Q064 board
* 1 Power Adapter 12V

* 4 Dupont male to male cables
» 1 Personal Computer

» 1 PEMicro Debugger

Boards supported
The following boards are supported by this application:

+ S32K-MB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION XS32K14WEVB-Q064 S32K-MB

LPSPIO CS (PTB5) J2.3-J5.8 J10.28 - J13.32
LPSPIO SCK (PTD15) J1.3-J2.2 J12.18 - J12.31
LPSPIO MOSI (PTB4) J2.4 - J21 J10.27 - J12.32
LPSPIO MISO (PTD16) J1.4-J3.6 J12.15 - J13.31
LPSPI1 CS (PTE1) J2.3-J5.8 J13.32 - J10.28
LPSPI1 SCK (PTDO) J1.3-J2.2 J12.31 -J12.18
LPSPI1 MOSI (PTD1) J2.4-J21 J12.32 - J10.27
LPSPI1 MISO (PTEO) J1.4-J3.6 J13.31 -J12.15
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’ LED (PTE7) \ LED - wired on the board \ J13.26 - J5.1

Note that on the EVB, the Green LED is connected to PTEO so you will see it lights up. In which case, on a
successful transfer, the Red LED will lights up after, resulting a yellow-ish light

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select Ipspi_dma_s32k144w.
Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 Configuration

The example will run without an active configuration, however if any changes are required, a configuration needs to
be generated.

The initial configuration will have the same settings as the default example settings. Right click on the current
project, then click "Open S32 Configuration" (it has blue chip symbol on the top of the toolbar).

In S32 Configuration menu, click on the desired configuration (Pins, Clock, Peripherals, etc.). Clicking on any one
of those will generate all the components.

Pay attention to any error and warning message. If any configured value is invalid, they will be shown for user.
Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description

Ipspi_dma_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

Ipspi_dma_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.13 SPIPAL

Driver example using SPI

Application description

The purpose of this application is to show you how to use the LPSPI Interfaces over SPI PAL on the S32K144W
using the S32 SDK API.

The application uses one board instance of LPSPI in slave configuration and other board instance of LPSPI in
master configuration to communicate data via the SPI bus using interrupts. It also verifies that the data sent is the
same as the received data. If transfer is successful, RED led will be on, otherwise it will be off.
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Prerequisites

To run the example you will need to have the following items:

1 XS32K14WEVB-Q064

* 1 Power Adapter 12V

» 1 Personal Computer

+ 4 Dupont male to male cable

* 1 PEmicro Debugger

Boards supported
The following boards are supported by this application:

+ S32K-MB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION XS32K14WEVB-Q064 S32K-MB
LPSPIO CS (PTB5) J2.3-J5.8 J10.28 - J13.32
LPSPIO SCK (PTD15) J1.3-J2.2 J12.18 - J12.31
LPSPI0 MOSI (PTB4) J2.4-J21 J10.27 - J12.32
LPSPI0O MISO (PTD16) J1.4-J3.6 J12.15 - J13.31
LPSPI1 CS (PTE1) J2.3-J5.8 J13.32 - J10.28
LPSPI1 SCK (PTDO) J1.3-J2.2 J12.31-J12.18
LPSPI1 MOSI (PTD1) J2.4-J21 J12.32 - J10.27
LPSPI1 MISO (PTEO) J1.4-J3.6 J13.31-J12.15
LED (PTE7) LED - wired on the board J13.26 - J5.1

Note that on the EVB, the Green LED is connected to PTEO so you will see it lights up. In which case, on a
successful transfer, the Red LED will lights up after, resulting a yellow-ish light

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select spi_pal. Then click on
Finish.
The project should now be copied into you current workspace.

2. Generating the S32 Configuration

The example will run without an active configuration, however if any changes are required, a configuration needs to
be generated.

The initial configuration will have the same settings as the default example settings. Right click on the current
project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar).

In S32 Configuration menu, click on the desired configuration (Pins, Clock, Peripherals, etc.). Clicking on any one
of those will generate all the components.

Pay attention to any error and warning message. If any configured value is invalid, they will be shown for user.
Make the desired changes (if any) then click "Update Code".
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3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description

spi_pal_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

spi_pal_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.14 UART PAL

Basic application that presents the project scenarios for S32 SDK

Application description

The purpose of this demo is to show the user how UART PAL works over FLEXIO_UART or LPUART peripherals.
The user can choose whether to use FLEXIO_UART or LPUART (see USE_FLEXIO_UART define from The board
sends a welcome message to the console with further instructions.)

» The welcome message is sent via UART: "This example is an simple echo using UART_PAL it will send
back any character you send to it. The board will greet you if you send 'Hello!" Now you can begin typing:"
- User shall send "Hello!" string. If the board receives the user's string, then the "Hello World!" string shall
be sent again. User need to add EOL character to string which will be sent to board. Blue led(devkit) or led
1(Motherboard) shall be turned on if the communication is done over FLEXIO_UART; similarly the led shall
be turned off if the communication is done over LPUART.

Prerequisites

To run the example you will need to have the following items:

+ 1 XS32K14WEVB-Q064 board

» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 2 Dupont male to male cable

» 1 Personal Computer

* 1 PEmicro

Boards supported

The following boards are supported by this application:

+ S32K14xCVD-Q064 with S32K-MB
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Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION XS32K14WEVB-Q064 S32K14xCVD-Q64 PCB | S32K-MB

RGB_BLUE (PTE3) wired on the board

LED1 (PTC1) wired on the board JP50 - jump 50 on

motherboard

LPUART1 TX (PTC9) UART_TX - wired onthe | UART_TX - wired onthe | J20.3 - J20.2
board board

LPUART1 RX (PTC8) UART_RX - wired on the | UART_RX - wired on the | J20.6 - J20.5
board board

FLEXIO_UART TX J2.1-J6.6 wired on the board J12.32 - J20.5

(PTD1)

FLEXIO_UART RX J2.2-J6.5 wired on the board J12.31 - J20.2

(PTDO)

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New -> S32DS Project From and select hello_world_s32k144w.
Then click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration was initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration" (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built RAM (Debug_RAM) or FLASH (Debug_FLASH) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description

uart_pal_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

uart_pal_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.
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Notes
For this example it is necessary to open a terminal emulator and configure it with:

* 9600 baud

» One stop bit

* No parity

* No flow control

* \n'line ending

13.4.15 LPUART

Example application using the LPUART driver

Application description

The purpose of this demo application is to show you how to use the Low Power UART from the S32K144W CPU
using the S32 SDK API.

» The welcome message is sent via UART: "This example is an simple echo using LPUART it will send back
any character you send to it. The board will greet you if you send 'Hello Board' Now you can begin typing:" -
User shall send "Hello Board" string. If the board receives the user's string, then the "Hello World" string shall
be sent again. User need to add EOL character to string which will be sent to board.

Prerequisites

To run the example you will need to have the following items: To run the example you will need to have the following
items:

+ 1 XS32K14WEVB-Q064 board

» 1 Power Adapter 12V (if the board cannot be powered from the USB port)

» 1 Personal Computer

* 1 PEmicro debugger

+ 1 USB type B connect with J16 on Mother Board S32K-MB (if using S32K14xCVD-Q064 with S32K-MB)

» UART to USB converter if it is not included on the target board. (Please consult your boards documentation
to check if UART-USB converter is present).

Boards supported
The following boards are supported by this application:

+ XS32K14WEVB-Q064
+ S32K14xCVD-Q064 with S32K-MB

Hardware Wiring

The following connections must be done to for this example application to work:
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PIN FUNCTION XS32K14WEVB-Q064 S32K14xCVD-Q64 PCB | S32K-MB
UART_TX LPUART1 TX (PTC9) - LPUART2 TX (PTD7?) - J20.1 - J20.2
wired on the board wired on the board
UART_RX LPUART1 RX (PTCS8) - LPUART2 RX (PTDS) - J20.4 - J20.5
wired on the board wired on the board
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select Ipuart_s32k144W. Then
click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs to
be generated. The initial configuration will have the same settings as the default example settings. Right click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configuration (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description

Ipuart_s32k144W_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

Ipuart_s32k144W_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

Notes
For this example it is necessary to open a terminal emulator and configure it with:

+ 9600 baud

» One stop bit

* No parity

+ No flow control

* \n' line ending
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13.4.16 12C PAL

Driver example using 12C

Application description
The purpose of this application is to show you how to use the LPI2C and FLEXIO Interfaces on the S32K144W
using the S32 SDK API.

The application uses one board instance of LPI2C in slave configuration and one board instance of FLEXIO in
master configuration to communicate data via the 12C bus using interrupts.

The RED or GREEN led will be turn on or turn off depending on the check result. Red led will turn on if data does
not match. Green led will turn on if then data is transfered correctly.

Prerequisites

To run the example you will need to have the following items:

1 S32K14xCVD-Q064 with S32K-MB

1 XS32K14WEVB-Q064 board

+ 1 Power Adapter 12V (if the board can't be powered from the USB)
» 1 Personal Computer

» 2 Dupont female to female cable

» 1 PEmicro Debugger (optional, users can use Open SDA)

Boards supported
The following boards are supported by this application:

+ S32K14xCVD-Q064 with S32K-MB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION S32K14xCVD-Q064 with XS32K14WEVB-Q064
S32K-MB

FLEXIO SDA (PTDO) J9.29 - J12.31 J3.10 - J1.1

FLEXIO SCL (PTA11) J9.30 - J9.22 J3.16 - J1.2

LPI2C SDA (PTA2) J9.29 - J12.31 J1.1-J43.10

LPI2C SCL (PTA3) J9.30-J9.22 J1.2-J3.16

The pull-up resistors should be connected one between VCC(J3.7) and SDA pin(J3.10) and the second one between
VCC(J3.7) and SCL pin(J3.16).

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New -> S32DS Project From and select i2c_pal_s32k144w. Then
click on Finish.
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The project should now be copied into you current workspace. Wait for the S32 Configuration was initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built RAM (Debug_RAM) or FLASH (Debug_FLASH) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There are two debug configurations for this project:

Configuration Name Description

i2c_pal_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

i2c_pal_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.17 12S PAL MASTER

Driver example using 12S

Application description

The purpose of this application is to show you how to use the i2s_pal driver on the S32K144W.

The application uses one instance of FLEXIO in slave board and one instance of FLEXIO in master board to
communicate data via the 12S bus using both of interrupts and DMA The application will work in conjunction with
the i2s_pal_slave demo on S32K1xx.

The application displays on the host PC terminal a menu in which the user can select to: For Slave board: "Press:
1) [Slave] Send data 2) [Slave] Received data Enter your input:"

For Master board: "Press: 1) [Master] Send data 2) [Master] Received data Enter your input:"
Select Send/Receive on Slave first. After that select Receive/Send on Master.

The slave buffers and master buffers will be checked after each transfer by the application:

» On EVB: RED or GREEN led will be lit depend on the check result.
* Red led will turn if data does not match.

» Green led will turn if then data is transfered correctly.
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+ On mother board: LEDO or LED1 will be lit depend on the check result.

« LEDO led will turn if data does not match.

» LED1 led will turn if then data is transfered correctly.

Prerequisites

To run the example you will need to have the following items:

+ 2 S32K MOTHER BOARD (SCH-28767) + 2 S32K14xCVD-Q064 (SCH-29454) or 2 S32K144WEVB-Q64

» 1 Personal Computer

* 4 male to male jump wires

» 2 J-link Lite Debugger (optional, users can use Open SDA)

+ 2 Power Adapter 12V (if the board can't be powered from the USB)

Boards supported

The following boards are supported by this application:

+ S32K MOTHER BOARD (SCH-28767)

- S32K14xCVD-Q064 (SCH-29454) or

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION XS32K14WEVB-Q064 MASTER | XS32K14WEVB-Q064 SLAVE
FLEXIO SCK J2.2 (PTDO) J1.1 (PTA2)
FLEXIO WS J2.1 (PTD1) J1.2 (PTA3)
FLEXIO MASTER TX - SLAVE RX | J5.4 (PTAO0) J6.1 (PTD3)
FLEXIO MASTER RX - SLAVE TX | J5.3 (PTA1) J6.2 (PTD2)

RED_LED (PTE?)

RGB_RED - wired on board

RGB_RED - wired on board

GREEN_LED (PTEO)

RGB_GREEN - wired on board

RGB_GREEN - wired on board

UART Wired on board Wired on board
PIN FUNCTION MB - MASTER MB - SLAVE
FLEXIO SCK J12.31 (PTDO) J9.29 (PTA2)
FLEXIO WS J12.32 (PTD1) J9.30 (PTA3)

FLEXIO MASTER TX - SLAVE RX | J9.31 (PTAO) J12.30 (PTD3)
FLEXIO MASTER RX - SLAVE TX | J9.32 (PTA1) J12.29 (PTD2)
LEDO J13.26 (PTE7) - JP49.1 J13.26 (PTE7) - JP49.1
LED1 J13.31 (PTEO) - JP50.1 J13.31 (PTEO) - JP50.1
UART Wired on board Wired on board

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select i2s_pal_master_«

s32k144w. Then click on Finish.

The project should now be copied into you current workspace.
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2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. First go to
Project Explorer View in S32 DS and select the current project(i2s_pal_master_s32k144w). Select the "Config«
Tools" menu then click on the desired configuration (Pins, Cocks, Peripherals etc...). Clicking on any one of those
will generate all the components. Make the desired changes(if any) then click on the "ConfigTools->Update Code"
button.

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description

i2s_pal_master_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

i2s_pal_master_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

Notes

For this example it is necessary to open a terminal emulator and configure it with:

* 9600 baud

» One stop bit

+ No parity

+ No flow control

* \n'line ending

13.4.18 12S PAL SLAVE

Driver example using 12S

Application description

The purpose of this application is to show you how to use the i2s_pal driver on the S32K144W.

The application uses one instance of FLEXIO in slave board and one instance of FLEXIO in master board to
communicate data via the 12S bus using both of interrupts and DMA The application will work in conjunction with
the i2s_pal_master demo on S32K1xx.

The application displays on the host PC terminal a menu in which the user can select to: For Slave board: "Press:
1) [Slave] Send data 2) [Slave] Received data Enter your input:"
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For Master board: "Press: 1) [Master] Send data 2) [Master] Received data Enter your input:"

Select Send/Receive on Slave first. After that select Receive/Send on Master.

The slave buffers and master buffers will be checked after each transfer by the application:

» On EVB: RED or GREEN led will be lit depend on the check result.

Red led will turn if data does not match.

« Green led will turn if then data is transfered correctly.

* On mother board: LEDO or LED1 will be lit depend on the check result.

« LEDO led will turn if data does not match.

» LED1 led will turn if then data is transfered correctly.

Prerequisites

To run the example you will need to have the following items:

» 1 Personal Computer

* 4 male to male jump wires

2 J-link Lite Debugger (optional, users can use Open SDA)

+ 2 Power Adapter 12V (if the board can't be powered from the USB)

Boards supported

The following boards are supported by this application:

+ S32K MOTHER BOARD (SCH-28767)

- S32K14xCVD-Q064 (SCH-29454) or

+ XS32K14WEVB-Q064

Hardware Wiring

2 S32K MOTHER BOARD (SCH-28767) + 2 S32K14xCVD-Q064 (SCH-29454) or 2 S32K144WEVB-Q64

The following connections must be done to for this example application to work:

PIN FUNCTION XS32K14WEVB-Q064 MASTER | XS32K14WEVB-Q064 SLAVE
FLEXIO SCK J2.2 (PTDO) J1.1 (PTA2)
FLEXIO WS J2.1 (PTD1) J1.2 (PTA3)
FLEXIO MASTER TX - SLAVE RX | J5.4 (PTAO0) J6.1 (PTD3)
FLEXIO MASTER RX - SLAVE TX | J5.3 (PTA1) J6.2 (PTD2)

RED_LED (PTE?)

RGB_RED - wired on board

RGB_RED - wired on board

GREEN_LED (PTEO)

RGB_GREEN - wired on board

RGB_GREEN - wired on board

UART Wired on board Wired on board
PIN FUNCTION MB - MASTER MB - SLAVE
FLEXIO SCK J12.31 (PTDO) J9.29 (PTA2)
FLEXIO WS J12.32 (PTD1) J9.30 (PTA3)
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FLEXIO MASTER TX - SLAVE RX | J9.31 (PTAO) J12.30 (PTD3)
FLEXIO MASTER RX - SLAVE TX | J9.32 (PTA1) J12.29 (PTD2)
LEDO J13.26 (PTE7) - JP49.1 J13.26 (PTE7) - JP49.1
LED1 J13.31 (PTEO) - JP50.1 J13.31 (PTEO) - JP50.1
UART Wired on board Wired on board

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select i2s_pal_slave_s32k144w.
Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. First go to
Project Explorer View in S32 DS and select the current project(i2s_pal_slave_s32k144w). Select the "Config«
Tools" menu then click on the desired configuration (Pins, Cocks, Peripherals etc...). Clicking on any one of those
will generate all the components. Make the desired changes(if any) then click on the "ConfigTools->Update Code"
button.

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description

i2s_pal_slave_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

i2s_pal_slave_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

Notes
For this example it is necessary to open a terminal emulator and configure it with:

+ 9600 baud

» One stop bit

* No parity

* No flow control

* \n' line ending
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13.4.19 FLEXIO I12C

Example application showing FlexIO 12C driver usage

Application description

The purpose of this demo application is to show you the usage of the FlexlO 12C driver found on the S32K144W
SoC using S32 SDK API.

The application uses FlexlO 12C driver as master to make a send and a receive data request. The slave device for
this example is the LPI2C instance, which is configured to act as a bus slave. The setup can't be changed to use
FlexIO 12C as slave because this mode is not supported by FlexlO module. The slave and master buffers will be
checked after each transfer by the application, user shall check isTransferOk variable to see if the transmissions
are successful. If transfers is Ok, the LED on board will turn Green, otherwise the LED will turn RED.

Prerequisites

To run the example you will need to have the following items:

1 XS32K14WEVB-Q064 board
» 1 Power Adapter 12V (if the board can't be powered from the USB)
» 1 Personal Computer

» 1 PEMicro Multilink Debugger

Boards supported

The following boards are supported by this application:

+ S32K14xCVD-Q064 with S32K-MB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION XS32K14WEVB-Q064

FLEXIO SDA (PTDO) J2.2-J1.1

FLEXIO SCL (PTD1) J2.1-J1.2

LPI2C SDA (PTA2) J1.1-J2.2

LPI2C SCL (PTA3) J1.2-J2.1

RED_LED (PTE7) RGB_RED - wired on board

GREEN_LED (PTEO) RGB_GREEN - wired on board
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New -> S32DS Project From and select flexio_i2c_s32k144w.
Then click on Finish.
The project should now be copied into you current workspace.
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2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Debugging the project

Go to Run and select Debug Configurations. There will be four debug configurations for this project:

Configuration Name Description

flexio_i2c_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

flexio_i2c_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.

Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.420 FLEXIO I12S MASTER

Example application showing FlexIO I12S driver usage

Application description
The purpose of this demo application is to show you the usage of the FlexlO 12S driver found on the S32K144W
SoC using S32 SDK API.

The application uses FlexlO 12S driver to make a data transfer of a defined size. The application will work in
conjunction with the flexio_i2s_slave demo on S32K14xw.

The application displays on the host PC terminal a menu in which the user can select to: For Slave board: "Press:
1) [Slave] Send data 2) [Slave] Received data Enter your input:"

For Master board: "Press: 1) [Master] Send data 2) [Master] Received data Enter your input:"
Select Send/Receive on Slave first. After that select Receive/Send on Master.

The slave buffers and master buffers will be checked after each transfer by the application:

On EVB: RED or GREEN led will be lit depend on the check result.

* Red led will turn if data does not match.

« Green led will turn if then data is transfered correctly.

+ On mother board: LEDO or LED1 will be lit depend on the check result.

« LEDO led will turn if data does not match.
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» LED1 led will turn if then data is transfered correctly.

The MASTER 12S driver is configured to use DMA for transfers.
Data size is configured by TRANSFER_SIZE define, by default is configured to be 64 Bytes.

Prerequisites

To run the example you will need to have the following items:

+ 2 XS32K14WEVB-Q064 board or S32K MB

+ 2 Power Adapter 12V (if the board can't be powered from the USB)

+ 4 Dupont male to male cable

» 1 Personal Computer

« 2 PEMicro Multilink Debugger (optional, users can use J-link)

Boards supported

The following boards are supported by this application:

+ S32K MOTHER BOARD (SCH-28767)

+ S32K14xCVD-Q064 (SCH-29454) or

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work: Connect each FlexlO pin board

master to pin board slave.

PIN FUNCTION XS32K14WEVB-Q064 MASTER | XS32K14WEVB-Q064 SLAVE
FLEXIO SCK J2.2 (PTDO) J1.1 (PTA2)
FLEXIO WS J2.1 (PTD1) J1.2 (PTA3)
FLEXIO MASTER TX - SLAVE RX | J5.4 (PTAO0) J6.1 (PTD3)
FLEXIO MASTER RX - SLAVE TX | J5.3 (PTA1) J6.2 (PTD2)

RED_LED (PTE?)

RGB_RED - wired on board

RGB_RED - wired on board

GREEN_LED (PTEO)

RGB_GREEN - wired on board

RGB_GREEN - wired on board

UART Wired on board Wired on board

PIN FUNCTION S32K-Mother MASTER S32K-Mother SLAVE
FLEXIO SCK J12.31 (PTDO) J9.29 (PTA2)
FLEXIO WS J12.32 (PTD1) J9.30 (PTA3)

FLEXIO MASTER TX - SLAVE RX | J9.31 (PTAO) J12.30 (PTD3)
FLEXIO MASTER RX - SLAVE TX | J9.32 (PTA1) J12.29 (PTD2)
LEDO J13.26 (PTE7) - JP49.1 J13.26 (PTE7) - JP49.1
LED1 J13.31 (PTEO) - JP50.1 J13.31 (PTEO) - JP50.1
UART Wired on board Wired on board

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New -> S32DS Project From and select flexio_i2s_master_«

s32k144W. Then click on Finish.

The project should now be copied into you current workspace.
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2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Debugging the project

Go to Run and select Debug Configurations. There will be four debug configurations for this project:

Configuration Name Description
flexio_i2s_master_s32k144W_debug_ram_« Debug the RAM configuration using PEMicro
pemicro debuggers
flexio_i2s_master_s32k144W_debug_flash_« Debug the FLASH configuration using PEMicro
pemicro debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

Notes
For this example it is necessary to open a terminal emulator and configure it with:

+ 9600 baud

» One stop bit

* No parity

+ No flow control

* \n' line ending

13.4.21 FLEXIO SPI

Example application showing FlexIO SPI driver usage

Application description

The purpose of this demo application is to show you the usage of the FlexIO SPI driver found on the S32K144W
SoC using S32 SDK API.

The application uses FlexlO SPI driver to make a data transfer of a defined size. The slave device for this example
is a second FlexIO SPI driver using the same FlexIO instance, which is configured to act as a bus slave. The slave
and master buffers will be checked after each transfer by the application, user shall check isTransferOk variable to
see if the transmissions are successful(Green led will turn on), otherise red led will turn on.
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Prerequisites

To run the example you will need to have the following items:

+ 1 S32K14xCVD-Q064 with S32K-MB

1 XS32K14WEVB-Q064
» 1 Power Adapter 12V (if the board can't be powered from the USB)
» 1 Personal Computer

* 1 PEMicro Multilink Debugger

Boards supported

The following boards are supported by this application:

+ S32K14xCVD-Q064 with S32K-MB
+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION S32K144W-MB XS32K14WEVB-Q064
FLEXIO_MASTER SS (PTDO) J12.31 - J9.29 J2.2-J1.1
FLEXIO_MASTER SCK (PTD1) J12.32 - J9.30 J2.1-J1.2
FLEXIO_MASTER MOSI (PTAO0) J9.31 -J13.27 J5.4 - J6.10
FLEXIO_MASTER MISO (PTA1) J9.32 - J13.28 J5.3-J6.9
FLEXIO_SLAVE SS (PTA2) J9.29 - J12.31 J1.1-J2.2
FLEXIO_SLAVE SCK (PTA3) J9.30 - J12.32 J1.2-J2.1
FLEXIO_SLAVE MOSI (PTE4) J13.27 - J9.31 J6.10 - J5.4
FLEXIO_SLAVE MISO (PTE5) J13.28 - J9.32 J6.9 - J5.3
RED_LED (PTE?) RGB_RED - wired on board J13.12 - JP49.2
GREEN_LED (PTEO) RGB_GREEN - wired on board J13.12 - JP50.2
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New -> S32DS Project From and select flexio_spi_s32k144w.
Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.
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4. Debugging the project

Go to Run and select Debug Configurations. There will be four debug configurations for this project:
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Configuration Name Description

flexio_spi_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

flexio_spi_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.22 FLEXIO I2S SLAVE

Example application showing FlexIO I12S driver usage

Application description

The purpose of this demo application is to show you the usage of the FlexIO I12S driver found on the S32K144W
SoC using S32 SDK API.

The application uses FlexIO 12S driver to make a data transfer of a defined size. The application will work in
conjunction with the flexio_i2s_master demo on S32K14xw.

The application displays on the host PC terminal a menu in which the user can select to: For Slave board: "Press:
1) [Slave] Send data 2) [Slave] Received data Enter your input:"

For Master board: "Press: 1) [Master] Send data 2) [Master] Received data Enter your input:"
Select Send/Receive on Slave first. After that select Receive/Send on Master.

The slave buffers and master buffers will be checked after each transfer by the application:

+ On EVB: RED or GREEN led will be lit depend on the check result.

* Red led will turn if data does not match.

» Green led will turn if then data is transfered correctly.

» On mother board: LEDO or LED1 will be lit depend on the check result.
» LEDO led will turn if data does not match.

» LED1 led will turn if then data is transfered correctly.

The SLAVE I2S driver is configured to use interrupt for transfers.

Data size is configured by TRANSFER_SIZE define, by default is configured to be 64 Bytes.

Prerequisites
To run the example you will need to have the following items:

+ 2 XS32K14WEVB-Q064 board or S32K MB
+ 2 Power Adapter 12V (if the board can't be powered from the USB)
* 4 Dupont male to male cable

» 1 Personal Computer

2 PEMicro Multilink Debugger (optional, users can use J-link)
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Boards supported

The following boards are supported by this application:

+ S32K MOTHER BOARD (SCH-28767)

- S32K14xCVD-Q064 (SCH-29454) or

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION XS32K14WEVB-Q064 MASTER | XS32K14WEVB-Q064 SLAVE
FLEXIO SCK J2.2 (PTDO) J1.1 (PTA2)
FLEXIO WS J2.1 (PTD1) J1.2 (PTA3)
FLEXIO MASTER TX - SLAVE RX | J5.4 (PTAO0) J6.1 (PTD3)
FLEXIO MASTER RX - SLAVE TX | J5.3 (PTA1) J6.2 (PTD2)

RED_LED (PTE?)

RGB_RED - wired on board

RGB_RED - wired on board

GREEN_LED (PTEO)

RGB_GREEN - wired on board

RGB_GREEN - wired on board

UART Wired on board Wired on board
PIN FUNCTION MB - MASTER MB - SLAVE
FLEXIO SCK J12.31 (PTDO) J9.29 (PTA2)
FLEXIO WS J12.32 (PTD1) J9.30 (PTA3)

FLEXIO MASTER TX - SLAVE RX

J9.31 (PTAO0)

J12.30 (PTD3

FLEXIO MASTER RX - SLAVE TX

J9.32 (PTA1)

)
J12.29 (PTD2)
) -

LEDO J13.26 (PTE7) - JP49.1 J13.26 (PTE7) - JP49.1
LED1 J13.31 (PTEO) - JP50.1 J13.31 (PTEO) - JP50.1
UART Wired on board Wired on board

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New -> S32DS Project From and select flexio_i2s_slave_<«

s32k144w. Then click on Finish.

The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Debugging the project

Go to Run and select Debug Configurations. There will be four debug configurations for this project:
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Configuration Name Description

flexio_i2s_slave_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

flexio_i2s_slave_s32k144w_debug_flash_pemicro | Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

Notes
For this example it is necessary to open a terminal emulator and configure it with:
* 9600 baud
» One stop bit
* No parity
+ No flow control

* \n' line ending

13.4.23 FLEXIO UART

Example application showing FlexIO UART driver usage

Application description

The purpose of this demo application is to show you the usage of the FlexlO UART driver found on the S32K144W
SoC using S32 SDK API.

Two instances of the FlexlO UART driver are used to display a welcome message ("Hello World") and then echo
the data received from host.

User shall send a string. If the board receives the user's string, then the same string shall be sent again.

Prerequisites

To run the example you will need to have the following items:

1 S32K14xCVD-Q064 with S32K-MB

1 XS32K14WEVB-Q064 board

+ 1 Power Adapter 12V (if the board can't be powered from the USB)
» 1 Personal Computer

+ 2 Dupont female to female cable

« 1 PEmicro Debugger (optional, users can use Open SDA)
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Boards supported
The following boards are supported by this application:

+ S32K14xCVD-Q064 with S32K-MB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION S32K144W-MB
FLEXIO_UART RX (PTD1) J12.32 - J20.5
FLEXIO_UART TX (PTDO) J12.31 - J20.2
PIN FUNCTION XS32K14WEVB-Q064
FLEXIO_UART TX (PTD1) J2.1-J6.6
FLEXIO_UART RX (PTDO) J2.2-J6.5

Note

The application uses on board USB - UART chips to transfer data from board to host PC. Use an USB type B
cable to connect to the J16 connector on the mainboard.

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New -> S32DS Project From and select flexio_uart_s32k144w.
Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Debugging the project

Go to Run and select Debug Configurations. There will be four debug configurations for this project:

Configuration Name Description
flexio_uart_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers
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flexio_uart_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

Notes

For this example it is necessary to open a terminal emulator and configure it with:

+ 115200 baud
» One stop bit
+ No parity

* No flow control

13.4.24 CAN PAL

Demo application showing the CAN PAL functionalities

Application description

The purpose of this demo application is to show you the usage of the CAN PAL module configured to use Flexible
Data Rate from the S32K144W CPU using the S32 SDK API.

« In the first part, the application will setup the board clocks, pins and other system functions such as SBC if
the board uses this module as a CAN transceiver.

» Then it will configure the CAN PAL module features such as FD, Bitrate and buffers

» The application will wait for frames to be received on the configured buffer or for an event raised by pressing
one of the two buttons which will trigger a frame send to the recipient.

+ Pressing SW3 button of board 1 shall trigger a CAN transfer that results in toggling the GREEN led on board
2.

* Pressing SW2 button of board 1 shall trigger a CAN transfer that results in toggling the RED led on board 2.

» This demo application requires two boards, one configured as master and the other one configured as slave
(see MASTER/SLAVE defines in application code).

Prerequisites

To run the example you will need to have the following items:

+ 1 S32K144EVB-Q100(or another S32K EVB board which supports CAN)
1 XS32K14WEVB-Q064

+ 2 Power Adapters 12V
» 3 Dupont female to female cable

» 1 Personal Computer

1 PEMicro Debugger (optional, users can use Open SDA for S32K144EVB-Q100)
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Boards supported

The following boards are supported by this application:

+ XS32K14WEVB-Q064

+ S32K14xCVD-Q064 with S32K-MB

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION XS32K14WEVB-Q064 S32K144EVB-Q100

CAN HIGH () CAN HIGH - J109.8 CAN HIGH - J13.1

CAN LOW (x) CAN LOW - J109.7 CAN LOW - J13.2

GND (GND) GND - J109.6 GND - J13.4

BUTTON 0 (PTD2) SW2 - wired on the board SW2 - wired on the board
BUTTON 1 (PTD3) SW3 - wired on the board SW3 - wired on the board

LEDO (PTE?) RGB_RED - wired on the board RGB_RED - wired on the board
LED1 (PTEO) RGB_GREEN - wired on the board | RGB_GREEN - wired on the board

(x) Those lines must be modulated using a transceiver, if it is not specified the boards already include the
CAN transceiver.

The CAN transceiver should be in Forced Normal Mode operation (default mode).

To reset the CAN transceiver to default mode connect the SBC transceiver in next configuration with the
board XS32K14WEVB-Q064 power off:

- pin RSTN from SBC is held LOW
« CANH(J109.8) is pulled up to VBAT(J109.5)

« CANL(J109.7) is pulled down to GND(J109.6)

Power on the board with external supply 12V (J16) This project only applies to S32K14W board. For S32K144
EVB board or other S32K EVB boards, please refer corresponding example to get the right way to setup hardware
correctly.

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New -> S32DS Project From and select can_pal_s32k144w.
Then click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration was initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs to
be generated. The initial configuration will have the same settings as the default example settings. Right click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".
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3. Building the project

Select the configuration to be built RAM (Debug_RAM) or FLASH (Debug_FLASH) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be four debug configurations for this project:

Configuration Name Description

can_pal_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

can_pal_s32k144_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.25 System Driver Examples

Applications that show the user how to initialize the communication peripherals

There are currently driver examples with the following modules:
Click on one of the module to see the available projects

* CRC Checksum

+ MPU PAL Memory Protection

* MPU Memory Protect Unit

» CSEc key configuration

+ FLASH Partitioning

« EIM INJECTION

+ ERM REPORT

* EWM Interrupt

« SECURITY PAL

» WDOG Interrupt

« Trigger MUX Control
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« EDMA transfer

« Power Mode Switch

+ WDG PAL Interrupt

13.4.26 CRC Checksum

Example application showing the usage of the CRC module

Application description

The purpose of this demo application is to show you how to use the Cyclic Redundancy Check of the S32K144W
with this SDK.

In this example, The CRC is configured to generate a configuration for CCITT standard following:

« CCITT 16 bits standard:

{
.crcWidth = CRC_BITS_16,
.seed = OxFFFFU,
.polynomial = 0x10210,
.writeTranspose = CRC_TRANSPOSE_NONE,
.readTranspose = CRC_TRANSPOSE_NONE,
.complementChecksum = false

The application:

1. After reset starts with both LEDO and LED1 turned off.

2. Initializes CRC module with the above CCITT 16 bits standard configuration.

3. Pressing the SW button CRC calculation is initialized with CRC_data array from input_data.c file.
4. If the result is correct LEDO is turned on. Otherwise LED1 will be turned on.

5. The program stops.

Prerequisites
To run the example you will need to have the following items:

« 1 X832K14WEVB-Q064 board
» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 1 Personal Computer

* 1 PEmicro

Boards supported
The following boards are supported by this application:

+ XS32K14WEVB-Q064
+ S32K14xCVD-Q064 with S32K-MB
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Hardware Wiring

The following connections must be done to for this example application to work:
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PIN FUNCTION XS32K14WEVB-Q064 S$32K14xCVD-Q064 with
S32K-MB
LEDO (PTEO/PTCO) RGB_GREEN - wired on the board | LED_0 - JP49 (wired on the board)
LED1 (PTE7/PTC1) RGB_RED - wired on the board LED_1 - JP50 (wired on the board)
SW (PTD3/PTB12) SW3 BUTTON 0 - wired on the board
Make sure the following jumpers are set:
Jumper Name S32K-MB
JP49 Set jumper on position 1-2
JP50 Set jumper on position 1-2
JP39 Set jumper on position 1-2
J69 Set jumper on position 1-2
J70 Set jumper on position 2-3
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From and select crc_checksum_s32k144w.
Then click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration was initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description

crc_checksum_s32k144_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

crc_checksum_s32k144_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Notes
The CRC module in S32K platform supports both big endian and little endian in source data.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.
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13.4.27 MPU PAL Memory Protection

Example application that shows how to use the MPU PAL

Application description

The purpose of this demo application is to show you how to use the Memory Protection Unit PAL of the S32K144W
MCU with this SDK.

In this example, MPU PAL regions are configured to have access rights as following:

Region Core Debugger DMA Address

0 — rwx rwx 0x00000000 -
OxFFFFFFFF

1 rwx rwx rwx 0x00000000 -
0x0007FEFF

2 -WX rwx rwx 0x0007FFO00 -
0x0007FF1F

3 r— rwx rwx 0x0007FF00 -
0x0007FF1F

4 rwx rwx rwx 0x0007FF20 -
OxFFFFFFFF

Run the example

1. After reset, MPU PAL will be initialized according to configuration above.

2. Read flash memory at address 0x0007FF04 is permitted.

3. Press button (SW) on the board to ignore read permission by disabling region 3.
4. Read flash memory at address 0x0007FF04 is violated.

5. MPU PAL report the detail of error access on slave port 0 (Crossbar slave port 0 -> Flash Controller).
Verification

1. LEDO on indicate that MPU PAL initialization successful.

2. LED1 on (LEDO off) indicate that there is violated read access reported by MPU PAL.

Prerequisites

To run the example you will need to have the following items:

+ 1 Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
* 1 Mother Board S32K-MB PCB RevA SCH RevB

1 Board XS32K14WEVB-Q064

» 1 Power Adapter 12V (if the board cannot be powered from the USB port)

» 1 Personal Computer

» 1 PEmicro Debugger

Generated on Fri Jun 11 2021 08:14:09 for S32SDK User Manual by Doxygen



84 CONTENTS

Boards supported
The following boards are supported by this application:

+ Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
* Mother Board S32K-MB PCB RevA SCH RevB

+ Board XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION S32K-MB XS32K14WEVB-Q064
LEDO (PTCO/PTEO) LEDO - JP49 LED GREEN - D11
LED1 (PTC1/PTE7) LED1 - JP50 LED RED - D11
SW (PTB12/PTD2) BUTTONO - J69(2-3), J70(1-2), SW2
JP39
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File ->> New S32DS Project From... and select mpu_pal_memory_«
protection_s32k144w. Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs to
be generated. The initial configuration will have the same settings as the default example settings. Right click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configuration (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code"."

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description
mpu_pal_memory_protection_s32k144w_debug« | Debug the RAM configuration using PEMicro
_ram_pemicro debuggers
mpu_pal_memory_protection_s32k144w_debug« | Debug the FLASH configuration using PEMicro
_flash_pemicro debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

Generated on Fri Jun 11 2021 08:14:09 for S32SDK User Manual by Doxygen



13.4 Driver Examples 85

13.4.28 MPU Memory Protect Unit

Basic application that presents the project scenarios for S32 SDK

Application description

The purpose of this demo application is to show you how to use the Memory Protection Unit of the S32K144W MCU
with this SDK. In this example, MPU regions are configured to have access rights as following:

Region Core Debugger DMA Address

0 — rwx rwx 0x00000000 -
OxFFFFFFFF

1 rwx rwx rwx 0x00000000 -
0x0007FEFF

2 -WX rwx rwx 0x0007FFO00 -
0x0007FF1F

3 r— rwx rwx 0x0007FF00 -
0x0007FF1F

4 rwx rwx rwx 0x0007FF20 -
OxFFFFFFFF

Boards supported

The following boards are supported by this application:

» Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
« Mother Board S32K-MB PCB RevA SCH RevB
» Board XS32K14WEVB-Q064

Run the example

1. After reset, MPU will be initialized according to configuration above.

. Read flash memory at address 0x0007FF04 is permitted.

2
3. Press button (SW) on the board to ignore read permission by disabling region 3.
4. Read flash memory at address 0x0007FF04 is violated.

5

. MPU report the detail of error access on slave port 0 (Crossbar slave port 0 -> Flash Controller).
Verification

1. LED1 on indicate that MPU initialization successful.

2. LEDO on (LED1 off) indicate that there is violated read access reported by MPU.

Prerequisites

To run the example you will need to have the following items:

+ 1 Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
* 1 Mother Board S32K-MB PCB RevA SCH RevB

1 Board XS32K14WEVB-Q064

» 1 Power Adapter 12V (if the board cannot be powered from the USB port)

» 1 Personal Computer

* 1 PEmicro Debugger
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Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION S32K-MB XS32K14WEVB-Q064
LEDO (PTCO/PTEO) LEDO - JP49 LED GREEN - D11
LED1 (PTC1/PTE7) LEDT - JP50 LED RED - D11
SW (PTB12/PTD2) BUTTONO - J69(2-3), J70(1-2), Sw2

JP39

## How to run ##

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select mpu_memory_«
protection_s32k144w. Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs to
be generated. The initial configuration will have the same settings as the default example settings. Right click on
the current project, then click "Open S32 Configuration" (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configuration (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code"."

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description
mpu_memory_protection_s32k144w_debug_« Debug the RAM configuration using PEMicro
ram_pemicro debuggers
mpu_memory_protection_s32k144w_debug_« Debug the FLASH configuration using PEMicro
flash_pemicro debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.29 CSEc key configuration

Basic application that presents basic usecases for the CSEc driver

Note

This example works only for CSEc enabled parts. SIM_SDID indicates whether CSEc is available on your
device.

The first time when running the example on the board, or after a key erase, this example should be ran
from RAM.
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The user keys are non-volatile. Once the key was loaded, in order to update it, the counter should be
increased.

After the user key was loaded using this example, any further full erase of the Flash requires a
Challenge-Authentication process. This can be done by setting the ERASE_ALL_KEYS macro to 1.

After partitioning Flash for CSEc operation, using the JLink Flash configuration of any other project
will not work anymore. Workaround:

» Run csec_keyconfig example with ERASE_ALL_KEYS 1, using PEmicro Flash debug configuration

Application description

The purpose of this demo application is to show the user how to use the Cryptographic Services Engine module
from the S32K144W MCU with the S32 SDK API.

The implementation demonstrates the following:

+ the enablement of the CSEc module, by showing how the Flash should be partitioned (using the Flash driver);
« configuring the MASTER_ECU key;
« configuring the first user key, using the MASTER_ECU key as an authorization;

« using the user key for an encryption. In order to update the user key after they were configured using the
example, the user should increase the counter used for loading the key. Please note that user should increase
counter in order to keep the encryption take its place successfully for 2 cases:

» The user key was already loaded by previous run.

» The example already ran from RAM for CSEc partition. Erasing all the configured keys (including the MA«~
STER_ECU key) can be done by changing the value of the ERASE_ALL_KEYS macro to 1. This will place
the part back into factory status (the partition command will need to be run again). Please note that when
the Flash is partitioned (the first time running the example on the board, or after a key erase), the example
should not be run from Flash (please use the RAM configuration).

Prerequisites

To run the example you will need to have the following items:

1 XS32K14WEVB-Q064 board
» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 1 Personal Computer

* 1 PEmicro

Boards supported
The following boards are supported by this application:

+ S32K14xCVD-Q064 with S32K-MB

Hardware Wiring

The following connections must be done to for this example application to work:

Generated on Fri Jun 11 2021 08:14:09 for S32SDK User Manual by Doxygen



88 CONTENTS

PIN FUNCTION XS32K14WEVB-Q064 S$32K14xCVD-Q064 with
S32K-MB
LED_ERROR (PTCO) N/A LEDO - wired on the board
LED_OK (PTC1) N/A LED1 - wired on the board
LED_ERROR (PTEO) RGB_RED - wired on the board N/A
LED_OK (PTE7) RGB_GREEN - wired on the board | N/A
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From and select csec_keyconfig_s32k144w.
Then click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration was initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built RAM (Debug_RAM) or FLASH (Debug_FLASH) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description

csec_keyconfig_s32k144W_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

csec_keyconfig_s32k144W_debug_flash_pemicro | Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.30 FLASH Partitioning

Example application which shows the basic operations of the FLASH driver

Application description

The purpose of this demo application is to show you the usage of the FLASH driver with the S32 SDK API.

The examples does the following operations:
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+ Partitions the flash

+ Configures FlexNVM region as EEPROM
+ Erases flash

* Programs flash

» Write data to EEPROM. Check the status of API which confirms activities of flash module. In addition, user
can view value at memory from address 0x7F000 when erases or programs flash. Checks the value at
memory from address 0x14000000 when writes data to EEPROM.

Note

The FlexNVM memory is partitioned to EEPROM use and is blocked for some erase commands (Erase Sector
and Erase Block). As a consequence, loading the program to flash memory may fail on some debuggers.
Please perform a mass erase operation on Flash to remove this partitioning after running the example to be
able to update your application on target.

Prerequisites

To run the example you will need to have the following items:

1 XS32K14WEVB-Q064 board
» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 1 Personal Computer

» 1 PEmicro Debugger

Boards supported
The following boards are supported by this application:

+ XS32K14WEVB-Q064
+ S32K144-MB

Hardware Wiring

No connections are required for this example.

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select flash_partitioning_«
s32k144w. Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs to
be generated. The initial configuration will have the same settings as the default example settings. Right click on
the current project, then click "Open S32 Configuration" (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configuration (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".
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3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description
flash_partitioning_s32k144w_debug_ram_« Debug the RAM configuration using PEMicro
pemicro debuggers
flash_partitioning_s32k144w_debug_flash_« Debug the FLASH configuration using PEMicro
pemicro debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.31 EIMINJECTION

Driver example that shows the user how to use the Error Injection Module

Application description

The EIM module enables the user to inject 1 bit error or 2 bit errors into bus data, when read from a designated
RAM area. The ECC module must correct all 1 bit errors. The ERM module reports any detected memory error.
The example runs only on FLASH.

Run the code

1. After reset, LED RED is turned off, LED_GREEN is turned on and the value of the test address is initialized.
2. Press button BUTTONO to initialize the ERM and EIM modules.

3. Read the initialized address; if the value read from the test address is the same as the initialized value, then
LED_GREEN will be turned off and LED_RED will be turned on.

If application runs success, LED_GREEN will be turned off and LED_RED will be turned on after press button 0.

Prerequisites
To run the example you will need to have the following items:

+ 1 Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
* 1 Mother Board S32K-MB PCB RevA SCH RevB

» 1 Power Adapter 12V (if the board cannot be powered from the USB port)

» 1 Personal Computer

» 1 PEmicro Debugger (optional OpenSDA)

1 XS32K14WEVB-Q064 board
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Boards supported

The following boards are supported by this application:

+ Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with s32k144W
* Mother Board S32K-MB PCB RevA SCH RevB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION XS32K14WEVB-Q064

RED_LED (PTE?7) LED_O - Wired on the board

GREEN_LED (PTEO) LED_1 - Wired on the board

SW (PTD2) SW2-BTNO

PIN FUNCTION S32K-MB

RED_LED (PTCO0) LED_O - JP49 (wired on the board)

GREEN_LED (PTC1) LED_1 - JP50 (wired on the board)

SW (PTB12) BUTTONO - J69(2-3), J70(1-2), JP39
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File ->> New S32DS Project From... and select eim_injection_s32k144w.
Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) by left clicking on the downward arrow corresponding
to the build button(. Wait for the build action to be completed before continuing to the next step.

4. Running the project

Go to Run and select Debug Configurations. There will be one debug configuration for this project:

Configuration Name Description
eim_injection_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.
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Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.32 ERM REPORT

Driver example that shows the user how to use the Error reporting module.

Application description

The EIM module enables the user to inject 1 bit error or 2 bit errors into bus data, when read from a designated
RAM area. The ECC module must correct all 1 bit errors. The ERM module reports any detected memory error.
The example runs only on FLASH

Run the code

1. After reset, LED_RED is turned off, LED_GREEN is turned on and the value for address used to test is
initialized.

2. Press button SW2(BUTTONO) to initialize ERM and EIM modules.

3. Read the address which was initialized, ERM will trigger an interrupt notification which also turns off LED_+«
GREEN, and turns on the LED_RED to report a single-bit correction event.

4. Error event details are reported by ERM.

Prerequisites

« 1 Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
+ 1 Mother Board S32K-MB PCB RevA SCH RevB

» 1 Power Adapter 12V (if the board cannot be powered from the USB port)

» 1 Personal Computer

» 1 PEmicro Debugger (optional OpenSDA)

1 XS32K14WEVB-Q064 board

Boards supported
The following boards are supported by this application:

+ Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
» Mother Board S32K-MB PCB RevA SCH RevB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION ‘ XS32K14WEVB-Q064
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LEDO (PTE?7) LED_0 - Wired on the board

LED1 (PTEO) LED_1 - Wired on the board

SW (PTD2) SW2-BTNO

PIN FUNCTION S32K144W-MB

LEDO (PTCO) LED_O - JP49 (wired on the board)

LED1 (PTC1) LED_1 - JP50 (wired on the board)

SW (PTB12) BUTTONO - J69(2-3), J70(1-2), JP39
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select erm_report_s32k144w.
Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) by left clicking on the downward arrow corresponding
to the build button(. Wait for the build action to be completed before continuing to the next step.

4. Running the project

Go to Run and select Debug Configurations. There will be one debug configuration for this project:

Configuration Name Description
erm_report_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.
This Example only run on Flash

13.4.33 EWM Interrupt

Driver example that shows the user how to use the External Watchdog Monitor

Application description

The purpose of this driver application is to show the user how to use the EWM from the S32K144w using the S32
SDK API.
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Run the code

1. Turn off LEDO and LED1.
2. The examples uses the SysTick timer from the ARM core to refresh the EWM counter for 30 times. After each
refresh, LEDO is also toggled. Within this interval the user can press the button associated with the EWM

input pin to assert the interrupt and output pin.

3. After the EWM counter is refreshed 30 times or the user presses the button before refreshing ends, the EWM
interrupt is triggered and both LEDO and LED1 are turned ON, then SysTick timer is disabled.

Expected output:

« If the button 0 is not pressed, the LEDO is toggled 30 times, after that LEDO and LEDO are turned ON.

« If the button 0 is pressed, LEDO and LED1 are turned ON immediately.

Prerequisites

To run the example you will need to have the following items:

1 XS32K14WEVB-Q064 board
« 1 Power Adapter 12V

+ 2 Dupont male to male cable

» 1 Personal Computer

» 1 PEMicro Debugger (optional, users can use Open SDA)

Boards supported

The following boards are supported by this application:

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION XS32K14WEVB-Q064

LEDO (PTE?) RGB_RED - wired on the board

LED1 (PTEO) RGB_GREEN - wired on the board

EWM_IN (PTA3) J1.2(EWM INPUT) - J6.2(SW2_BTNO)
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select ewm_interrupt_s32k144w.
Then click on Finish.
The project should now be copied into you current workspace.
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2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description

ewm_interrupt_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

ewm_interrupt_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.34 SECURITY PAL

Basic application that presents basic usecases for the Security PAL.

Note

This example works only for CSEc enabled parts. SIM_SDID indicates whether CSEc is available on your
device.

The first time when running the example on the board, or after a key erase, this example should be ran
from RAM.

This example generates a random number.

This example demonstrates CBC Encryption/Decryption.

Application description

The purpose of this demo application is to show the user how to use the Security PAL in conjuction with Crypto-
graphic Services Engine module from the S32K14x MCU with the S32 SDK API.

The implementation demonstrates the following:

+ the enablement of the Security PAL, used over CSEc module, by showing how the Flash should be partitioned
(using the Flash driver);

« initializing the Random Number Generator and generating a vector of 128 random bits;
+ configuring the RAM key, with a 128-bit plaintext;

« using the user key for a CBC encryption and a CBC decryption;
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If no errors occur during the cryptographic operations, the LEDO will be turned on upon completion; if the red LED1
is lit, the program failed during one of the steps.

Prerequisites
To run the example you will need to have the following items:

» 1 S32K144W board
» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 1 Personal Computer

» 1 PEmicro debugger

Boards supported
The following boards are supported by this application:

+ S32K14WEVB-Q064

+ S32K14xCVD-Q064 with S32K-MB

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File ->> New S32DS Project From... and select security_pal. Select "Copy
projects into workspace" and then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs to
be generated. The initial configuration will have the same settings as the default example settings. Right click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configuration (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,

they will be shown for user. Make the desired changes (if any) then click "Update Code".
3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description

security_pal_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

security_pal_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.
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Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.35 WDOG Interrupt

Example application that will show the usage of the Watchdog

Application description

The purpose of this driver application is to show the user how to use the WDOG from the S32K144w using the S32
SDK API.

The examples uses the SysTick timer from the ARM core to refresh the WDOG counter for 8 times. After this the
Watchdog counter will expire and the CPU will be reset. If the FLASH configuration will be used, then the code will
use the Reset Control Module to detect if the reset was caused by the Watchdog and will stop the execution of the
program.

Run the example on Devkit:

1. After reset, LED 0 and LED 1 is off.
2. Initialize WDOG Interrupt above then LED 0 is toggle 8 times( on 4 times and off 4 times).

3. Watchdog timeout happen then MCU reset and LED 0 and LED 1 is on and The program will stopped.

Prerequisites
To run the example you will need to have the following items:

» 1 S32K144W board

* 1 Power Adapter 12V

» 2 Dupont male to male cable
» 1 Personal Computer

» 1 PEmicro Debugger

Boards supported
The following boards are supported by this application:

+ XS32K14WEVB-Q064
+ S32K14xCVD-Q064 with S32K-MB

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION XS32K14WEVB-Q064 S32K14xCVD-Q064 S32K-MB
LEDO RGB_RED - wired on the | LEDO - wired on the JP49.1 - JP49.2
board board
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LED1 RGB_GREEN - wired on | LED1 - wired on the JP50.1 - JP50.2
the board board

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select wdog_interrupt_«
s32k144w. Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32CT configuration

The example will run without an active configuration, however if any changes are required, a configuration needs to
be generated. The initial configuration will have the same settings as the default example settings. Right click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configuration (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,

they will be shown for user. Make the desired changes (if any) then click "Update Code".
3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) by left clicking on the downward arrow corresponding
to the build button(. Wait for the build action to be completed before continuing to the next step.

4. Running the project

Go to Run and select Debug Configurations. There will be one debug configurations for this project:

Configuration Name Description
wdog_interrupt_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.36 Trigger MUX Control

Example application showing the usage of the TRGMUX module

Application description

The purpose of this demo application is to show you how to use the Trigger MUX Control of the S32K14xW MCU
with this SDK.

The examples use TRGMUX to connect Pin Trigger Mux In3 and LPIT channel 0 on motherboard or connect Pin
Trigger Mux In5 and LPIT channel 1 in EVB board

+ Initialize TRGMUX with source trigger from TRGMUX_IN3 and target module is LPIT_CHO for motherboard
or Initialize TRGMUX with source trigger from TRGMUX_IN5 and target module is LPIT_CH1 for EVB board

« Initialize the LPIT Channel 0 for motherboard or Initialize the LPIT Channel 1 for EVB board.

« LED ORANGE on Motherboard or RGB_RED led in EVB board is used to blink led
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» Each time when user presses button SW4 on Motherboard or SW2 in EVB board will generate a trigger signal
that actives LPIT via TRGMUX. After 1s, LPIT will create an event interrupt and toggle LED

Prerequisites

To run the example you will need to have the following items:

1 S32K144W board (S32K14xCVD-Q064)
» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 1 Personal Computer

» 1 PEmicro Debugger (optional, users can use Open SDA)

Boards supported
The following boards are supported by this application:

+ S32K144W-MB

+ XS32K14WEVB-Q064

Hardware Wiring

PIN FUNCTION S32K144W-MB XS32K14WEVB-Q064
LEDO (PTCO) JP49.1 - JP49.2 REG_RED (PTE7)- wired on the
board
BUTTONS () JP36.1-JP42.1, J63.2-3, J64.1-2 SW2 (PTD2) -wired on the board
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select trgmux_Ipit_s32k144W.
Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs to
be generated. The initial configuration will have the same settings as the default example settings. Right click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configuration (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:
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Configuration Name Description

trgmux_lpit_s32k144W_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

trgmux_lpit_s32k144W_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

Notes

The TRGMUX module in S32K platform supports both big endian and little endian in source data.

13.4.37 EDMA transfer

Example application showing the usage of the EDMA module

Application description

The purpose of this driver example is to show you how to use the eDMA in the following transfer scenarios for the
S32K144W MCU using the S32 SDK API.

+ Loop memory-to-memory transfer

If the application works correctly, the data shall be transfered correctly to destination memory and a transmission
complete interrupt shall be triggered. And the application will not jump to any DEV_ASSERT.

Prerequisites
To run the example you will need to have the following items:

+ 1 Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
* 1 Mother Board S32K-MB PCB RevA SCH RevB

» 1 Power Adapter 12V (if the board can't be powered from the USB)

» 1 Personal Computer

» 1 PEmicro Debugger

Boards supported
The following boards are supported by this application:

+ Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
+ Mother Board S32K-MB PCB RevA SCH RevB

+ XS32K14WEVB-Q064
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Hardware Wiring
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select edma_transfer_s32k144w.
Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. First go to
Project Explorer View in S32 DS and select the current project(edma_transfer_s32k144w). Select the "Config«
Tools" menu then click on the desired configuration (Pins, Cocks, Peripherals etc...). Clicking on any one of those
will generate all the components. Make the desired changes(if any) then click on the "ConfigTools->Update Code"
button.

3. Building the project

Select the configuration to be built RAM (Debug_RAM) or FLASH (Debug_FLASH) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be one debug configurations for this project:

Configuration Name Description

edma_transfer_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

edma_transfer_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.38 Power Mode Switch

Example application demonstrating S32K144W power modes

Application description

The purpose of the application is to show the user how to enter various power modes of the S32K144 SoC using
the S32 SDK API.

The application displays on the host PC terminal a menu in which the user can select to enter:

* Normal Run (RUN)
» Very Low Power Run (VLPR)

- STOP mode 1 (STOP1)
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« STOP mode 2 (STOP2)
» Very Low Power Stop (VLPS)

When user selects a mode, PC terminal will show the following text:

Press:
1) for RUN
2) for VLPR

3) fo
4) fo
5) fo

r STOP1
r STOP2
r VLPS

—>Press SW3 to wake up the CPU from STOP1,STOP2 or VLPS mode
Enter your input:

Expected Output:

» If STOP1, STOP2 or VLPS is selected by entering the character: '3', '4' or '5' into PC terminal, LED_RED will
turn on, LED_GREEN will turn off and the PC terminal will show:

Mode The content informs

STOP1 sk CPU is going in STOP1 mode...
STOP2 wkxkxkkk CPU is going in STOP2 mode...
VLPS sxxkkckk CPU is going in VLPS mode...

» The CPU can be woken up from sleep modes by pressing button SW3 in EVB board, then LED_RED turn

off, LED_GREEN turn on and PC terminal will show:

Mode The content informs

STOP1 CPU was entered STOP1 mode successfully and
then woke up to exit STOP1 mode.

STOP2 CPU was entered STOP2 mode successfully and
then woke up to exit STOP2 mode.

VLPS CPU was entered VLPS mode successfully and
then woke up to exit VLPS mode.

« If user selects RUN or VLPR, the PC terminal will show:

Mode

The content informs

RUN

skskskoskskokskskokskokskskokskokskskokskokskskok CPU is in RUN
mode

sokskokokskokkoRsoRsoksokokokkorskoksok Core frequency:
48000000[Hz]

VLPR

sk ok kokok okl kokkkokkxokk CPU is in VLPR
mode

kR Rk ckkkokkokx Core frequency:
1000000[HZz]

Prerequisites

To run the example you will need to have the following items:

1 S32K144W board

1 Power Adapter 12V (if the board cannot be powered from the USB port)

1 Personal Computer
1 PEmicro Debugger
1 Micro Usb Cable
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Boards supported

The following boards are supported by this application:

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION XS32K14WEVB-Q064
GREEN_LED (PTEO) RGB_RED - wired on board
RED_LED (PTE7) RGB_GREEN - wired on board
BUTTON (PTD3) SWS3 - wired on the board

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From and select power_mode_switch_«
s32k144w. Then click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration was initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs to
be generated.

The initial configuration will have the same settings as the default example settings. Left click on the current project,
then click "Open S32 Configuration" (it has blue chip symbol on the top of the toolbar).

In S32 Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of
those will generate all the components.

Pay attention to any error and warning message. If any configured value is invalid, they will be shown for user. Make
the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) by left clicking on the downward arrow corresponding
to the build button.
Wait for the build action to be completed before continuing to the next step.

4. Running the project

Go to Run and select Debug Configurations. There will be four debug configurations for this project:

Configuration Name Description
power_mode_switch_s32k144w_debug_flash_« Debug the FLASH configuration using PEMicro
pemicro debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.
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Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

Notes
For this example it is necessary to open a terminal emulator and configure it with:

+ 9600 baud

» One stop bit

* No parity

+ No flow control

* "\n' line ending

Clock source is remained in SIRC (8 MHz) before MCU switches from RUN to VLP mode.
In order to set to default clock for RUN mode. User presses option for RUN or re-initializes clock configuration.

13.4.39 WDG PAL Interrupt

Example application that will show the usage of the Watchdog

Application description

The purpose of this driver application is to show the user how to use the WDG PAL from the S32K144W using the
S32 SDK API.

The example uses the SysTick timer from the ARM core to refresh the WDG PAL counter for 30 times. LEDO will
toggle when WDG PAL counter is refreshed. After this the WDG PAL counter will expire, WDG PAL interrupt will
happen and turn off LEDO, LED1. Then the CPU will be reset. If the FLASH configuration will be used, then the
program will use the Reset Control Module to detect if the reset was caused by the Watchdog and will stop the
execution of the program and turn on LEDO, LED1.

Prerequisites

To run the example you will need to have the following items:

1 S32K144W board

« 1 Power Adapter 12V

» 2 Dupont male to male cable
» 1 Personal Computer

* 1 PEmicro Debugger

Boards supported
The following boards are supported by this application:

+ XS32K14WEVB-Q064

+ S32K14xCVD-Q064 with S32K-MB
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Hardware Wiring

The following connections must be done to for this example application to work:
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PIN FUNCTION XS32K14WEVB-Q064 S32K14xCVD-Q064 S32K-MB
LEDO RGB_RED - wired on the | LEDO - wired on the JP49.1 - JP49.2
board board
LED1 RGB_GREEN - wired on | LED1 - wired on the JP50.1 - JP50.2
the board board
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File ->> New S32DS Project From... and select wdg_pal_interrupt_«~
s32k144w. Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Right click
on the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In
S32 Configuration menu, click on the desired configuration (Pins, Clock, Peripherals, etc.). Clicking on any one of
those will generate all the components. Pay attention to any error and warning message. If any configured value is
invalid, they will be shown for user. Make the desired changes (if any) then click "Update Code"." Wait for the code
generation to be completed before continuing to the next step.

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) by left clicking on the downward arrow corresponding
to the build button(. Wait for the build action to be completed before continuing to the next step.

4. Running the project

Go to Run and select Debug Configurations. There will be one debug configurations for this project:

Configuration Name Description
wdg_pal_interrupt_s32k144w_debug_flash_«~ Debug the FLASH configuration using PEMicro
pemicro debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.40 Timer Driver Examples

Applications that show the user how to initialize the timer peripherals

There are currently driver examples with the following modules:
Click on one of the module to see the available projects

« FTM Combined PWM

* FTM Periodic Interrupt

« FTM PWM
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* FTM Signal Measurement

+ IC PAL

» LPTMR Periodic Interrupt

* LPTMR Periodic Interrupt

» PDB Periodic Interrupt

« RTC Alarm

« TIMING PAL

« PWM PAL

+ OC PAL

» LPIT Periodic Interrupt

13.4.41 FTM Combined PWM

Example application showing the FTM's combined PWM functionality

Application description

The purpose of this demo application is to show you the usage of the Combined PWM mode of the FlexTimer
module on S32K144W using S32 SDK API.

The examples does the following operations:

* Increment or decrement duty cycle
« Update channel duty cycle

« Wait for a number of cycles to make the change visible
Run the example

1. After reset, The LEDO and LED1 of S32K144-MB will increment or decrement light intensity

2. Use oscilloscope to verify the output signal

Prerequisites
To run the example you will need to have the following items:

+ 1 XS32K14WEVB-Q064 or 1 S32K144-MB

+ 1 Power Adapter 12V (if the board cannot be powered from the USB port)
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» 1 Personal Computer
* 1 microUSB cable
* 1 PEmicro Debugger

Boards supported

The following boards are supported by this application:

+ XS32K14WEVB-Q064
+ S32K144-MB

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION S32K144-MB XS32K14WEVB-Q064
FTMO Channel 0 LEDO - wired on the board - JP49 RGB_GREEN - J3.6 - J4.2
(1-2)
FTMO Channel 1 LED1 - wired on the board - JP50 RGB_RED - J5.7 - J3.8
(1-2)
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File ->> New S32DS Project From... and select ftm_combined_pwm_«
s32k144w. Then click on Finish.
The project should now be copied into your current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. First go
to Project Explorer View in S32 DS and select the current project(ftm_combined_pwm_s32k144w). Right click
on the current project ->" S32 Configuration Tool" menu then click on the desired configuration (Pins, Cocks,
Peripherals etc...). Clicking on any one of those will generate all the components. Make the desired changes(if any)
then click on the "ConfigTools->Update Code" button.

3. Building the project

Select the configuration FLASH (Debug_FLASH) or RAM (Debug_RAM) to be built by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There are two debug configurations for this project:

Configuration Name Description
ftm_combined_pwm_s32k144w_debug_ram_« Debug the RAM configuration using PEMicro
pemicro debugger
ftm_combined_pwm_s32k144w_debug_flash_<« Debug the FLASH configuration using PEMicro
pemicro debugger

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.
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Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.42 FTM Periodic Interrupt

Example application showing the FTM's Timer functionality

Application description

The purpose of this demo application is to show you the usage of the FlexTimer's Timer functionality on S32K144W
CPU using the S32 SDK API

» The application configures FTM to generate an interrupt every 1 second

 The interrupt will blink the configured LED wired on the board

Prerequisites
To run the example you will need to have the following items:
+ 1S32K144-MB or 1 XS32K14WEVB-Q064
» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 1 Personal Computer
* 1 microUSB cable

* 1 PEmicro Debugger

Boards supported

The following boards are supported by this application:

+ S32K144-MB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION S32K144-MB XS32K14WEVB-Q064
LEDO (wired on the board) LEDO (PTCO) - JP49 (1-2) RGB_GREEN (PTEOQ)
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select ftm_periodic_interrupt«—
_s32k144w. Then click on Finish.
The project should now be copied into your current workspace.
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2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. First go
to Project Explorer View in S32 DS and select the current project(ftm_periodic_interrupt_s32k144w). Right
click on the current project ->" S32 Configuration Tool" menu then click on the desired configuration (Pins, Cocks,
Peripherals etc...). Clicking on any one of those will generate all the components. Make the desired changes(if any)
then click on the "ConfigTools->Update Code" button.

3. Building the project

Select the configuration FLASH (Debug_FLASH) or RAM (Debug_RAM) to be built by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There are two debug configurations for this project:

Configuration Name Description
ftm_periodic_interrupt_s32k144w_debug_ram_« Debug the RAM configuration using PEMicro
pemicro debuggers
ftm_periodic_interrupt_s32k144w_debug_flash_:— | Debug the FLASH configuration using PEMicro
pemicro debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.
Note
For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.43 FTM PWM

Example application showing the FTM's PWM functionality

Application description

The purpose of this demo application is to show you the usage of the PWM mode of the FlexTimer module found
on the S32K144W using S32 SDK API. The examples does the following operations:

* Increment or decrement duty cycle
+ Update channel duty cycle

« Wait for a number of cycles to make the change visible
Run the example

1. After run debug, the LED wired on board will increment or decrement light intensity

2. Use oscilloscope to verify the output signal

Prerequisites
To run the example you will need to have the following items:

+ 1S32K144-MB or 1 XS32K14WEVB-Q064
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» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 1 Personal Computer
* 1 microUSB cable

* 1 PEmicro Debugger

Boards supported
The following boards are supported by this application:

+ S32K144-MB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION S32K144-MB XS32K14WEVB-Q064
FTMO Channel 0 (PTCO) LEDO wired on the board - JP49
(1-2)
FTMO Channel 7 (PTE7) RGB_RED - LEDO wired on the
board
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select ftm_pwm_s32k144w.
Then click on Finish.
The project should now be copied into your current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. First go to
Project Explorer View in S32 DS and select the current project(ftm_pwm_s32k144w). Right click on the current
project ->" S32 Configuration Tool" menu then click on the desired configuration (Pins, Cocks, Peripherals etc...).
Clicking on any one of those will generate all the components. Make the desired changes(if any) then click on the
"ConfigTools->Update Code" button.

3. Building the project

Select the configuration FLASH (Debug_FLASH) or RAM (Debug_RAM) to be built by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There are two debug configurations for this project:

Configuration Name Description
ftm_pwm_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debugger
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ftm_pwm_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debugger

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.44 FTM Signal Measurement

Example application showing the FTM's Signal Measurement functionality

Application description

The purpose of this demo application is to show you the usage of the FlexTimer's Signal Measurement functionality
from the S32K144W CPU using the S32 SDK API.

» The application is configured to generate a PWM signal with a variable frequency which will be measured by
another FTM instance. The frequency will range from 1000 Hz to 3000 Hz. Each step changes 100 Hz. The
measurement result will be sent to the host PC via LPUART. User is able to compare pwm frequency and
measurement frequency.

The pwm frequency must be in measurable frequency range of FTM_IC. For example, here are the measur-
able ranges corresponding to the clock source = System clock (48 MHz)

Clock source prescaler Maximum frequency (Hz) Minimum frequency (Hz)
1 48,000,000 732.42

2 24,000,000 366.21

4 12,000,000 183.10

8 6,000,000 91.55

16 3,000,000 45.77

32 1,500,000 22.88

64 750,000 11.44

128 375,000 5.72

Prerequisites

To run the example you will need to have the following items:

1 XS832K14WEVB-Q064 or 1 S32K144-MB

» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 1 Personal Computer

* 1 microUSB cable

» 1 PEmicro Debugger

Boards supported
The following boards are supported by this application:

+ XS32K14WEVB-Q064

+ S32K144-MB
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Hardware Wiring

The following connections must be done to for this example application to work:
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PIN FUNCTION S32K144-MB XS32K14WEVB-Q064

FTMO Output Channel 0 (PTCO) J11.31-J10.29 J4.06 - J2.06

FTM1 Input Channel 0 (PTB2) J10.29 - J11.31 J2.06 - J4.06

UART_TX J20.01 - J20.02 Wired on the board

UART_RX J20.04 - J20.05 Wired on the board

USB_MICRO_AB J41 - microUSB cable J7 - microUSB cable
Notes

For this example it is necessary to open a terminal emulator and configure it with:

+ 9600 baud

» One stop bit

+ No parity

+ No flow control

* \n'line ending

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select ftm_signal_«
measurement_s32k144w. Then click on Finish.
The project should now be copied into your current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. First go
to Project Explorer View in S32 DS and select the current project(ftm_signal_measurement_s32k144w). Right
click on the current project ->" S32 Configuration Tool" menu then click on the desired configuration (Pins, Cocks,

Peripherals etc...). Clicking on any one of those will generate all the components. Make the desired changes(if any)
then click on the "ConfigTools->Update Code" button.

3. Building the project

Select the configuration FLASH (Debug_FLASH) to be built by left clicking on the downward arrow corresponding
to the build button(. Wait for the build action to be completed before continuing to the next step.

4. Running the project

Go to Run and select Debug Configurations. There is a debug configuration for this project:

Configuration Name Description
ftm_signal_measurement_s32k144w_debug_<« Debug the FLASH configuration using PEMicro
flash_pemicro debugger

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

5. Output display on Terminal

Welcome message:

This example will show you how to use FTIM’s signal measurement feature.
To achieve that we will generate a modifiable frequency PWM and read
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it with Input Capture
Press any key to initiate a new conversion...

Expected output:

PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM

frequency: 1000 Measured frequency: 1000 [Hz]
frequency: 1100 Measured frequency: 1100 [Hz]
frequency: 1200 Measured frequency: 1200 [Hz]
frequency: 1300 Measured frequency: 1300 [Hz]
frequency: 1400 Measured frequency: 1400 [Hz]
frequency: 1500 Measured frequency: 1500 [Hz]
frequency: 1600 Measured frequency: 1600 [Hz]
frequency: 1700 Measured frequency: 1700 [Hz]
frequency: 1800 Measured frequency: 1800 [Hz]
frequency: 1900 Measured frequency: 1900 [Hz]
frequency: 2000 Measured frequency: 2000 [Hz]
frequency: 2100 Measured frequency: 2100 [Hz]
frequency: 2200 Measured frequency: 2200 [Hz]
frequency: 2300 Measured frequency: 2300 [Hz]
frequency: 2400 Measured frequency: 2400 [Hz]
frequency: 2500 Measured frequency: 2500 [Hz]
frequency: 2600 Measured frequency: 2600 [Hz]
frequency: 2700 Measured frequency: 2700 [Hz]
frequency: 2800 Measured frequency: 2800 [Hz]
frequency: 2900 Measured frequency: 2900 [Hz]
frequency: 3000 Measured frequency: 3000 [Hz]

Press any key to initiate a new conversion...

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.45 ICPAL

Example application showing the IC's Signal Measurement functionality

Application description

The purpose of this demo application is to show you the usage of the IC's Signal Measurement functionality from
the S32K144W CPU using the S32 SDK API.

The application is configured to generate a PWM signal with a variable frequency which will be measured by
IC_PAL. The frequency will range from 1000 Hz to 3000 Hz. Each step changes 100 Hz. The measurement
result will be sent to the host PC via LPUART. User is able to compare pwm frequency and measurement
frequency.

Prerequisites

To run the example you will need to have the following items:

1 XS32K14WEVB-Q064 or 1 S32K144-MB

1 Power Adapter 12V (if the board cannot be powered from the USB port)
1 Personal Computer

1 microUSB cable

1 PEmicro Debugger

Generated on Fri Jun 11 2021 08:14:09 for S32SDK User Manual by Doxygen



116 CONTENTS

Boards supported
The following boards are supported by this application:

+ XS32K14WEVB-Q064

+ S32K144-MB

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION S32K144-MB XS32K14WEVB-Q064

FTMO Output Channel 0 (PTCO) J11.31 -J10.29 J4.06 - J2.06

FTM1 Input Channel 0 (PTB2) J10.29 - J11.31 J2.06 - J4.06

UART_TX J20.01 - J20.02 Wired on the board

UART_RX J20.04 - J20.05 Wired on the board

USB_MICRO_AB J41 - microUSB cable J7 - microUSB cable
Notes

For this example it is necessary to open a terminal emulator and configure it with:

* 9600 baud

» One stop bit

* No parity

+ No flow control

* \n' line ending

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select ic_pal_s32k144w. Then
click on Finish.
The project should now be copied into your current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. First go
to Project Explorer View in S32 DS and select the current project(ic_pal_s32k144w). Right click on the current
project ->" S32 Configuration Tool" menu then click on the desired configuration (Pins, Cocks, Peripherals etc...).
Clicking on any one of those will generate all the components. Make the desired changes(if any) then click on the
"ConfigTools->Update Code" button.

3. Building the project

Select the configuration FLASH (Debug_FLASH) to be built by left clicking on the downward arrow corresponding
to the build button(. Wait for the build action to be completed before continuing to the next step.

4. Running the project

Go to Run and select Debug Configurations. There is a debug configuration for this project:
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Configuration Name

Description

ic_pal_s32k144w_debug_flash_pemicro

Debug the FLASH configuration using PEMicro
debugger

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

5. Output display on Terminal

Welcome message:

This example will show you how to use IC’s signal measurement feature.
To achieve that we will generate a modifiable frequency PWM and read

it with Input Capture
Press any key to initiate a new conversion...

Expected output:

PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM
PWM

Note

13.4.46 LPTMR Periodic Interrupt

frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
Press any key to initiate a new conversion...

1000
1100
1200
1300
1400
1500
1600
1700
1800
1900
2000
2100
2200
2300
2400
2500
2600
2700
2800
2900
3000

Measured
Measured
Measured
Measured
Measured
Measured
Measured
Measured
Measured
Measured
Measured
Measured
Measured
Measured
Measured
Measured
Measured
Measured
Measured
Measured
Measured

frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:
frequency:

1000 [Hz]
1100 [Hz]
1200 [Hz]
1300 [Hz]
1400 [Hz]
1500 [Hz]
1600 [Hz]
1700 [Hz]
1800 [Hz]
1900 [Hz]
2000 [Hz]
2100 [Hz]
2200 [Hz]
2300 [Hz]
2400 [Hz]
2500 [Hz]
2600 [Hz]
2700 [Hz]
2800 [Hz]
2900 [Hz]
3000 [Hz]

For more detailed information related to S32 Design Studio usage please consult the available documentation.

Example application that shows the LPTMR's Timer feature

Application description

The purpose of this demo application is to show you how to use the LPTMR's Timer functionality from the S32«
K144 W using the S32 SDK API.

Prerequisites

» The LPTMR is configured to generate a periodic interrupt at 1 seconds which toggles a LED.

To run the example you will need to have the following items:

+ 1 Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
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* 1 Mother Board S32K-MB PCB RevA SCH RevB
» 1 Power Adapter 12V (if the board can't be powered from the USB)
» 1 Personal Computer

* 1 PEmicro Debugger

Boards supported
The following boards are supported by this application:

» Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
* Mother Board S32K-MB PCB RevA SCH RevB
* XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION S32K-MB XS32K14WEVB-Q064
LEDO (PTCO) JP49.1 - JP49.2 (PTE7) wired on the board
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select Iptmr_periodic_«
interrupt_s32k144w. Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. First go to
Project Explorer View in S32 DS and select the current project(lptmr_periodic_interrupt_s32k144w). Select the
"ConfigTools" menu then click on the desired configurator (Pins, Cocks, Peripherals etc...). Clicking on any one of
those will generate all the components. Make the desired changes(if any) then click on the "ConfigTools->Update
Code" button.

3. Building the project

Select the configuration to be built RAM (Debug_RAM) by left clicking on the downward arrow corresponding to the
build button(. Wait for the build action to be completed before continuing to the next step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description
Iptmr_periodic_interrupt_s32k144w_debug_ram« | Debug the RAM configuration using PEMicro
_pemicro debuggers
Iptmr_periodic_interrupt_s32k144w_debug_« Debug the FLASH configuration using PEMicro
flash_pemicro debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Generated on Fri Jun 11 2021 08:14:09 for S32SDK User Manual by Doxygen



13.4 Driver Examples 119

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.47 LPTMR Periodic Interrupt

Example application that shows the LPTMR's Pulse Counting feature

Application description

The purpose of this demo application is to show you how to use the Low Power Timer's Pulse Counter functionality
from the S32K144W using the S32 SDK API.

« The example is configured to trigger an interrupt and toggle an LED after three pulses, sourced from one of
the board's buttons.

Prerequisites
To run the example you will need to have the following items:

« 1 Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
* 1 Mother Board S32K-MB PCB RevA SCH RevB

+ 1 Power Adapter 12V (if the board can't be powered from the USB)

» 1 Personal Computer

* 1 PEmicro Debugger

Boards supported
The following boards are supported by this application:

» Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
* Mother Board S32K-MB PCB RevA SCH RevB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION S32K-MB XS32K14WEVB-Q064
LEDO (PTCO) JP49.1 - JP49.2 (PTE?) wired on the board
BUTTONS (PTE11) J36.1-2, J63.2-3, J64.1-2 SW2(J6.2) - J4.3

How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File ->> New S32DS Project From... and select Iptmr_pulse_counter_«
s32k144w. Then click on Finish.
The project should now be copied into you current workspace.
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2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. First go to
Project Explorer View in S32 DS and select the current project(lptmr_pulse_counter_s32k144w). Select the
"ConfigTools" menu then click on the desired configurator (Pins, Cocks, Peripherals etc...). Clicking on any one of
those will generate all the components. Make the desired changes(if any) then click on the "ConfigTools->Update
Code" button.

3. Building the project

Select the configuration to be built RAM (Debug_RAM) by left clicking on the downward arrow corresponding to the
build button(. Wait for the build action to be completed before continuing to the next step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description
Iptmr_pulse_counter_s32k144w_debug_ram_« Debug the RAM configuration using PEMicro
pemicro debuggers
Iptmr_pulse_counter_s32k144w_debug_flash_«~ Debug the FLASH configuration using PEMicro
pemicro debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note
For more detailed information related to S32 Design Studio usage please consult the available documentation.
13.4.48 PDB Periodic Interrupt

Driver example using PDB for demonstrating PDB timer functionality

Application description

The purpose of this demo application is to show the use of PDB driver for configuring PDB as timer. The PDB is
configured to generate a periodic interrupt which toggles an LED.

Prerequisites

To run the example you will need to have the following items:

1 XS32K14WEVB-Q064 board
» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 1 Personal Computer

» 1 PEmicro debugger (optional, users can use Open SDA)

Boards supported

The following boards are supported by this application:

+ S32K14xCVD-Q064 with S32K-MB
+ XS32K14WEVB-Q064
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Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION S32K14xCVD-Q064 with XS32K14WEVB-Q064
S32K-MB
LEDO (PTCO) JP49 must be connected (PTE7) wired on the board
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New -> S32DS Project From and select pdb_periodic_interrupt—
_s32k144w. Then click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration was initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration" (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".

3. Building the project

Select the configuration to be built RAM (Debug_RAM) or FLASH (Debug_FLASH) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description
pdb_periodic_interrupt_s32k144w_debug_ram_«— | Debug the RAM configuration using PEMicro
pemicro debuggers
pdb_periodic_interrupt_s32k144w_debug_flash«— | Debug the FLASH configuration using PEMicro
_pemicro debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.49 RTC Alarm

Example application showing basic use cases for the RTC module

Application description

The purpose of this demo application is to show you how to use the Real Time Clock module from the S32K144W
MCU with the S32 SDK API.
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The RTC is configured to generate an interrupt every 1 second toggling LEDO. If the alarm button is pressed an
alarm interrupt toggles the alarm LED1 after 5 seconds.

Prerequisites
To run the example you will need to have the following items:

+ 1 XS32K14WEVB-Q064 board

» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 2 Dupont male to male cable

» 1 Personal Computer

* 1 PEmicro

Boards supported

The following boards are supported by this application:

+ XS32K14WEVB-Q064
+ S32K14xCVD-Q064 with S32K-MB

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION XS32K14WEVB-Q064 S32K14xCVD-Q064

LEDO RGB_GREEN - wired on the board | LEDO - wired on the board
LED1 RGB_RED - wired on the board LED1 - wired on the board
BUTTON SW3 - wired on the board BUTTON 0 - wired on the board

Make sure the following jumpers are set:

Jumper Name S32K-MB

JP49 Set jumper on position 1-2

JP50 Set jumper on position 1-2

JP39 Set jumper on position 1-2

J69 Set jumper on position 1-2

J70 Set jumper on position 2-3
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File ->> New S32DS Project From and select rtc_alarm_s32k144w. Then
click on Finish.

The project should now be copied into you current workspace. Wait for the S32 Configuration was initialized and
ready.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. Left click on
the current project, then click "Open S32 Configuration” (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configurator (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code".
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3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description

rtc_alarm_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

rtc_alarm_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Notes

If the example doesn't work, please Flash the Debug_FLASH configuration and enforce a power on reset of the
board.
This is caused by the fact that the register which configures the RTC clock source can only be written once.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.50 TIMING PAL

Driver example using TIMING PAL

Application description

The purpose of this application is to show you how to use the TIMING PAL over LPIT, LPTMR and FTM timers on
the S32K144W using the S32 SDK API.

The application uses one board instance of LPIT, LPTMR and FTM to periodically toggle 3 leds every second.

Prerequisites

To run the example you will need to have the following items:

+ 1 Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
* 1 Mother Board S32K-MB PCB RevA SCH RevB

» 1 Power Adapter 12V (if the board can't be powered from the USB)

» 1 Personal Computer

» 1 PEmicro Debugger
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Boards supported

The following boards are supported by this application:

» Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
« Mother Board S32K-MB PCB RevA SCH RevB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION XS32K14WEVB-Q064 S32K-MB

LEDO (PTCO) RGB_GREEN - wired on the board | JP49.1 - JP49.2

LED1 (PTC1) RGB_RED - wired on the board JP50.1 - JP50.2

LED2 (PTC2) RGB_BLUE - wired on the board JP51.1 - JP51.2
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select timing_pal_s32k144w.
Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. First go to
Project Explorer View in S32 DS and select the current project(timing_pal_s32k144w). Select the "ConfigTools"
menu then click on the desired configurator (Pins, Cocks, Peripherals etc...). Clicking on any one of those will
generate all the components. Make the desired changes(if any) then click on the "ConfigTools->Update Code"
button.

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug Configurations for this project:

Configuration Name Description

timing_pal_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

timing_pal_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.
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13.4.51 PWM PAL

Example application using the PWM PAL

Application description
The purpose of this demo application is to show you how to use the PWM PAL from the S32K144W CPU using the

S32 SDK API. The example will dim the ORANGE LED on mother board or RGB_GREEN led on EVB board by
varying the duty cycle of the PWM signal.

Prerequisites

To run the example you will need to have the following items:

1 XS32K14WEVB-Q064 board
» 1 Power Adapter 12V (if the board cannot be powered from the USB port)
» 1 Personal Computer

» 1 PEmicro Debugger (optional, users can use Open SDA)

Boards supported

The following boards are supported by this application:

+ S32K144W-MB

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION S32K144W-MB XS32K14WEVB-Q064
FTMO Channel 0 (PTCO) LED_ORANGE - Connected LED_GREEN - Connected J4.6 to
J49.1 t0 J49.2 J3.6
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select pwm_pal_s32k144w.
Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs to
be generated. The initial configuration will have the same settings as the default example settings. Right click on
the current project, then click "Open S32 Configuration" (it has blue chip symbol on the top of the toolbar). In S32
Configuration menu, click on the desired configuration (Pins, Clock, Peripherals, etc.). Clicking on any one of those
will generate all the components. Pay attention to any error and warning message. If any configured value is invalid,
they will be shown for user. Make the desired changes (if any) then click "Update Code"."
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3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configurations for this project:

Configuration Name Description

pwm_pal_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

pwm_pal_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note
For more detailed information related to S32 Design Studio usage please consult the available documentation.
13.4.52 OCPAL

Driver example using OC PAL

Application description

The purpose of this demo application is to show you how to use the OC PAL of the S32K144W MCU with this SDK.
The demo is configured to toggle a LED in an interrupt callback.

The examples use OC PAL over FTMO.

« Initialize the OC PAL module with interrupt function callback.

« This application will toggle green led with period 2 second after each OC PAL interrupt.

Prerequisites

To run the example you will need to have the following items:

1 S32K144W board

» 1 Power Adapter 12V (if the board can't be powered from the USB)
» 1 Personal Computer

» 1 PEmicro Debugger (optional, users can use Open SDA)

Boards supported

The following boards are supported by this application:

+ XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:
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PIN FUNCTION XS32K14WEVB-Q064
FTMO Channel 0 (PTEO) RGB_GREEN - wired on the board
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select oc_pal_s32k144w. Then
click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. First go to
Project Explorer View in S32 DS and select the current project(oc_pal_s32k144w). Select the "ConfigTools" menu
then click on the desired configurator (Pins, Cocks, Peripherals etc...). Clicking on any one of those will generate all
the components. Make the desired changes(if any) then click on the "ConfigTools->Update Code" button.

3. Building the project

Select the configuration to be built FLASH (Debug_FLASH) or RAM (Debug_RAM) by left clicking on the downward
arrow corresponding to the build button(. Wait for the build action to be completed before continuing to the next
step.

4. Running the project

Go to Run and select Debug Configurations. There will be one debug configuration for this project:

Configuration Name Description

oc_pal_s32k144w_debug_flash_pemicro Debug the FLASH configuration using PEMicro
debuggers

oc_pal_s32k144w_debug_ram_pemicro Debug the RAM configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-
spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

13.4.53 LPIT Periodic Interrupt

Driver example that will show the LPIT functionality

Application description

The purpose of this demo application is to show you how to use the Low Power Interrupt Timer from the S32K144W
using the S32 SDK API.

» The example is configured to trigger an interrupt every second, which toggles a LED.

See also

For other LPIT usage scenario check: ADC_LOW_POWER_group
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Prerequisites
To run the example you will need to have the following items:

+ 1 Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
* 1 Mother Board S32K-MB PCB RevA SCH RevB

» 1 Power Adapter 12V (if the board cannot be powered from the USB port)

» 1 Personal Computer

* 1 PEmicro Debugger

XS32K14WEVB-Q064

Boards supported
The following boards are supported by this application:

» Daughter Card S32K14xCVD-Q64 PCB RevX2 SCH RevA1 with S32K144W
* Mother Board S32K-MB PCB RevA SCH RevB
* XS32K14WEVB-Q064

Hardware Wiring

The following connections must be done to for this example application to work:

PIN FUNCTION S32K-MB XS32K14WEVB-Q064
LEDO (PTCO) JP49.1 - JP49.2 (PTEO) wired on the board
How to run

1. Importing the project into the workspace

After opening S32 Design Studio, go to File -> New S32DS Project From... and select Ipit_periodic_interrupt—
_s32k144w. Then click on Finish.
The project should now be copied into you current workspace.

2. Generating the S32 configuration

The example will run without an active configuration, however if any changes are required, a configuration needs
to be generated. The initial configuration will have the same settings as the default example settings. First go to
Project Explorer View in S32 DS and select the current project(lpit_periodic_interrupt_s32k144w). Select the
"ConfigTools" menu then click on the desired configurator (Pins, Cocks, Peripherals etc...). Clicking on any one of
those will generate all the components. Make the desired changes(if any) then click on the "ConfigTools->Update
Code" button.

3. Building the project

Select the configuration to be built RAM (Debug_RAM) by left clicking on the downward arrow corresponding to the
build button(. Wait for the build action to be completed before continuing to the next step.

4. Running the project

Go to Run and select Debug Configurations. There will be two debug configuration for this project:
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Configuration Name Description
Ipit_periodic_interrupt_s32k144w_debug_ram_« Debug the RAM configuration using PEMicro
pemicro debuggers

Ipit_periodic_interrupt_s32k144w_debug_flash_«
pemicro

Debug the FLASH configuration using PEMicro
debuggers

Select the desired debug configuration and click on Launch. Now the perspective will change to the Debug Per-

spective.
Use the controls to control the program flow.

Note

For more detailed information related to S32 Design Studio usage please consult the available documentation.

14 Module Index

14.1 Modules

Here is a list of all modules:

ADC Driver

Analog to Digital Converter - Peripheral Abstraction Layer (ADC PAL)

Automotive Math and Motor Control Library
Clock
Clock Manager
Clock Manager Driver
Comparator (CMP)

Comparator Driver

Controller Area Network - Peripheral Abstraction Layer (CAN PAL)

Controller Area Network with Flexible Data Rate (FlexCAN)

FlexCAN Driver

Cryptographic Services Engine (CSEc)
CSEc Driver

Cyclic Redundancy Check (CRC)
CRC Driver

Enhanced Direct Memory Access (eDMA)
EDMA Driver

Error Injection Module (EIM)
EIM Driver

Error Reporting Module (ERM)

ERM Driver

132

153

166

194

195

196

239

243

259

276

357

280

173

281

168

328

288

329

313

331

318
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External Watchdog Monitor (EWM) 333
EWM Driver 323
Flash Memory (Flash) 354
Flash Memory (Flash) 334
FlexTimer (FTM) 432
FlexTimer Input Capture Driver (FTM_IC) 470
FlexTimer Module Counter Driver (FTM_MC) 478
FlexTimer Output Compare Driver (FTM_OC) 482
FlexTimer Pulse Width Modulation Driver (FTM_PWM) 488
FlexTimer Quadrature Decoder Driver (FTM_QD) 505
Flexible 1/O (FlexlO) 511
FlexlO Common Driver 379
FlexIO 12C Driver 382
FlexIO I2S Driver 391
FlexlO SPI Driver 409
FlexlO UART Driver 423
FreeRTOS 512
I12S - Peripheral Abstraction Layer (12S PAL) 513
Input Capture - Peripheral Abstraction Layer (IC PAL) 522
Inter Integrated Circuit - Peripheral Abstraction Layer(12C PAL) 531
Interrupt Manager (Interrupt) 548
Local Interconnect Network (LIN) 655
LIN Driver 559
LIN Stack 578
Diagnostic services 283

Node configuration 729

Node identification 734

LIN Core API 558
Common Core API. 233

Driver and cluster management 287

Interface management 546

Notification 735
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Schedule management 827

Signal interaction 861

User provided call-outs 945

J2602 Specific API 554

LIN 2.1 Specific API 556

Low level API 663
Transport layer API 890
Common Transport Layer API 235

Cooked API 278

Initialization 521

Raw API 819

J2602 Transport Layer specific API 555

Node configuration 727

Low Power Inter-Integrated Circuit (LPI2C) 656
LPI2C Driver 581
Low Power Interrupt Timer (LPIT) 657
LPIT Driver 597
Low Power Serial Peripheral Interface (LPSPI) 658
LPSPI Driver 612
Low Power Timer (LPTMR) 661
LPTMR Driver 630
Low Power Universal Asynchronous Receiver-Transmitter (LPUART) 662
LPUART Driver 640
Memory Protection Unit (MPU) 720
MPU Driver 695
Memory Protection Unit Peripheral Abstraction Layer (MPU PAL) 722
MPU PAL 709
OS Interface (OSIF) 736
Output Compare - Peripheral Abstraction Layer (OC PAL) 745
Pins Driver (PINS) 774
PINS Driver 768
Power Manager 776
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Power Manager Driver 786
Power_s32k1xx 788
Programmable Delay Block (PDB) 794
PDB Driver 756
Pulse-width modulation - Peripheral Abstraction Layer (PWM PAL) 795
Real Time Clock Driver (RTC) 821
RTC Driver 804
Security Peripheral Abstraction Layer - SECURITY PAL 846
Security PAL 828
Serial Peripheral Interface - Peripheral Abstraction Layer(SPI PAL) 849
SoC Header file (SoC Header ) 862
S32K144 SoC Header file 825
Backward Compatibility Symbols for S32K144 167
Interrupt vector numbers for S32K144 553
Peripheral access layer for S32K144 773

SoC Support 863
S32K144 System Files 826
Structural Core Self Test 865
System Basis Chip Driver (SBC) - UJA116xA Family 867
UJA116xA SBC Driver 891
TRGMUX Driver 872
Timing - Peripheral Abstraction Layer (TIMING PAL) 879
Universal Asynchronous Receiver/Transmitter - Peripheral Abstraction Layer (UART PAL) 932
Watchdog Peripheral Abstraction Layer (WDG PAL) 962
WDG PAL 946
Watchdog timer (WDOG) 965
WDOG Driver 953

15 Data Structure Index

15.1 Data Structures

Here are the data structures with brief descriptions:
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adc_callback_info_t
Defines a structure used to pass information to the ADC PAL callback 966

adc_instance_t
Structure storing PAL instance information 966

can_instance _t
Structure storing PAL instance information 967

drv_config_t 967

i2c_instance_t
Structure storing PAL instance information 968

i2s_instance_t
Structure storing PAL instance information 969

ic_instance_t
Structure storing PAL instance information 969

lin_product_id_t
Product id structure Implements : lin_product_id_t_Class 970

mpu_instance_t
Structure storing PAL instance information 971

oc_instance_t
Structure storing PAL instance information 971

oc_pal_state_t
The internal context structure 972

pwm_instance_t
Structure storing PAL instance information 972

spi_instance_t
Structure storing PAL instance information 973

timer_chan_state t
Runtime state of the Timer channel 973

timing_instance_t
Structure storing PAL instance information 974

uart_instance_t
Structure storing PAL instance information 974

wdg_instance_t
Structure storing PAL instance information 975

16 Module Documentation

16.1 ADC Driver
16.1.1 Detailed Description

Analog to Digital Converter Peripheral Driver.
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The ADC is a configurable 12-bit (selectable to between 8-bit, 10-bit and 12-bit resolution) single-ended SA«
R converter.

Features of the ADC include:

* up to 32 control channels (depending on the device variant), with configurable triggers

» up to 32 selectable external input sources (depending on the device variant) and multiple internal input
sources

+ hardware compare and average functions

« auto-calibration feature

Hardware background

The ADC included in the S32K14x series is a selectable resolution (8, 10, 12-bit), single-ended, SAR converter.
Depending on the device variant, each ADC instance has up to 40 selectable input channels (up to 32 external and
up to 8 internal) and up to 32 control channels (each with a result register, an input channel selection register and
interrupt enable).

Sample time is configurable through selection of A/D clock and a configurable sample time (in A/D clocks).
Also provided are the Hardware Average and Hardware Compare Features.

Hardware Average will sample a selectable number of measurements and average them before signaling a Con-
version Complete.

Hardware Compare can be used to signal if an input channel goes outside (or inside) of a predefined range.

The Calibration features can be used to automatically calibrate or fine-tune the ADC before use.
Driver consideration

The ADC Driver provides access to all features, but not all need to be configured to use the ADC. The user appli-
cation can use the default for most settings, changing only what is necessary. For example, if Compare or Average
features are not used, the user does not need to configure them.

The Driver uses structures for configuration. Each structure contains members that are specific to its respective
functionality. There is a converter structure, a hardware compare structure, a hardware average structure and a
calibration structure. Each struct has a corresponding ITnitStruct () method that can be used to initialize the
members to reset values, so the user can change only the values that are specific to the application.

The Driver also includes support for configuring the Trigger Latching and Arbitration Unit controlled from a separate
hardware module - System Integration Module (SIM).

Interrupt handling

The ADC Driver in S32 SDK does not use interrupts internally. These can be defined by the user application. There
are two ways to add an ADC interrupt:

1. Using the weak symbols defined by start-up code. If the methods ADCx_Handler (void) (x denotes
instance number) are not defined, the linker uses a default ISR. An error will be generated if methods with
the same name are defined multiple times. This method works regardless of the placement of the interrupt
vector table (Flash or RAM).

2. Using the Interrupt Manager's INT_SYS_InstallHandler () method. This can be used to dynamically
change the ISR at run-time. This method works only if the interrupt vector table is located in RAM (S32 SDK
behavior). To get the ADC instance's interrupt number, use ADC_DRV_Get InterruptNumber ().

Clocking and pin configuration

The ADC Driver does not handle clock setup (from PCC) or any kind of pin configuration (done by PORT module).
This is handled by the Clock Manager and PORT module, respectively. The driver assumes that correct clock
configurations have been made, so it is the user's responsibility to set up clocking and pin configurations correctly.
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Triggering a conversion

There are two separate ways for triggering an ADC conversion from a control channel:

1. Software triggering Only conversion from first control channel may be triggered from software - must enabled
at converter configuration Initiated by writing a valid input channel ID to the first control channel - use ADC«
_DRV_ConfigChan().

2. Hardware triggering Conversion from any control channel may be hardware triggered - however for first control
channel it must be enabled at converter configuration.

Integration guideline

Compilation units

The following files need to be compiled in the project:

* ${S32SDK_PATH}\platform\drivers\src\adc_driver.c

*

Include path

The following paths need to be added to the include path of the toolchain:

* ${S32SDK_PATH}\platform\drivers\inc\

*

Compile symbols
No special symbols are required for this component
Dependencies

Clock Manager

Data Structures

« struct adc_converter_config_t

Defines the converter configuration. More...
« struct adc_compare_config_t

Defines the hardware compare configuration. More...
« struct adc_average_config_t

Defines the hardware average configuration. More...
« struct adc_chan_config_t

Defines the control channel configuration. More...
« struct adc_calibration_t

Defines the user calibration configuration. More...

Enumerations

+ enum adc_clk_divide_t { ADC_CLK_DIVIDE_1 = 0x00U, ADC_CLK_DIVIDE_2 = 0x01U, ADC_CLK_DIVIx-
DE_4 = 0x02U, ADC_CLK_DIVIDE_8 = 0x03U }

Clock Divider selection.

» enum adc_resolution_t { ADC_RESOLUTION_8BIT = 0x00U, ADC_RESOLUTION_12BIT = 0x01U, ADC+
_RESOLUTION_10BIT = 0x02U }

Conversion resolution selection.
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* enum adc_input_clock_t { ADC_CLK_ALT_1 = 0x00U, ADC_CLK_ALT_2 = 0x01U, ADC_CLK_ALT_3 =
0x02U, ADC_CLK_ALT_4 = 0x03U }
Input clock source selection.
» enum adc_trigger_t { ADC_TRIGGER_SOFTWARE = 0x00U, ADC_TRIGGER_HARDWARE = 0x01U }
Trigger type selection.
» enum adc_pretrigger_sel_t { ADC_PRETRIGGER_SEL_PDB = 0x00U, ADC_PRETRIGGER_SEL_TRGM«
UX = 0x01U, ADC_PRETRIGGER_SEL_SW = 0x02U }
Pretrigger types selectable from Trigger Latching and Arbitration Unit.
» enum adc_trigger_sel_t { ADC_TRIGGER_SEL_PDB = 0x00U, ADC_TRIGGER_SEL_TRGMUX = 0x01U }
Trigger source selectable from Trigger Latching and Arbitration Unit.
» enum adc_sw_pretrigger_t {
ADC_SW_PRETRIGGER_DISABLED = 0x00U, ADC_SW_PRETRIGGER_0 = 0x04U, ADC_SW_PRETR+«
IGGER_1 = 0x05U, ADC_SW_PRETRIGGER_2 = 0x06U,
ADC_SW_PRETRIGGER_3 = 0x07U }
Software pretriggers which may be set from Trigger Latching and Arbitration Unit.
* enum adc_voltage_reference_t { ADC_VOLTAGEREF_VREF = 0x00U, ADC_VOLTAGEREF_VALT =
0x01U }
Voltage reference selection.
» enum adc_average_t { ADC_AVERAGE_4 = 0x00U, ADC_AVERAGE_8 = 0x01U, ADC_AVERAGE_16 =
0x02U, ADC_AVERAGE_32 = 0x03U }
Hardware average selection.
* enum adc_inputchannel_t {
ADC_INPUTCHAN_EXTO0 = 0x00U, ADC_INPUTCHAN_EXT1 = 0x01U, ADC_INPUTCHAN_EXT3 = 0x03U,
ADC_INPUTCHAN_EXT4 = 0x04U,
ADC_INPUTCHAN_EXT5 = 0x05U, ADC_INPUTCHAN_EXT6 = 0x06U, ADC_INPUTCHAN_EXT7 = 0x07U,
ADC_INPUTCHAN_EXT9 = 0x09U,
ADC_INPUTCHAN_EXT10 = 0x0AU, ADC_INPUTCHAN_EXT11 = 0x0BU, ADC_INPUTCHAN_EXT12 =
0x0CU, ADC_INPUTCHAN_EXT13 = 0x0DU,
ADC_INPUTCHAN_EXT14 = 0xOEU, ADC_INPUTCHAN_DISABLED = ADC_SC1_ADCH_MASK, ADC_I+
NPUTCHAN_INTO = 0x15, ADC_INPUTCHAN_INT1 = 0x16,
ADC _INPUTCHAN_INT2 = 0x17, ADC_INPUTCHAN_INT3 = 0x1C, ADC_INPUTCHAN_TEMP = 0x1A, A~
DC_INPUTCHAN_BANDGAP = 0x1B,
ADC_INPUTCHAN_VREFSH = 0x1D, ADC_INPUTCHAN_VREFSL = 0x1E, ADC_INPUTCHAN_SUPPLY «+
VDD = 0xFOOU, ADC_INPUTCHAN_SUPPLY_VDDA = 0xF01U,
ADC_INPUTCHAN_SUPPLY_VREFH = 0xF02U, ADC_INPUTCHAN_SUPPLY_VDD_3V = 0xFO3U, ADC+
_INPUTCHAN_SUPPLY_VDD_FLASH_3V = 0xF04U, ADC_INPUTCHAN_SUPPLY_VDD_LV = 0xF05U }
Enumeration of input channels assignable to a control channel.
Note 0: entries in this enum are affected by ::FEATURE_ADC_NUM_EXT_CHANS, which is device dependent and
controlled from "device _name"_features.h file.
» enum adc_latch_clear_t { ADC_LATCH_CLEAR_WAIT, ADC_LATCH_CLEAR_FORCE }
Defines the trigger latch clear method Implements : adc_latch_clear t Class.
Converter

Converter specific methods. These are used to configure and use the A/D Converter specific functionality,
including:

clock input and divider
sample time in A/D clocks
resolution

trigger source

voltage reference
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« enable DMA

< enable continuous conversion on one channel

To start a conversion, a control channel (see Channel Configuration) and a trigger source must be configured. Once
a conversion is started, the user application can wait for it to be finished by calling the ADC_DRV_WaitConvDone()
function.

Only the first control channel can be triggered by software. To start a conversion in this case, an input channel
must be written in the channel selection register using the ADC_DRV_ConfigChan() method. Writing a value to the
control channel while a conversion is being performed on that channel will start a new conversion.

 void ADC_DRV_InitConverterStruct (adc_converter_config_t *xconst config)

Initializes the converter configuration structure.
» void ADC_DRV_ConfigConverter (const uint32_t instance, const adc_converter_config_t xconst config)

Configures the converter with the given configuration structure.
» void ADC_DRV_GetConverterConfig (const uint32_t instance, adc_converter_config_t *const config)

Gets the current converter configuration.
» void ADC_DRV_Reset (const uint32_t instance)

Resets the converter (sets all configurations to reset values)
» void ADC_DRV_WaitConvDone (const uint32_t instance)

Waits for a conversion/calibration to finish.
» bool ADC_DRV_GetConvCompleteFlag (const uint32_t instance, const uint8_t chanindex)

Gets the control channel Conversion Complete Flag state.

Hardware Compare

The Hardware Compare feature of the S32K144 ADC is a versatile mechanism that can be used to monitor that a
value is within certain values. Measurements can be monitored to be within certain ranges:

* less than/ greater than a fixed value

* inside or outside of a certain range

Two compare values can be configured (the second value is used only for range function mode). The compare
values must be written in 12-bit resolution mode regardless of the actual used resolution mode.

Once the hardware compare feature is enabled, a conversion is considered complete only when the measured value
is within the allowable range set by the configuration.

 void ADC_DRV_InitHwCompareStruct (adc_compare_config_t *const config)

Initializes the Hardware Compare configuration structure.
» void ADC_DRV_ConfigHwCompare (const uint32_t instance, const adc_compare_config_t *const config)

Configures the Hardware Compare feature with the given configuration structure.
 void ADC_DRV_GetHwCompareConfig (const uint32_t instance, adc_compare_config_t *const config)

Gets the current Hardware Compare configuration.

Hardware Average

The Hardware Average feature of the S32K144 allows for a set of measurements to be averaged together as a
single conversion. The number of samples to be averaged is selectable (4, 8, 16 or 32 samples).

» void ADC_DRV_InitHwAverageStruct (adc_average_config_t xconst config)

Initializes the Hardware Average configuration structure.
» void ADC_DRV_ConfigHwAverage (const uint32_t instance, const adc_average_config_t *const config)

Configures the Hardware Average feature with the given configuration structure.
» void ADC_DRV_GetHwAverageConfig (const uint32_t instance, adc_average_config_t xconst config)

Gets the current Hardware Average configuration.
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Channel configuration

Control register specific functions. These functions control configurations for each control channel (input channel
selection and interrupt enable).

When software triggering is enabled, calling the ADC_DRV_ConfigChan() method for control channel 0 starts a new
conversion.

After a conversion is finished, the result can be retrieved using the ADC_DRV_GetChanResult() method.

» void ADC_DRV_InitChanStruct (adc_chan_config_t xconst config)

Initializes the control channel configuration structure.
» void ADC_DRV_ConfigChan (const uint32_t instance, const uint8_t chanlndex, const adc_chan_config_«
t *const config)

Configures the selected control channel with the given configuration structure.
» void ADC_DRV_GetChanConfig (const uint32_t instance, const uint8_t chanindex, adc_chan_config_«
t xconst config)

Gets the current control channel configuration for the selected channel index.
 void ADC_DRV_SetSwPretrigger (const uint32_t instance, const adc_sw_pretrigger_t swPretrigger)

This function sets the software pretrigger - affects only first 4 control channels.
» void ADC_DRV_GetChanResult (const uint32_t instance, const uint8_t chanindex, uint16_t xconst result)

Gets the last result for the selected control channel.

Automatic Calibration

These methods control the Calibration feature of the ADC.

The ADC_DRV_AutoCalibration() method can be called to execute a calibration sequence, or a calibration can be
retrieved with the ADC_DRV_GetUserCalibration() and saved to non-volatile storage, to avoid calibration on every
power-on. The calibration structure can be written with the ADC_DRV_ConfigUserCalibration() method.

» void ADC_DRV_AutoCalibration (const uint32_t instance)

Executes an Auto-Calibration.
«+ void ADC_DRV_lInitUserCalibrationStruct (adc_calibration_t *const config)

Initializes the User Calibration configuration structure.
» void ADC_DRV_ConfigUserCalibration (const uint32_t instance, const adc_calibration_t xconst config)

Configures the User Calibration feature with the given configuration structure.
» void ADC_DRV_GetUserCalibration (const uint32_t instance, adc_calibration_t *const config)

Gets the current User Calibration configuration.

Interrupts

This method returns the interrupt number for an ADC instance, which can be used to configure the interrupt, like in
Interrupt Manager.

» IRQn_Type ADC_DRV_GetInterruptNumber (const uint32_t instance)

Returns the interrupt number for the ADC instance.

Latched triggers processing
These functions provide basic operations for using the trigger latch mechanism.

» void ADC_DRV_ClearLatchedTriggers (const uint32_t instance, const adc_latch_clear_t clearMode)

Clear latched triggers under processing.
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+ void ADC_DRV_ClearTriggerErrors (const uint32_t instance)

Clear all latch trigger error.
» uint32_t ADC_DRV_GetTriggerErrorFlags (const uint32_t instance)

Get the trigger error flags bits of the ADC instance.

16.1.2 Data Structure Documentation

16.1.2.1 struct adc_converter_config_t

Defines the converter configuration.
This structure is used to configure the ADC converter
Implements : adc_converter_config_t_Class

Definition at line 249 of file adc_driver.h.
Data Fields

» adc_clk_divide_t clockDivide

» uint8_t sampleTime

« adc_resolution_t resolution

+ adc_input_clock_t inputClock

» adc_trigger_t trigger

+ adc_pretrigger_sel_t pretriggerSel
+ adc_trigger_sel_t triggerSel

* bool dmaEnable

» adc_voltage_reference_t voltageRef
* bool continuousConvEnable

* bool supplyMonitoringEnable

Field Documentation
16.1.2.1.1 adc_clk_divide_t clockDivide

Divider of the input clock for the ADC

Definition at line 251 of file adc_driver.h.
16.1.2.1.2 bool continuousConvEnable

Enable Continuous conversions

Definition at line 260 of file adc_driver.h.
16.1.2.1.3 bool dmaEnable

Enable DMA for the ADC

Definition at line 258 of file adc_driver.h.
16.1.2.1.4 adc_input_clock_t inputClock

Input clock source

Definition at line 254 of file adc_driver.h.
16.1.2.1.5 adc_pretrigger_sel_t pretriggerSel

Pretrigger source selected from Trigger Latching and Arbitration Unit - affects only the first 4 control channels

Definition at line 256 of file adc_driver.h.
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16.1.2.1.6 adc_resolution_t resolution

ADC resolution (8,10,12 bit)

Definition at line 253 of file adc_driver.h.
16.1.2.1.7 uint8_t sampleTime

Sample time in AD Clocks

Definition at line 252 of file adc_driver.h.

16.1.2.1.8  bool supplyMonitoringEnable

Only available for ADC 0. Enable internal supply monitoring - enables measurement of ADC_INPUTCHAN_SUP+«

PLY_ sources.

Definition at line 261 of file adc_driver.h.
16.1.2.1.9 adc_trigger._t trigger

ADC trigger type (software, hardware) - affects only the first control channel

Definition at line 255 of file adc_driver.h.
16.1.2.1.10 adc_trigger_sel_t triggerSel

Trigger source selected from Trigger Latching and Arbitration Unit

Definition at line 257 of file adc_driver.h.
16.1.2.1.11 adc_voltage_reference_t voltageRef

Voltage reference used

Definition at line 259 of file adc_driver.h.
16.1.2.2 struct adc_compare_config_t

Defines the hardware compare configuration.

This structure is used to configure the hardware compare feature for the ADC
Implements : adc_compare_config_t_Class

Definition at line 272 of file adc_driver.h.

Data Fields

* bool compareEnable

* bool compareGreaterThanEnable
* bool compareRangeFuncEnable
+ uint16_t compVali

» uint16_t compVal2

Field Documentation
16.1.2.2.1 bool compareEnable

Enable the compare feature

Definition at line 274 of file adc_driver.h.
16.1.2.2.2 bool compareGreaterThanEnable

Enable Greater-Than functionality
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Definition at line 275 of file adc_driver.h.
16.1.2.2.3 bool compareRangeFuncEnable

Enable Range functionality

Definition at line 276 of file adc_driver.h.
16.1.2.2.4 uint16_t compVali

First Compare Value

Definition at line 277 of file adc_driver.h.
16.1.2.2.5 uint16_t compVal2

Second Compare Value

Definition at line 278 of file adc_driver.h.
16.1.2.3 struct adc_average_config_t

Defines the hardware average configuration.

This structure is used to configure the hardware average feature for the ADC

Implements : adc_average_config_t_Class

Definition at line 289 of file adc_driver.h.
Data Fields
* bool hwAvgEnable
» adc_average_t hwAverage
Field Documentation
16.1.2.3.1 adc_average_t hwAverage

Selection for number of samples used for averaging

Definition at line 292 of file adc_driver.h.
16.1.2.3.2 bool hwAvgEnable

Enable averaging functionality

Definition at line 291 of file adc_driver.h.
16.1.2.4 struct adc_chan_config_t

Defines the control channel configuration.
This structure is used to configure a control channel of the ADC
Implements : adc_chan_config_t_Class

Definition at line 303 of file adc_driver.h.
Data Fields
* bool interruptEnable

 adc_inputchannel_t channel

Field Documentation
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16.1.2.4.1 adc_inputchannel_t channel

Selection of input channel for measurement

Definition at line 306 of file adc_driver.h.
16.1.2.4.2 bool interruptEnable

Enable interrupts for this channel

Definition at line 305 of file adc_driver.h.
16.1.2.5 struct adc_calibration_t

Defines the user calibration configuration.
This structure is used to configure the user calibration parameters of the ADC.
Implements : adc_calibration_t_Class

Definition at line 317 of file adc_driver.h.
Data Fields

* uint16_t userGain
« uint16_t userOffset

Field Documentation
16.1.2.5.1 uint16_t userGain

User-configurable gain

Definition at line 319 of file adc_driver.h.
16.1.2.5.2 uint16_t userOffset

User-configurable Offset (2's complement, subtracted from result)

Definition at line 320 of file adc_driver.h.

16.1.3 Enumeration Type Documentation

16.1.3.1 enum adc_average_t

Hardware average selection.

Implements : adc_average_t_Class

Enumerator

ADC _AVERAGE_4 Hardware average of 4 samples.
ADC _AVERAGE_8 Hardware average of 8 samples.
ADC _AVERAGE_16 Hardware average of 16 samples.
ADC _AVERAGE_32 Hardware average of 32 samples.

Definition at line 154 of file adc_driver.h.
16.1.3.2 enum adc_clk_divide_t

Clock Divider selection.

Implements : adc_clk_divide_t_Class
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Enumerator

ADC_CLK_DIVIDE_1 Input clock divided by 1.
ADC_CLK_DIVIDE_2 Input clock divided by 2.
ADC_CLK_DIVIDE_4 Input clock divided by 4.
ADC_CLK_DIVIDE_8 Input clock divided by 8.

Definition at line 57 of file adc_driver.h.
16.1.3.3 enum adc_input_clock_t

Input clock source selection.

Implements : adc_input_clock_t_Class

Enumerator

ADC _CLK_ALT_1 Input clock alternative 1.
ADC CLK_ALT 2 Input clock alternative 2.
ADC _CLK_ALT_3 Input clock alternative 3.
ADC CLK_ALT 4 Input clock alternative 4.

Definition at line 82 of file adc_driver.h.
16.1.3.4 enum adc_inputchannel_t

Enumeration of input channels assignable to a control channel.
Note 0: entries in this enum are affected by ::FEATURE_ADC_NUM_EXT_CHANS, which is device dependent and
controlled from "device_name"_features.h file.

Note 1: the actual number of external channels may differ between device packages and ADC instances. Reading
a channel that is not connected externally, will return a random value within the range. Please refer to the Reference
Manual for the maximum number of external channels for each device variant and ADC instance.

Note 2: ADC_INPUTCHAN_SUPPLY_ select which internal supply channel to be measured. They are only avail-
able for ADCO and measured internally via internal input channel 0. Please note that supply monitoring needs to be
enabled separately via dedicated flag in adc_converter_config_t.

Implements : adc_inputchannel_t_Class

Enumerator

ADC_INPUTCHAN_EXTO External input channel 0
ADC_INPUTCHAN_EXT1 External input channel 1
ADC_INPUTCHAN_EXT3 External input channel 3
ADC_INPUTCHAN_EXT4 External input channel 4
ADC_INPUTCHAN_EXT5 External input channel 5
ADC_INPUTCHAN_EXT6 External input channel 6
ADC_INPUTCHAN_EXT7 External input channel 7
ADC_INPUTCHAN_EXT9 External input channel 9
ADC _INPUTCHAN_EXT10 External input channel 10
ADC_INPUTCHAN_EXT11 External input channel 11
ADC_INPUTCHAN_EXT12 External input channel 12
ADC _INPUTCHAN_EXT13 External input channel 13
ADC _INPUTCHAN_EXT14 External input channel 14
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ADC_INPUTCHAN_DISABLED Channel disabled

ADC_INPUTCHAN_INTO Internal input channel 0

ADC_INPUTCHAN_INT1 Internal input channel 1

ADC_INPUTCHAN_INT2 Internal input channel 2

ADC_INPUTCHAN_INT3 Internal input channel 3

ADC_INPUTCHAN_TEMP Temperature Sensor

ADC_INPUTCHAN_BANDGAP Band Gap

ADC_INPUTCHAN_VREFSH \oltage Reference Select High

ADC_INPUTCHAN_VREFSL V\oltage Reference Select Low
ADC_INPUTCHAN_SUPPLY_VDD Monitor internal supply 5 V input VDD supply.
ADC_INPUTCHAN_SUPPLY VDDA Monitor internal supply 5 V input analog supply.

ADC _INPUTCHAN_SUPPLY _VREFH Monitor internal supply ADC reference supply.
ADC_INPUTCHAN_SUPPLY_VDD_3V Monitor internal supply 3.3 V oscillator regulator output.
ADC _INPUTCHAN_SUPPLY _VDD_FLASH_3V Monitor internal supply 3.3 V flash regulator output.
ADC _INPUTCHAN_SUPPLY _VDD_LV Monitor internal supply 1.2 V core regulator output.

Definition at line 177 of file adc_driver.h.
16.1.3.5 enumadc_latch_clear _t

Defines the trigger latch clear method Implements : adc_latch_clear_t_Class.

Enumerator

ADC_LATCH_CLEAR _WAIT Clear by waiting all latched triggers to be processed
ADC_LATCH_CLEAR FORCE Process current trigger and clear all latched

Definition at line 327 of file adc_driver.h.
16.1.3.6 enum adc_pretrigger_sel_t

Pretrigger types selectable from Trigger Latching and Arbitration Unit.

Implements : adc_pretrigger_sel_t_Class

Enumerator

ADC_PRETRIGGER_SEL_PDB PDB pretrigger selected.
ADC _PRETRIGGER _SEL_TRGMUX TRGMUX pretrigger selected.
ADC _PRETRIGGER_SEL_SW Software pretrigger selected.

Definition at line 106 of file adc_driver.h.
16.1.3.7 enum adc_resolution_t

Conversion resolution selection.

Implements : adc_resolution_t_Class

Enumerator

ADC_RESOLUTION_8BIT 8-bit resolution mode
ADC_RESOLUTION_12BIT 12-bit resolution mode
ADC_RESOLUTION_10BIT 10-bit resolution mode

Definition at line 70 of file adc_driver.h.
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16.1.3.8 enum adc_sw_pretrigger_t

Software pretriggers which may be set from Trigger Latching and Arbitration Unit.

Implements : adc_sw_pretrigger_t_Class

Enumerator

ADC_SW_PRETRIGGER_DISABLED SW pretrigger disabled.
ADC_SW_PRETRIGGER_0 SW pretrigger 0.
ADC_SW _PRETRIGGER_1 SW pretrigger 1.
ADC_SW_PRETRIGGER_2 SW pretrigger 2.
ADC_SW _PRETRIGGER_3 SW pretrigger 3.

Definition at line 129 of file adc_driver.h.
16.1.3.9 enum adc_trigger_sel_t

Trigger source selectable from Trigger Latching and Arbitration Unit.

Implements : adc_trigger_sel_t_Class

Enumerator

ADC _TRIGGER_SEL_PDB PDB trigger selected.
ADC _TRIGGER_SEL_TRGMUX TRGMUX trigger selected.

Definition at line 118 of file adc_driver.h.
16.1.3.10 enum adc_trigger _t

Trigger type selection.

Implements : adc_trigger_t_Class

Enumerator

ADC_TRIGGER_SOFTWARE Software trigger.
ADC _TRIGGER_HARDWARE Hardware trigger.

Definition at line 95 of file adc_driver.h.
16.1.3.11 enum adc_voltage_reference_t

Voltage reference selection.

Implements : adc_voltage_reference_t_Class

Enumerator

ADC_VOLTAGEREF_VREF \VrefH and VrefL as Voltage reference.
ADC _VOLTAGEREF _VALT ValtH and ValiL as Voltage reference.

Definition at line 143 of file adc_driver.h.

16.1.4 Function Documentation

16.1.4.1 void ADC_DRV_AutoCalibration ( const uint32_t instance )

Executes an Auto-Calibration.

This functions executes an Auto-Calibration sequence. It is recommended to run this sequence before using the
ADC converter.
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Parameters

in

instance \ instance number

Definition at line 555 of file adc_driver.c.

16.1.4.2 void ADC_DRV_ClearLatchedTriggers ( const uint32_t instance, const adc_latch_clear_t clearMode )

Clear latched triggers under processing.

This function clears all trigger latched flags of the ADC instance. This function must be called after the hardware
trigger source for the ADC has been deactivated.

Parameters
in instance | instance number of the ADC
in clearMode | The clearing method for the latched triggers

+ ADC_LATCH_CLEAR_WAIT : Wait for all latched triggers to be pro-
cessed.

* ADC_LATCH_CLEAR_FORCE : Clear latched triggers and wait for trig-
ger being process to finish.

Definition at line 712 of file adc_driver.c.

16.1.4.3 void ADC_DRV_ClearTriggerErrors ( const uint32_t instance )

Clear all latch trigger error.

This function clears all trigger error flags of the ADC instance.

Parameters

in

instance \ instance number of the ADC

Definition at line 737 of file adc_driver.c.

16.1.4.4 void ADC_DRV_ConfigChan ( const uint32_t instance, const uint8_t chanindex, const adc_chan_config_t xconst

config )

Configures the selected control channel with the given configuration structure.

When Software Trigger mode is enabled, configuring control channel index 0, implicitly triggers a new conversion
on the selected ADC input channel. Therefore, ADC_DRV_ConfigChan can be used for sw-triggering conversions.

Configuring any control channel while it is actively controlling a conversion (sw or hw triggered) will implicitly abort
the on-going conversion.

Parameters
in instance | instance number
in chanindex | the control channel index
in config | the configuration structure

Definition at line 381 of file adc_driver.c.

16.1.4.5 void ADC_DRV_ConfigConverter ( const uint32_t instance, const adc_converter_config_t xconst config )

Configures the converter with the given configuration structure.

This function configures the ADC converter with the options provided in the provided structure.
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Parameters

in instance | instance number

in config | the configuration structure

Definition at line 94 of file adc_driver.c.

16.1.4.6 void ADC_DRV_ConfigHwAverage ( const uint32_t instance, const adc_average_config_t xconst config )

Configures the Hardware Average feature with the given configuration structure.

This function sets the configuration for the Hardware Average feature.

Parameters
in instance | instance number
in config | the configuration structure

Definition at line 318 of file adc_driver.c.

16.1.4.7 void ADC_DRV_ConfigHwCompare ( const uint32_t instance, const adc_compare_config_t x«const config )

Configures the Hardware Compare feature with the given configuration structure.

This functions sets the configuration for the Hardware Compare feature using the configuration structure.

Parameters
in instance | instance number
in config | the configuration structure

Definition at line 255 of file adc_driver.c.

16.1.4.8 void ADC_DRV_ConfigUserCalibration ( const uint32_t instance, const adc_calibration_t xconst config )

Configures the User Calibration feature with the given configuration structure.

This function sets the configuration for the user calibration registers.

Parameters
in instance | instance number
in config | the configuration structure

Definition at line 658 of file adc_driver.c.

16.1.4.9 void ADC_DRV_GetChanConfig ( const uint32_t instance, const uint8_t chanindex, adc_chan_config_t *const

config )

Gets the current control channel configuration for the selected channel index.

This function returns the configuration for a control channel

Parameters
in instance | instance number
in chanindex | the control channel index
out config | the configuration structure

Definition at line 406 of file adc_driver.c.

16.1.4.10 void ADC_DRV_GetChanResult ( const uint32_t instance, const uint8_t chanindex, uint16_t xconst result )

Gets the last result for the selected control channel.

This function returns the conversion result from a control channel.
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Parameters

in instance | instance number

in chanindex | the converter control channel index

out result | the result raw value

Definition at line 517 of file adc_driver.c.

16.1.4.11

bool ADC_DRV_GetConvCompleteFlag ( const uint32_t instance, const uint8_t chanindex )

Gets the control channel Conversion Complete Flag state.

This function returns the state of the Conversion Complete flag for a control channel. This flag is set when a
conversion is complete or the condition generated by the Hardware Compare feature is evaluated to true.

Parameters

in instance | instance number

in chanindex | the adc control channel index
Returns

the Conversion Complete Flag state

Definition at line 490 of file adc_driver.c.

16.1.4.12 void ADC_DRV_GetConverterConfig ( const uint32_t instance, adc_converter_config_t xconst config )

Gets the current converter configuration.

This functions returns the configuration for converter in the form of a configuration structure.

Parameters
in instance | instance number
out config | the configuration structure

Definition at line 140 of file adc_driver.c.

16.1.4.13 void ADC_DRV_GetHwAverageConfig ( const uint32_t instance, adc_average_config_t xconst config )

Gets the current Hardware Average configuration.

This function returns the configuration for the Hardware Average feature.

Parameters
in instance | instance number
out config | the configuration structure

Definition at line 337 of file adc_driver.c.

16.1.4.14 void ADC_DRV_GetHwCompareConfig ( const uint32_t instance, adc_compare_config_t xconst config )

Gets the current Hardware Compare configuration.

This function returns the configuration for the Hardware Compare feature.

Parameters
in instance | instance number
out config | the configuration structure

Definition at line 277 of file adc_driver.c.
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16.1.4.15 IRQn_Type ADC_DRV_GetInterruptNumber ( const uint32_t instance )

Returns the interrupt number for the ADC instance.
This function returns the interrupt number for the specified ADC instance.

Parameters

in instance | instance number of the ADC

Returns

irg_number: the interrupt number (index) of the ADC instance, used to configure the interrupt
Definition at line 695 of file adc_driver.c.

16.1.4.16 uint32_t ADC_DRV_GetTriggerErrorFlags ( const uint32_t instance )

Get the trigger error flags bits of the ADC instance.
This function returns the trigger error flags bits of the ADC instance.

Parameters

in instance \ instance number of the ADC

Returns
trigErrorFlags The Trigger Error Flags bit-mask
Definition at line 753 of file adc_driver.c.
16.1.4.17 void ADC_DRV_GetUserCalibration ( const uint32_t instance, adc_calibration_t xconst config )

Gets the current User Calibration configuration.

This function returns the current user calibration register values.

Parameters
in instance | instance number
out config | the configuration structure

Definition at line 677 of file adc_driver.c.
16.1.4.18 void ADC_DRV_lInitChanStruct ( adc_chan_config_t x«const config )

Initializes the control channel configuration structure.

This function initializes the control channel configuration structure to default values (Reference Manual resets). This
function should be called on a structure before using it to configure a channel (ADC_DRV_ConfigChan), otherwise
all members must be written by the caller. This function insures that all members are written with safe values, so

the user can modify only the desired members.

Parameters

out config \ the configuration structure

Definition at line 359 of file adc_driver.c.
16.1.4.19 void ADC_DRV_lInitConverterStruct ( adc_converter_config_t «const config )

Initializes the converter configuration structure.

This function initializes the members of the adc_converter_config_t structure to default values (Reference Manual
resets). This function should be called on a structure before using it to configure the converter with ADC_DRV«-
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_ConfigConverter(), otherwise all members must be written (initialized) by the user. This function insures that all
members are written with safe values, so the user can modify only the desired members.
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Parameters

out config \ the configuration structure

Definition at line 69 of file adc_driver.c.
16.1.4.20 void ADC_DRV_InitHwAverageStruct ( adc_average_config_t x«const config )

Initializes the Hardware Average configuration structure.

This function initializes the Hardware Average configuration structure to default values (Reference Manual resets).
This function should be called before configuring the Hardware Average feature (ADC_DRV_ConfigHwAverage),
otherwise all members must be written by the caller. This function insures that all members are written with safe
values, so the user can modify the desired members.

Parameters

out config \ the configuration structure

Definition at line 302 of file adc_driver.c.
16.1.4.21 void ADC_DRV_InitHwCompareStruct ( adc_compare_config_t xconst config )

Initializes the Hardware Compare configuration structure.

This function initializes the Hardware Compare configuration structure to default values (Reference Manual resets).
This function should be called before configuring the Hardware Compare feature (ADC_DRV_ConfigHwCompare),
otherwise all members must be written by the caller. This function insures that all members are written with safe
values, so the user can modify the desired members.

Parameters

out config | the configuration structure

Definition at line 236 of file adc_driver.c.
16.1.4.22 void ADC_DRV_InitUserCalibrationStruct ( adc_calibration_t xconst config )

Initializes the User Calibration configuration structure.

This function initializes the User Calibration configuration structure to default values (Reference Manual resets).
This function should be called on a structure before using it to configure the User Calibration feature (ADC_DRV_+«
ConfigUserCalibration), otherwise all members must be written by the caller. This function insures that all members
are written with safe values, so the user can modify only the desired members. this function will check and reset
clock divide based the adc frequency. an error will be displayed if frequency is greater than required clock for
calibration.

Parameters

out config \ the configuration structure

Definition at line 642 of file adc_driver.c.
16.1.4.23 void ADC_DRV_Reset ( const uint32_t instance )

Resets the converter (sets all configurations to reset values)
This function resets all the internal ADC registers to reset values.

Parameters

in instance | instance number

Definition at line 178 of file adc_driver.c.
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16.1.4.24 void ADC_DRV_SetSwPretrigger ( const uint32_t instance, const adc_sw_pretrigger_t swPretrigger )

This function sets the software pretrigger - affects only first 4 control channels.
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Parameters
in instance | instance number
in swPretrigger | the swPretrigger to be enabled

Definition at line 426 of file adc_driver.c.
16.1.4.25 void ADC_DRV_WaitConvDone ( const uint32_t instance )

Waits for a conversion/calibration to finish.
This functions waits for a conversion to complete by continuously polling the Conversion Active Flag.

Parameters

in instance | instance number

Definition at line 470 of file adc_driver.c.
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16.2 Analog to Digital Converter - Peripheral Abstraction Layer (ADC PAL)
16.2.1 Detailed Description

Analog to Digital Converter - Peripheral Abstraction Layer (ADC PAL).
ADC PAL general consideration

The ADC PAL is an interface abstraction layer for multiple Analog to Digital Converter peripherals.

The ADC PAL allows configuration of groups of successive conversions started by a single trigger event.

Each conversion in a group is mapped to an ADC input channel - the conversion group is actually defined by an
array of input channels, which is a member of the adc_group_config_t structure. The order of the input channels
will also give the order of execution of the conversions within the group.

Note: all conversion groups need to be configured at PAL initialization time.

The trigger event for a group can be SW or HW, and needs to be selected at configuration time.

1. Execution of SW triggered groups may be started/stopped by calling a dedicated function ADC_Start«
GroupConversion(), ADC_StopGroupConversion().

2. HW triggered groups need to be enabled for execution by calling a dedicated function - the actual execution
will be started by the occurrence of the selected hardware trigger event ADC_EnableHardwareTrigger(), A«
DC_DisableHardwareTrigger().

Note: for HW triggered groups the ADC PAL does not configure the peripherals which provide the triggering
events (timers, counters, etc.) - they will need to be configured separately by the ADC PAL user.

Each group needs to have associated a result buffer which needs to be allocated by the PAL user. The length of
the result buffer is defined by two configuration parameters:

* numChannels - defines also the size of the inputChannelArray

* numSetsResultBuffer - defines the number of sets of results which can be stored in the result buffer.

The length of the result buffer = numChannels x numSetsResultBuffer. Each time a group of conversions finishes
execution, a set of results for all conversions in the group will be copied by the PAL into the corresponding result
buffer. The PAL considers the result buffer as circular, with the length configured via previously described.

On some platforms, HW triggered groups may support delay(s) between the occurrence of the HW trigger event
and the actual start of conversions. This feature can be controlled for each HW triggered group via delay Type and
delayArray parameters in adc_group_config_t. For SW triggered groups, these parameters are ignored. For details
please refer to ADC PAL platform specific information.

Each group can also have associated a notification callback which will be executed when all conversions
finish execution. The callback shall receive as parameter a pointer to adc_callback_info_t containing the group
index for which the notification is called, and result buffer tail - offset of the most recent conversion result in the result
buffer. Notifications can be enabled and disabled using ADC_EnableNotification() and ADC_DisableNotification().
By default the notification is set to active when enabling a HW triggered group or starting a SW triggered group.
Note: The notification callback may be set to NULL and thus it will not be called.

For SW triggered groups, continuous mode can be enabled at configuration time.

E.g.: a group with 3 conversions InputChO, InputCh1, InputCh2 -> with continuous mode enabled will continuously
repeat the series of conversions until it is stopped: InputChO0, InputCh1, InputCh2, InputChO0, InputCh1, InputCh2,...
The user needs to dimension accordingly the result buffer, such that it has sufficient time to read the results before
they are overwritten.

For HW triggered groups, continuous mode parameter is not available.

The ADC PAL implicitly configures and uses other peripherals besides ADC - these resources should not be
used simultaneously from other parts of the application. For details please refer to the platform specific details.

The ADC PAL module needs to include a configuration file named adc_pal cfg.h, which defines which IPs
are used.

The ADC PAL allows configuration of platform specific parameters via a pointer to a platform specific structure,
following the naming convention: extension_adc_<platform>_t. E.g.: extension_adc_s32k1xx_t
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Important note

The ADC PAL configuration structure passed via reference to ADC_Init(), including all arrays referenced by structure
members, must be persistent throughout the usage of the ADC PAL. Storing them to memory sections which get
freed or altered during ADC PAL usage, will lead to unpredictable behavior.

Platform specific details
S$32K1xx device family

On these platforms, each instance of ADC PAL uses:

+ one instance of PDB linked to the selected ADC (ADCn - PDBn) - used for both SW and HW triggered groups

» the TRGMUX_TARGET_MODULE_PDBn_TRG_IN targets from TRGMUX - used only for HW triggered
groups

These platforms are supported by the ADC PAL of type ADC_PAL_S32K1xx.

Important details:

1. The PAL supports configuring any number of conversion groups at PAL initialization time, but every time a
HW/SW triggered group is enabled/started, the underlying hardware peripherals are reconfigured.

2. The same input channel may appear multiple times in a group.
Group delay support:

* no delay between HW trigger event and conversions start:
delayType = ADC_DELAY_TYPE_NO_DELAY and delayArray = NULL

» group delay between HW trigger event and the start of the first conversion in the group - the rest of conversions
start right after the previous one
delayType = ADC_DELAY_TYPE_GROUP_DELAY and delayArray set to point to a single uint16_t variable
storing the delay value, expressed in PDB ticks (affected by PDB prescaler configurable via config extension)

« individual delays between HW trigger event and the start of each conversion in the group delay Type = ADC+
_DELAY_TYPE_INDIVIDUAL_DELAY and delayArray set to point to an uin16_t array with length equal with
the number of conversions in the group
Delays are expressed in PDB ticks (affected by PDB prescaler configurable via config extension). Delay
values are measured relative to the trigger event. When a delay expires, a PDB pretrigger is issued.

Note: the pretriggers must not occur while another conversion in the group is running, otherwise the ADC
freezes. It is the user's responsibility to make sure they do not overlap, i.e. delayN_plus_1 > (delayN +
conversion_duration).

MPC5746C and MPC5748G device families

On these platforms, each instance of ADC PAL uses:

« one instance of BCTU - used only for HW triggered groups

« all ADC instances connected to the selected BCTU instance. Please note that the ADC instances may have
different resolutions

These platforms are supported by the ADC PAL of type ADC_PAL_MPC574xC_G_R.

Group delay support:
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« groups do not support delays, so in adc_group_config_t structures delay Type must be set to ADC_DELAY «
_TYPE_NO_DELAY and delayArray to NULL, in adc_group_config_t.

Important details:

1. The PAL supports any number of SW triggered conversion groups at PAL initialization time. SW triggered
groups will be configured directly in ADC, each time ADC_StartGroupConversion() is called.

2. The maximum supported number of HW triggered conversion groups is expressed in two steps:

« for groups which include a minimum of 2 conversions: the total number of conversions within all these
groups shall be less than or equal with the number of BCTU LIST HW registers. (E.g. 1 group of 8
conversions & 1 group of 24 conversions: 8 + 24 <= 32)

« for groups which include a single conversion: the total number of such groups shall be less than or
equal with the total number of BCTU Triggers minus the number of configured groups with at least 2
conversions

3. Aninput channel may only appear once in the group, otherwise the last conversion result will appear for each
occurrence of the channel index in the group. This is a platform limitation: BCTU has only a single result
register per ADC instance, and the ADC has a single result register per channel.

4. A conversion group (SW and HW triggered) can target only conversions on a single ADC instance.
5. The same trigger source cannot be assigned to multiple HW triggered groups.

6. Multiple HW triggered groups may be enabled simultaneously.
However, the user must make sure that the actual HW trigger events do not occur simultaneously and that
conversions from multiple groups do not overlap in time. Otherwise hardware errors may occur and results
may be overwritten.

MPC574xP and S32Rx7x device families

On these platforms, each instance of ADC PAL uses:

 one instance of CTU - used only for HW triggered groups and statically configured to CTU triggered mode

« all ADC instances connected to the selected CTU instance
These platforms are supported by the ADC PAL of type ADC_PAL_SAR_CTU.
Group delay support:

* no delay between HW trigger event and conversions start:
delayType = ADC_DELAY_TYPE_NO_DELAY and delayArray = NULL

+ group delay between HW trigger event and the start of the first conversion in the group - the rest of conversions
start right after the previous one
delayType = ADC_DELAY_TYPE_GROUP_DELAY and delayArray set to point to a single uint16_t variable
storing the delay value, expressed in CTU ticks (affected by CTU prescaler)

Important details:

1. The PAL supports any number of SW triggered conversion groups at PAL initialization time. SW triggered
groups will be configured directly in ADC, each time ADC_StartGroupConversion() is called.

2. The maximum supported number of HW triggered conversion groups is equal with the number of CTU result
FIFOs - defined in platform header file as CTU_FR_COUNT. The total number of conversions in all HW
triggered groups must be <= the length of the CTU ADC command list - defined in platform header file as
CTU_CHANNEL_COUNT.
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3. A conversion group (SW and HW triggered) can target only conversions on a single ADC instance.

4. An input channel may only appear once in a SW triggered group, otherwise the last conversion result will
appear for each occurrence of the channel index in the group. This is a platform limitation: the ADC has a
single result register per channel. For HW triggered groups this restriction doesn't apply.

5. All HW triggered groups can be enabled simultaneously.
However, the user must make sure that the actual HW trigger events do not occur simultaneously and that
conversions from multiple groups do not overlap in time. Otherwise hardware errors may occur and results
may be overwritten.

6. Each HW triggered group has assigned a CTU result FIFO. The number of channels in each group must be
less than the CTU result FIFO length - note that not all FIFOs have the same length. FIFOs are assigned in
the same order in which the HW triggered groups are configured in the PAL init state: FIFO#0 assigned to
first group, FIFO#1 to second, etc.

7. The trigger sources enabled for a group can implicitly start also the rest of the enabled HW triggered groups.
E.g. SourceX configured for group0, sourceY configured for group1. If both groups are enabled, when event
from sourceX occurs, both group0 and group1 will execute; the same when event from sourceY occurs.

Integration guideline

Compilation units
The following files need to be compiled in the project:

${S32SDK_PATH}\platform\pall\src\adc\adc_pal.c
${S32SDK_PATH}\platform\pallsrc\adc\adc_irqg.c

Additionally, it is required to compile also the .c files from the dependencies listed for each ADC PAL type (please
see Dependencies subsection below).

Include path
The following paths need to be added to the include path of the toolchain:

${S32SDK_PATH}\platform\pallinc\
${S32SDK_PATH}\platform\drivers\inc\

An additional file, named adc_pal_cfg.h, must be created by the user and added to one of the include paths. The
user has to add to the file the definitions of preprocessor symbols according to the ADC PAL type used. These
symbols are specified in the next subsection.

When using the S32 SDK configuration tool, the file is generated by the configurator.

The pal type ADC_PAL_S32K1xx also requires:

${S32SDK_PATH}\platform\drivers\src\adc\

Compile symbols
1. Define for selecting one of the ADC PAL type to be used:
ADC_PAL_S32K1lxx
ADC_PAL_MPC574xC_G_R
ADC_PAL_SAR_CTU

2. Define the maximum number of HW triggered groups which may be enabled simultaneously. For ADC_PA«
L_S32K1xx the maximum value of the define is 1.

ADC_PAL_MAX_NUM_HW_GROUPS_EN

3. For ADC_PAL_MPC574xC_G_R and ADC_PAL_SAR_CTU types, define the total number of configured
groups.

ADC_PAL_TOTAL_NUM_GROUPS

Generated on Fri Jun 11 2021 08:14:09 for S32SDK User Manual by Doxygen



158 CONTENTS

Dependencies

Interrupt Manager (Interrupt)
OS Interface (OSIF)

» The pal type ADC_PAL_S32K1xx also depends on:
ADC Driver
PDB Driver
TRGMUX Driver

» The pal type ADC_PAL_MPC574xC_G_R also depends on:
adc_c55_driver
bctu_driver

» The pal type ADC_PAL_SAR_CTU also depends on:
adc_c55_driver
ctu_driver

Data Structures

+ struct adc_group_config_t

Defines the configuration structure for an ADC PAL conversion group. More...
« struct adc_config_t

Defines the configuration structure for ADC PAL. More...
« struct extension_adc_s32k1xx_t

Defines the extension structure for ADC S32K1xx. More...

Typedefs

+ typedef adc_inputchannel_t adc_input_chan_t

Defines the enumeration with ADC PAL input channels.
« typedef trgmux_trigger_source_t adc_trigger_source_t

Defines the enumeration with ADC PAL hardware trigger sources.

Enumerations

« enum adc_delay_type_t { ADC_DELAY_TYPE_NO_DELAY = Ou, ADC_DELAY_TYPE_GROUP_DELAY =
1u, ADC_DELAY_TYPE_INDIVIDUAL_DELAY =2u}

Defines an enumeration which contains the types of delay configurations for ADC conversions within a group.

Functions

« status_t ADC_Init (const adc_instance_t xconst instance, const adc_config_t xconst config)
Initializes the ADC PAL instance.
« status_t ADC_Deinit (const adc_instance_t *const instance)

Deinitializes the ADC PAL instance.
« status_t ADC_EnableHardwareTrigger (const adc_instance_t xconst instance, const uint32_t groupldx)

Generated on Fri Jun 11 2021 08:14:09 for S32SDK User Manual by Doxygen



16.2 Analog to Digital Converter - Peripheral Abstraction Layer (ADC PAL) 159

Enables the selected HW trigger for a conversion group, if the conversion group has support for HW trigger.

« status_t ADC_DisableHardwareTrigger (const adc_instance_t xconst instance, const uint32_t groupldx, const
uint32_t timeout)

Disables the selected HW trigger for a conversion group, if the conversion group is HW triggered.
« status_t ADC_StartGroupConversion (const adc_instance_t *const instance, const uint32_t groupldx)

Starts the execution of a selected SW triggered ADC conversion group.

« status_t ADC_StopGroupConversion (const adc_instance_t xconst instance, const uint32_t groupldx, const
uint32_t timeout)

Stops the selected SW triggered ADC conversion group execution.

« status_t ADC_EnableNotification (const adc_instance_t xconst instance, const uint32_t groupldx)
Enables the notification callback for a configured group.

« status_t ADC_DisableNotification (const adc_instance_t xconst instance, const uint32_t groupldx)

Disables the notification callback for a configured group.

16.2.2 Data Structure Documentation

16.2.2.1 struct adc_group_config_t

Defines the configuration structure for an ADC PAL conversion group.
Implements : adc_group_config_t_Class

Definition at line 129 of file adc_pal.h.
Data Fields

+ const adc_input_chan_t * inputChannelArray
- uint16_t * resultBuffer

 uint8_t numChannels

* uint8_t numSetsResultBuffer

* bool hwTriggerSupport
 adc_trigger_source_t triggerSource
» adc_delay_type_t delayType

* uint16_t * delayArray

* bool continuousConvEn

» adc_callback t callback

+ void * callbackUserData

Field Documentation
16.2.2.1.1 adc_callback_t callback

Callback function associated with group conversion complete

Definition at line 145 of file adc_pal.h.
16.2.2.1.2 void: callbackUserData

Pointer to additional user data to be passed by the callback

Definition at line 146 of file adc_pal.h.
16.2.2.1.3 bool continuousConvEn

Flag for enabling continuous conversions of a group - used only for SW triggered groups i.e. hwTrigger«
Support==false.

Definition at line 143 of file adc_pal.h.
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16.2.2.1.4 uint16_tx delayArray

Pointer to array of delay values introduced from the occurrence of a HW trigger event until each ADC conversion in
the group can start execution. Expressed in clock ticks. Note: the delay might be bigger if there is an overlap with
another conversion already executing.

Definition at line 141 of file adc_pal.h.
16.2.2.1.5 adc_delay_type_t delayType

Type of delay configuration. Supported values are platform dependent.

Definition at line 140 of file adc_pal.h.
16.2.2.1.6 bool hwTriggerSupport

Conversion group is HW triggered (true) or SW triggered (false).

Definition at line 137 of file adc_pal.h.
16.2.2.1.7 const adc_input_chan_tx inputChannelArray

Pointer to the array of ADC input channels. Each entry in this array corresponds to an individual conversion in the
group. Only on some of the platforms the same input channel may appear multiple times - see device family specific
details in the ADC PAL documentation.

Definition at line 131 of file adc_pal.h.
16.2.2.1.8 uint8_t numChannels

Number of input channels in the array

Definition at line 134 of file adc_pal.h.
16.2.2.1.9 uint8_t numSetsResultBuffer

Number of sets of results which can be stored in result buffer: length of the result buffer = numChannels x num«
SetsResultBuffer

Definition at line 135 of file adc_pal.h.
16.2.2.1.10 uint16_tx resultBuffer

Pointer to the array for conversion results

Definition at line 133 of file adc_pal.h.
16.2.2.1.11 adc_trigger_source_t triggerSource

HW trigger source associated with the conversion group. Will be ignored if (hwTriggerSupport == false). Note for
ADC_SAR_CTU: this enables the HW trigger source for all other groups; the actual order of execution of groups
depends on the order of occurrence of triggers.

Definition at line 138 of file adc_pal.h.
16.2.2.2 struct adc_config_t

Defines the configuration structure for ADC PAL.
Implements : adc_config_t_Class

Definition at line 155 of file adc_pal.h.

Data Fields

» const adc_group_config_t * groupConfigArray
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* uint16_t numGroups
* uint8_t sampleTicks
« void * extension

Field Documentation
16.2.2.2.1 voidx extension

This field is used to add extra IP specific settings to the basic configuration.

Definition at line 161 of file adc_pal.h.
16.2.2.2.2 const adc_group_config_tx groupConfigArray

Array of group configurations

Definition at line 157 of file adc_pal.h.
16.2.2.2.3 uint16_t numGroups

Number of elements in groupConfigArray

Definition at line 158 of file adc_pal.h.
16.2.2.2.4 uint8_t sampleTicks

Duration of sample time expressed in ADC clock ticks

Definition at line 160 of file adc_pal.h.
16.2.2.3 struct extension_adc_s32k1xx_t

Defines the extension structure for ADC S32K1xx.
Implements : extension_adc_s32k1xx_t_Class
Definition at line 171 of file adc_pal.h.

Data Fields

» adc_clk_divide_t clockDivide

» adc_resolution_t resolution
 adc_input_clock_t inputClock

» adc_voltage_reference_t voltageRef

* bool supplyMonitoringEnable

» pdb_clk_prescaler_div_t pdbPrescaler

Field Documentation
16.2.2.3.1 adc_clk_divide_t clockDivide

Divider of the input clock for the ADC

Definition at line 173 of file adc_pal.h.
16.2.2.3.2 adc_input_clock_t inputClock

Input clock source

Definition at line 175 of file adc_pal.h.
16.2.2.3.3 pdb_clk_prescaler_div_t pdbPrescaler

PDB clock prescaler. Delays are measured based on PDB clock divided by prescaler. Only relevant if delays are
used.
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Definition at line 178 of file adc_pal.h.
16.2.2.3.4 adc_resolution_t resolution

ADC resolution (8,10,12 bit)

Definition at line 174 of file adc_pal.h.
16.2.2.3.5 bool supplyMonitoringEnable

Enable internal supply monitoring

Definition at line 177 of file adc_pal.h.
16.2.2.3.6 adc_voltage_reference_t voltageRef

Voltage reference used

Definition at line 176 of file adc_pal.h.

16.2.3 Typedef Documentation

16.2.3.1 typedef adc_inputchannel_t adc_input_chan_t

Defines the enumeration with ADC PAL input channels.
Implements : adc_input_chan_t_Class

Definition at line 54 of file adc_pal.h.
16.2.3.2 typedef trgmux_trigger_source_t adc_trigger_source_t

Defines the enumeration with ADC PAL hardware trigger sources.
Implements : adc_trigger_source_t_Class

Definition at line 61 of file adc_pal.h.

16.2.4 Enumeration Type Documentation

16.2.4.1 enum adc_delay_type_t

Defines an enumeration which contains the types of delay configurations for ADC conversions within a group.

Implements : adc_delay_type_t_Class

Enumerator

ADC DELAY TYPE_NO_DELAY First conversion can start right after the trigger occurrence, and the rest of
conversions execute one after another

ADC_DELAY_TYPE_GROUP_DELAY Delay only first conversion, and the rest execute one after another

ADC _DELAY TYPE_INDIVIDUAL_DELAY Individual delay for each conversion in the group (each measured
from the occurrence of the trigger)

Definition at line 117 of file adc_pal.h.

16.2.5 Function Documentation

16.2.5.1 status_t ADC_Deinit ( const adc_instance_t «const instance )

Deinitializes the ADC PAL instance.
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This function resets the ADC PAL instance, including the other platform specific HW units used together with ADC,
if there are no active conversions.
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Parameters
in instance | Pointer to ADC PAL instance number structure
Returns
status:
- STATUS_BUSY: there is already a HW triggered group enabled or executing, or a SW triggered group
executing

- STATUS_BUSY: on MPC574x platforms, if the BCTU module could not be reset
- STATUS_SUCCESS: ADC PAL initialized successfully

Definition at line 338 of file adc_pal.c.

16.2.5.2 status_t ADC_DisableHardwareTrigger ( const adc_instance_t xconst instance, const uint32_t groupldx, const
uint32_t timeout )

Disables the selected HW trigger for a conversion group, if the conversion group is HW triggered.

This function disables the HW trigger for a configured conversion group and also may stop its execution (depending
on platform), if called when a conversion group is executing. If stopping is supported, the execution shall be stopped
according to device specific procedures. The function shall wait for the procedures to complete within the given
timeout interval and return error code if they do not succeed. : the function prevents new conversions from the
group from starting, then waits until the current active conversion finishes execution (if the function call occurred
while an ADC conversion from the group is executing) or timeout occurs. : the execution of a HW triggered group of
conversions cannot be stopped, so the function shall wait until it is complete or timeout occurs. : the function always
returns STATUS_SUCCESS (even if a conversion is still executing) and doesn't use 'timeout' parameter. If it is
called during a control cycle, between MRS and actual group conversion start, there will be an additional execution
of the group, without callback.

Parameters
in instance | Pointer to ADC PAL instance number structure
in groupldx | Index of the selected group configured via groupConfigArray in adc_config_t
in timeout | Timeout interval in milliseconds
Returns
status:

- STATUS_TIMEOUT: the operation did not complete successfully within the provided timeout interval
- STATUS_SUCCESS: the operation completed successfully within the provided timeout interval

Definition at line 529 of file adc_pal.c.
16.2.5.3 status_t ADC_DisableNotification ( const adc_instance_t xconst instance, const uint32_t groupldx )

Disables the notification callback for a configured group.

This function disables the notification callback for a selected group of ADC conversions.

Parameters
in instance | Pointer to ADC PAL instance number structure
in groupldx | Index of the selected group configured via groupConfigArray in adc_config_t
Returns
status:
- STATUS_ERROR: the selected group is not active (SW triggered running or HW triggered running or en-
abled)

- STATUS_SUCCESS: the notification has been disabled successfully

Definition at line 870 of file adc_pal.c.
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16.2.5.4 status_t ADC_EnableHardwareTrigger ( const adc_instance_t xconst instance, const uint32_t groupldx )

Enables the selected HW trigger for a conversion group, if the conversion group has support for HW trigger.

Enables the selected HW trigger for a conversion group, if the conversion group has support for HW trigger. The
function will return an error code if there is a conversion group already active. If the function succeeds, the conver-
sion group will be triggered for execution when the selected HW trigger occurs.

Parameters
in instance | Pointer to ADC PAL instance number structure
in groupldx | Index of the selected group configured via groupConfigArray in adc_config_t
Returns
status:
- STATUS_BUSY: there is already a HW triggered group enabled or executing, or a SW triggered group
executing

- STATUS_SUCCESS: HW trigger enabled successfully for the selected conversion group

Definition at line 437 of file adc_pal.c.
16.2.5.5 status_t ADC_EnableNotification ( const adc_instance_t xconst instance, const uint32_t groupldx )

Enables the notification callback for a configured group.

This function enables the notification callback for a selected group of ADC conversions.

Parameters
in instance | Pointer to ADC PAL instance number structure
in groupldx | Index of the selected group configured via groupConfigArray in adc_config_t
Returns
status:
- STATUS_ERROR: the selected group is not active (SW triggered running or HW triggered running or en-
abled)

- STATUS_SUCCESS.: the notification has been enabled successfully

Definition at line 820 of file adc_pal.c.
16.2.5.6 status_t ADC_Init ( const adc_instance_t xconst instance, const adc_config_t x«const config )

Initializes the ADC PAL instance.

This function initializes the ADC PAL instance, including the other platform specific HW units used together with
ADC. Noatifications are default enabled after init.

Parameters
in instance | Pointer to ADC PAL instance number structure
in config | The ADC PAL configuration structure

Returns
status:

- STATUS_ERROR: platform specific error encountered while initializing one of the HW modules used by
ADC PAL. On MPC574x returned if ADC calibration did not succeed for all the selected ADCs. On S32K1xx
returned if it cannot reconfigure successfully the TRGMUX trigger source of the used PDB instance.

- STATUS_BUSY: on MPC574x platforms, if the BCTU module could not be reset

- STATUS_SUCCESS: ADC PAL initialized successfully

Definition at line 255 of file adc_pal.c.
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16.2.5.7 status_t ADC_StartGroupConversion ( const adc_instance_t «const instance, const uint32_t groupldx )

Starts the execution of a selected SW triggered ADC conversion group.

This function starts execution of a selected ADC conversion group, if there is no other conversion group active.
Conversion groups started by ADC_StartGroupConversion shall not be preempted by HW triggered conversion
groups.

Parameters
in instance | Pointer to ADC PAL instance number structure
in groupldx | Index of the selected group configured via groupConfigArray in adc_config_t
Returns
status:
- STATUS_BUSY: there is already a HW triggered group enabled or executing, or a SW triggered group
executing

- STATUS_SUCCESS: group conversion successfully triggered

Definition at line 640 of file adc_pal.c.

16.2.5.8 status_t ADC_StopGroupConversion ( const adc_instance_t xconst instance, const uint32_t groupldx, const
uint32_t timeout )

Stops the selected SW triggered ADC conversion group execution.

This function stops the execution of a SW triggered conversion group. The execution shall be stopped according to
device specific procedures. The function shall wait for the procedures to complete within the given timeout interval
and return error code if they do not succeed. For ADC_SAR_CTU type and MPC574xC_G_R a conversion already
started for execution cannot be stopped, so the function shall wait until it finishes or timeout occurs.

Parameters
in instance | Pointer to ADC PAL instance number structure
in groupldx | Index of the selected group configured via groupConfigArray in adc_config_t
in timeout | Timeout interval in milliseconds
Returns
status:

- STATUS_TIMEOUT: the operation did not complete successfully within the provided timeout interval
- STATUS_SUCCESS: the operation completed successfully within the provided timeout interval

Definition at line 720 of file adc_pal.c.
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16.3

Automotive Math and Motor Control Library

Automotive Math and Motor Control Library integration with S32 SDK

General Information

The Automotive Math and Motor Control Library Set is a precompiled off-the-shelf software library containing the
building blocks for a wide range of motor control and general mathematical applications. The Automotive Math
and Motor Control Library Set is delivered as a precompiled or source code library, and a provides production-
ready, highly speed-optimized, intensively tested and easy to use solution for the rapid development of user motor
control and general mathematical applications. An integral part of the Automotive Math and Motor Control Library
Set are the Matlab/Simulink® models of all supported functions to allow modelling of the user application using
the Matlab/Simulink® environment, and extensive user documentation. The Automotive Math and Motor Control
Library Set support three major arithmetic: 32-bit fixed-point, 16-bit fixed-point and single precision floating-point.
For more information, application notes and demos please visit AMMCLib page from NXP website. AMMCLIB
package contains the following:

bam : contains Bit Accurate Models of all the functions for Matlab/Simulink
doc : contains the User Manual

include : contains all the header files, including the master header files of each library to be included in the
user application

lib : contains the compiled library file to be included in the user application

Note
For an overview of what is included in the Automotive Math and Motor Control Library and it's capabilities you
can check the document found in <SDK_Location>/doc/AMMCLIB_OnePager_ S32SDK.pdf
This is just a brief description of the Automotive Math and Motor Control Library, for more information please
check the full library documentation found in <SDK_TLocation>/1lib/<CPU_Family>/AMMCLI«
B/doc/S32K14XMCLUG. pdf
The library is provided in binary format, compiled using GCC, GHS, IAR and for evaluation purposes
only. Please consult license.txt file for more information found in <SDK_TLocation>/1ib/<CPU_+«
Family>/AMMCLIB/license.txt

How to use

To add AMMCLib in your application you need to follow four steps:

1) Add AMMCLIib S32CT component into your project. The component will automatically add the required
include paths.

2) Add ":S32K14x_AMMCLIB.2" in Libraries (-) and add "${workspace_loc:/${ProjName}/SDK/lib/AMMCL
IB/lib/<compiler>}" in Library search path (-L)

3) Select the implementations from the AMMCLib component(Fixed 16, Fixed 32 or Float). If you are using
the float implementation you need to enable FPU in the toolchain settings.

4) Use the library API to execute the required tests.

You can use the AMMCLIib examples as a practical implementation of the steps described above.

Note

IAR compiler:

The compiler is not able to distinguish the sequence of read and write operations inside an inline assembly
block in GFLIB_VMin.h and it make the Warning[Pe549] messages. In that case, C option "--diag_suppress
Pe549" should be added to suppress those warnings or "--warnings_are_errors" should be removed to not
treat those warnings as errors.
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16.4 Backward Compatibility Symbols for S32K144

This module covers backward compatibility symbols.
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16.5 CRC Driver
16.5.1 Detailed Description

Cyclic Redundancy Check Peripheral Driver.

This section describes the programming interface of the CRC driver.

Data Structures

« struct crc_user_config_t
CRC configuration structure. Implements : crc_user_config_t_Class. More...

Enumerations

» enum crc_transpose_t { CRC_TRANSPOSE_NONE = 0x00U, CRC_TRANSPOSE_BITS = 0x01U, CRC_«
TRANSPOSE_BITS_AND_BYTES = 0x02U, CRC_TRANSPOSE_BYTES = 0x03U }

CRC type of transpose of read write data Implements : crc_transpose_t Class.

CRC DRIVER API

« status_t CRC_DRV_lInit (uint32_t instance, const crc_user_config_t xuserConfigPtr)

Initializes the CRC module.
« status_t CRC_DRV_Deinit (uint32_t instance)

Sets the default configuration.
+ uint32_t CRC_DRV_GetCrc32 (uint32_t instance, uint32_t data, bool newSeed, uint32_t seed)

Appends 32-bit data to the current CRC calculation and returns new result.
» uint32_t CRC_DRV_GetCrc16 (uint32_t instance, uint16_t data, bool newSeed, uint32_t seed)

Appends 16-bit data to the current CRC calculation and returns new result.
» uint32_t CRC_DRV_GetCrc8 (uint32_t instance, uint8_t data, bool newSeed, uint32_t seed)

Appends 8-bit data to the current CRC calculation and returns new result.
 void CRC_DRV_WriteData (uint32_t instance, const uint8_t xdata, uint32_t dataSize)

Appends a block of bytes to the current CRC calculation.
+ uint32_t CRC_DRV_GetCrcResult (uint32_t instance)

Returns the current result of the CRC calculation.
« status_t CRC_DRV_Configure (uint32_t instance, const crc_user_config_t *«userConfigPtr)

Configures the CRC module from a user configuration structure.
« status_t CRC_DRV_GetConfig (uint32_t instance, crc_user_config_t xconst userConfigPtr)

Get configures of the CRC module currently.
« status_t CRC_DRV_GetDefaultConfig (crc_user_config_t sconst userConfigPtr)

Get default configures the CRC module for configuration structure.

16.5.2 Data Structure Documentation

16.5.2.1 struct crc_user_config_t

CRC configuration structure. Implements : crc_user_config_t_Class.

Definition at line 83 of file crc_driver.h.

Data Fields

* crc_transpose_t writeTranspose
* bool complementChecksum
» uint32_t seed
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Field Documentation
16.5.2.1.1 bool complementChecksum

True if the result shall be complement of the actual checksum.

Definition at line 95 of file crc_driver.h.
16.5.2.1.2 uint32_t seed

Starting checksum value.

Definition at line 96 of file crc_driver.h.
16.5.2.1.3 crc_transpose_t writeTranspose

Type of transpose when writing CRC input data.

Definition at line 94 of file crc_driver.h.

16.5.3 Enumeration Type Documentation

16.5.3.1 enum crc_transpose_t

CRC type of transpose of read write data Implements : crc_transpose_t_Class.

Enumerator

CRC_TRANSPOSE_NONE No transpose

CRC_TRANSPOSE_BITS Transpose bits in bytes
CRC_TRANSPOSE_BITS AND_BYTES Transpose bytes and bits in bytes
CRC_TRANSPOSE_BYTES Transpose bytes

Definition at line 44 of file crc_driver.h.

16.5.4 Function Documentation

16.5.4.1 status_t CRC_DRV_Configure ( uint32_t instance, const crc_user_config_t x« userConfigPtr )

Configures the CRC module from a user configuration structure.

This function configures the CRC module from a user configuration structure

Parameters

in instance | The CRC instance number

in userConfigPtr | Pointer to structure of initialization
Returns

Execution status (success)

Definition at line 236 of file crc_driver.c.
16.5.4.2 status_t CRC_DRV_Deinit ( uint32_t instance )

Sets the default configuration.

This function sets the default configuration
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Parameters

in instance | The CRC instance number

Returns
Execution status (success)
Definition at line 88 of file crc_driver.c.
16.5.4.3 status_t CRC_DRV_GetConfig ( uint32_t instance, crc_user_config_t xconst userConfigPtr )

Get configures of the CRC module currently.

This function Get configures of the CRC module currently

Parameters

in instance | The CRC instance number

out userConfigPtr | Pointer to structure of initialization
Returns

Execution status (success)

Definition at line 268 of file crc_driver.c.
16.5.4.4 uint32_t CRC_DRV_GetCrc16 ( uint32_t instance, uint16_t data, bool newSeed, uint32_t seed )

Appends 16-bit data to the current CRC calculation and returns new result.

This function appends 16-bit data to the current CRC calculation and returns new result. If the newSeed is true,
seed set and result are calculated from the seed new value (new CRC calculation)

Parameters
in instance | The CRC instance number
in data | Input data for CRC calculation
in newSeed | Sets new CRC calculation
« true: New seed set and used for new calculation.
- false: Seed argument ignored, continues old calculation.
in seed | New seed if newSeed is true, else ignored
Returns

New CRC result

Definition at line 139 of file crc_driver.c.
16.5.4.5 uint32_t CRC_DRV_GetCrc32 ( uint32_t instance, uint32_t data, bool newSeed, uint32_t seed )

Appends 32-bit data to the current CRC calculation and returns new result.

This function appends 32-bit data to the current CRC calculation and returns new result. If the newSeed is true,
seed set and result are calculated from the seed new value (new CRC calculation)
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Parameters
in instance | The CRC instance number
in data | Input data for CRC calculation
in newSeed | Sets new CRC calculation
» true: New seed set and used for new calculation.
« false: Seed argument ignored, continues old calculation.
in seed | New seed if newSeed is true, else ignored
Returns

New CRC result

Definition at line 108 of file crc_driver.c.

16.5.4.6 uint32_t CRC_DRV_GetCrc8 ( uint32_t instance, uint8_t data, bool newSeed, uint32_t seed )

Appends 8-bit data to the current CRC calculation and returns new result.

This function appends 8-bit data to the current CRC calculation and returns new result. If the newSeed is true, seed
set and result are calculated from the seed new value (new CRC calculation)

Parameters
in instance | The CRC instance number
in data | Input data for CRC calculation
in newSeed | Sets new CRC calculation
+ true: New seed set and used for new calculation.
« false: Seed argument ignored, continues old calculation.
in seed | New seed if newSeed is true, else ignored
Returns

New CRC result

Definition at line 169 of file crc_driver.c.

16.5.4.7 uint32_t CRC_DRV_GetCrcResult ( uint32_t instance )

Returns the current result of the CRC calculation.

This function returns the current result of the CRC calculation

Parameters

in instance | The CRC instance number

Returns

Result of CRC calculation

Definition at line 220 of file crc_driver.c.

16.5.4.8 status_t CRC_DRV_GetDefaultConfig ( crc_user_config_t xconst userConfigPir )

Get default configures the CRC module for configuration structure.

This function Get default configures the CRC module for user configuration structure
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Parameters

out userConfigPtr | Pointer to structure of initialization

Returns
Execution status (success)
Definition at line 300 of file crc_driver.c.
16.5.4.9 status_t CRC_DRV_Init ( uint32_t instance, const crc_user_config_t x userConfigPtr )

Initializes the CRC module.

This function initializes CRC driver based on user configuration input. The user must make sure that the clock is
enabled

Parameters

in instance | The CRC instance number

in userConfigPtr | Pointer to structure of initialization
Returns

Execution status (success)

Definition at line 65 of file crc_driver.c.
16.5.4.10 void CRC_DRV_WriteData ( uint32_t instance, const uint8_t x data, uint32_t dataSize )

Appends a block of bytes to the current CRC calculation.

This function appends a block of bytes to the current CRC calculation

Parameters
in instance | The CRC instance number
in data | Data for current CRC calculation
in dataSize | Length of data to be calculated

Definition at line 197 of file crc_driver.c.
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16.6 CSEc Driver
16.6.1 Detailed Description

Cryptographic Services Engine Peripheral Driver.
How to use the CSEc driver in your application

To access the command feature set, the part must be configured for EEE operation, using the PGMPART command.
This can be implemented by using the Flash driver. By enabling security features and configuring a number of user
keys, the total size of the 4 KByte EEERAM will be reduced by the space required to store the user keys. The user
key space will then effectively be unaddressable space in the EEERAM.

At the bottom of this page is an example of making this configuration using the Flash driver. For more details related
to the FLASH_DRV_DEFlashPartition function, please refer to the Flash driver documentation. Please note that
this configuration is required only once and should not be lanched from Flash memory.

In order to use the CSEc driver in your application, the CSEC_DRV_Init function should be called prior to using
the rest of the API. The parameter of this function is used for holding the internal state of the driver throughout the
lifetime of the application.

Key/seed/random number generation
This is the high level flow in which to initialize and generate random numbers.

1. Run CSEC_DRV_InitRNG to initialize a random seed from the internal TRNG

+ CSEC_DRV_InitRNG must be run after every POR, and before the first execution of CSEC_DRV_«
GenerateRND

* Note that if the next step (run CSEC_DRV_GenerateRND) is run without initializing the seed, CSEC«
_RNG_SEED will be returned.

2. Run CSEC_DRV_GenerateRND to generate a random numer The PRNG uses the PRNG_STATE/KEY and
Seed per SHE spec and the AlS20 standard.

3. For additional random numbers the user may continue executing CSEC_DRV_GenerateRND unless a POR
event occurred.

Memory update protocol

In order to update a key, the user must have knowledge of a valid authentication secret, i.e. another key (AuthlD). If
the key AuthID is empty, the key update will only work if AuthlD = ID (the key that will be updated will represent the
AuthlD from now on), otherwise CSEC_KEY_EMPTY is returned.

The M1-M3 values need to be computed according to the SHE Specification in order to update a key slot. The
CSEC_DRV_LoadKey function will require those values. After successfully updating the key slot, two verification
values will be returned: M4 and M5. The user can compute the two values and compare them with the ones returned
by the CSEC_DRV_LoadKey function in order to ensure the slot was updated as desired. Please refer to the CSEc
driver example for a reference implementation of the memory update protocol.

Integration guideline
Compilation units
The following files need to be compiled in the project:

${S32SDK_PATH}\platform\drivers\src\csec\csec_driver.c
${S32SDK_PATH}\platform\drivers\src\csec\csec_hw_access.c

Include path
The following paths need to be added to the include path of the toolchain:

${S32SDK_PATH}\platform\drivers\inc\
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Preprocessor symbols
No special symbols are required for this component
Important Note

While executing CSEC_DRV_GenerateMACAddrMode and CSEC_DRV_VerifyMACAddrMode functions, it is not
possible to execute code from the FLASH block targeted by the current operation. This includes interrupt handlers
for any interrupt that might occur during this time. It is the responsibility of the application to ensure that any
such code is placed in a different FLASH block or in RAM. Functions can be placed in RAM section by using the
START/END_FUNCTION_DEFINITION/DECLARATION_RAMSECTION macros.

Dependencies

Interrupt Manager (Interrupt) OS Interface (OSIF)
Examples:

Using the Flash driver to partition Flash for CSEc operation, the below code section applies for S32K14x:

flash_ssd_config_t flashSSDConfig;
FLASH_DRV_Init (&flashl_InitConfig0O, &flashSSDConfig);

/+ Configure the part for EEE operation, with 20 keys for CSEc */
FLASH_DRV_DEFlashPartition(&flashSSDConfig, 0x2, 0Ox4, 0x3, false, true);

The example partition code for S32K11x:

flash_ssd_config_t flashSSDConfig;
FLASH_DRV_Init (&flashl_InitConfig0O, &flashSSDConfig);

/* Configure the part for EEE operation, with 20 keys for CSEc */
FLASH_DRV_DEFlashPartition(&flashSSDConfig, 0x3, 0x3, 0x3, false, true);

Encryption using AES EBC mode

uint8_t plainText[1l6] = {0x00, O0x11l, 0x22, 0x33, 0x44, 0x55, 0x66, 0x77, 0x88,
0x99, OxAA, 0xBB, 0xCC, 0xDD, OxEE, OxFF};
uint8_t plainKey([1l6] = {0x00, 0x01, 0x02, 0x03, 0x04, 0x05, 0x06, 0x07, 0x08,

0x09, Ox0a, 0x0b, 0x0Oc, 0x0d, 0x0Oe, 0xO0f};

csec_error_code_t stat;
uint8_t cipherText[16];

csec_state_t csecState;
CSEC_DRV_Init (&csecState);

stat = CSEC_DRV_LoadPlainKey (plainKey);
(stat != CSEC_NO_ERROR)

{
/+ Loading the key failed, encryption will not have the expected result =/
return false;

}

stat = CSEC_DRV_EncryptECB(CSEC_RAM_KEY, plainText, 16U, cipherText, 1U);
(stat != CSEC_NO_ERROR)

{
/* Encryption was successful =/
return true;

Generating and verifying CMAC for a message

uint8_t plainKey[l6] = {0x2b, Ox7e, 0x15, 0x1l6, 0x28, Oxae, 0xd2, Oxa6, Oxab,
0xf7, 0x15, 0x88, 0x09, Oxcf, 0x4f, 0x3c};
uint8_t msg[l6] = {0x00, 0x01, 0x02, 0x03, 0x04, 0x05, 0x06, 0x07, 0x08,

0x09, Ox0a, 0x0b, 0x0c, 0x0d, 0x0Oe, 0xO0f};
uint8_t cmac[16];
bool verifStatus;
csec_error_code_t stat;
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csec_state_t csecState;
CSEC_DRV_TInit (&csecState);

stat = CSEC_DRV_LoadPlainKey (plainKey);
if (stat != CSEC_NO_ERROR)
return false;

stat = CSEC_DRV_GenerateMAC (CSEC_RAM_KEY, msg, 128U, cmac, 1U);
if (stat != CSEC_NO_ERROR)
return false;

stat = CSEC_DRV_VerifyMAC (CSEC_RAM_KEY, msg, 128U, cmac, 128U, &verifStatus,
10);

if (stat != CSEC_NO_ERROR)
return false;

(!verifStatus)

/* The given CMAC did not matched with the one computed internally */
return false;

Generating random bits

csec_error_code_t stat;
csec_status_t status;
uint8_t rnd[l6];

csec_state_t csecState;
CSEC_DRV_TInit (&csecState);

stat = CSEC_DRV_InitRNG () ;
(stat != CSEC_NO_ERROR)
return false;

/+ Check RNG is initialized =/

status = CSEC_DRV_GetStatus();

if (! (status & CSEC_STATUS_RND_INIT))
return false;

stat = CSEC_DRV_GenerateRND (rnd) ;

(stat != CSEC_NO_ERROR)
return false;

Data Structures

« struct csec_state t

Internal driver state information. More...

Macros

+ #define CSEC_STATUS_BUSY (0x1U)
The bit is set whenever SHE is processing a command.
« #define CSEC_STATUS_SECURE_BOOT (0x2U)
The bit is set if the secure booting is activated.
« #define CSEC_STATUS_BOOT_INIT (0x4U)
The bit is set if the secure booting has been personalized during the boot sequence.
« #define CSEC_STATUS_BOOT_FINISHED (0x8U)
The bit is set when the secure booting has been finished by calling either CMD_BOOT_FAILURE or CMD_BOOT+
_OKor if CMD_SECURE_BOOT failed in verifying BOOT_MAC.
+ #define CSEC_STATUS_BOOT_OK (0x10U)
The bit is set if the secure booting (CMD_SECURE_BOOT) succeeded. If CMD_BOOT_FAILURE is called the bit is
erased.
+ #define CSEC_STATUS_RND_INIT (0x20U)
The bit is set if the random number generator has been initialized.
« #define CSEC_STATUS_EXT_DEBUGGER (0x40U)
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The bit is set if an external debugger is connected to the chip.
« #define CSEC_STATUS_INT_DEBUGGER (0x80U)

The bit is set if the internal debugging mechanisms of SHE are activated.

Typedefs

« typedef uint8_t csec_status_t

Represents the status of the CSEc module. Provides one bit for each status code as per SHE specification. CSE«+
C_STATUS_x masks can be used for verifying the status.

Enumerations

* enum csec_key_id_t{
CSEC_SECRET_KEY = 0x0U, CSEC_MASTER_ECU, CSEC_BOOT_MAC_KEY, CSEC_BOOT_MAC,
CSEC_KEY_1, CSEC_KEY_2, CSEC_KEY_3, CSEC_KEY _4,
CSEC_KEY_5, CSEC_KEY_6, CSEC_KEY_7, CSEC_KEY_8,
CSEC_KEY_9, CSEC_KEY_10, CSEC_RAM_KEY = 0xFU, CSEC_KEY_11 = 0x14U,
CSEC_KEY_12, CSEC_KEY_13, CSEC_KEY_14, CSEC_KEY_15,
CSEC_KEY_16, CSEC_KEY_17}

Specify the KeyID to be used to implement the requested cryptographic operation.

* enum csec_cmd_t {
CSEC_CMD_ENC_ECB = 0x1U, CSEC_CMD_ENC_CBC, CSEC_CMD_DEC_ECB, CSEC_CMD_DEC_+
CBC,
CSEC_CMD_GENERATE_MAC, CSEC_CMD_VERIFY_MAC, CSEC_CMD_LOAD_KEY, CSEC_CMD_L+-
OAD_PLAIN_KEY,
CSEC_CMD_EXPORT_RAM_KEY, CSEC_CMD_INIT_RNG, CSEC_CMD_EXTEND_ SEED, CSEC_CM«
D_RND,
CSEC_CMD_RESERVED_1, CSEC_CMD_BOOT_FAILURE, CSEC_CMD_BOOT_OK, CSEC_CMD_GE+«
T_ID,
CSEC_CMD_BOOT_DEFINE, CSEC_CMD_DBG_CHAL, CSEC_CMD_DBG_AUTH, CSEC_CMD_RESE+-
RVED 2,
CSEC_CMD_RESERVED_3, CSEC_CMD_MP_COMPRESS }

CSEc commands which follow the same values as the SHE command definition.
» enum csec_call_sequence_t { CSEC_CALL_SEQ_FIRST, CSEC_CALL_SEQ_SUBSEQUENT }

Specifies if the information is the first or a following function call.
» enum csec_boot_flavor_t { CSEC_BOOT_STRICT, CSEC_BOOT_SERIAL, CSEC_BOOT_PARALLEL, C+
SEC_BOOT_NOT_DEFINED }

Specifies the boot type for the BOOT_DEFINE command.

Functions

» void CSEC_DRV_lInit (csec_state_t xstate)
Initializes the internal state of the driver and enables the FTFC interrupt.
+ void CSEC_DRV_Deinit (void)
Clears the internal state of the driver and disables the FTFC interrupt.
« status_t CSEC_DRV_EncryptECB (csec_key_id_t keyld, const uint8_t xplainText, uint32_t length, uint8_t
xCipherText, uint32_t timeout)
Performs the AES-128 encryption in ECB mode.
« status_t CSEC_DRV_DecryptECB (csec_key_id_t keyld, const uint8_t xcipherText, uint32_t length, uint8_t
xplainText, uint32_t timeout)
Performs the AES-128 decryption in ECB mode.

« status_t CSEC_DRV_EncryptCBC (csec_key_id_t keyld, const uint8_t xplainText, uint32_t length, const
uint8_t xiv, uint8_t xcipherText, uint32_t timeout)
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Performs the AES-128 encryption in CBC mode.
status_t CSEC_DRV_DecryptCBC (csec_key_id t keyld, const uint8_t xcipherText, uint32_t length, const
uint8_t xiv, uint8_t xplainText, uint32_t timeout)
Performs the AES-128 decryption in CBC mode.
status_t CSEC_DRV_GenerateMAC (csec_key_id_t keyld, const uint8_t xmsg, uint32_t msglLen, uint8_«
t xcmac, uint32_t timeout)
Calculates the MAC of a given message using CMAC with AES-128.
status_t CSEC_DRV_GenerateMACAddrMode (csec_key_id_t keyld, const uint8_t xmsg, uint32_t msgLen,
uint8_t xcmac)
Calculates the MAC of a given message (located in Flash) using CMAC with AES-128.
status_t CSEC_DRV_VerifyMAC (csec_key_id_t keyld, const uint8_t xmsg, uint32_t msglLen, const uint8_t
xmac, uint16_t macLen, bool xverifStatus, uint32_t timeout)
Verifies the MAC of a given message using CMAC with AES-128.
status_t CSEC_DRV_VerifyMACAddrMode (csec_key_id_t keyld, const uint8_t xmsg, uint32_t msgLen, con-
st uint8_t «xmac, uint16_t macLen, bool xverifStatus)
Verifies the MAC of a given message (located in Flash) using CMAC with AES-128.
status_t CSEC_DRV_LoadKey (csec_key id_t keyld, const uint8_t *m1, const uint8_t *m2, const uint8_t
*m3, uint8_t xm4, uint8_t *xm5)
Updates an internal key per the SHE specification.
status_t CSEC_DRV_LoadPlainKey (const uint8_t *plainKey)
Updates the RAM key memory slot with a 128-bit plaintext.
status_t CSEC_DRV_ExportRAMKey (uint8_t *m1, uint8_t *m2, uint8_t *m3, uint8_t xm4, uint8_t xm>5)
Exports the RAM_KEY into a format protected by SECRET_KEY.
status_t CSEC_DRV_InitRNG (void)
Initializes the seed and derives a key for the PRNG.
status_t CSEC_DRV_ExtendSeed (const uint8_t xentropy)
Extends the seed of the PRNG.
status_t CSEC_DRV_GenerateRND (uint8_t xrnd)
Generates a vector of 128 random bits.
status_t CSEC_DRV_BootFailure (void)
Signals a failure detected during later stages of the boot process.
status_t CSEC_DRV_BootOK (void)
Marks a successful boot verification during later stages of the boot process.
status_t CSEC_DRV_BootDefine (uint32_t bootSize, csec_boot_flavor_t bootFlavor)
Implements an extension of the SHE standard to define both the user boot size and boot method.
static csec_status_t CSEC_DRV_GetStatus (void)
Returns the content of the status register.
status_t CSEC_DRV_GetID (const uint8_t xchallenge, uint8_t xuid, uint8_t xsreg, uint8_t xmac)
Returns the identity (UID) and the value of the status register protected by a MAC over a challenge and the data.
status_t CSEC_DRV_DbgChal (uint8_t xchallenge)
Obtains a random number which the user shall use along with the MASTER_ECU_KEY and UID to return an autho-
rization request.
status_t CSEC_DRV_DbgAuth (const uint8_t xauthorization)
Erases all keys (actual and outdated) stored in NVM Memory if the authorization is confirmed by CSEc.
status_t CSEC_DRV_MPCompress (const uint8_t *msg, uint16_t msgLen, uint8_t xmpCompress, uint32_t
timeout)
Compresses the given messages by accessing the Miyaguchi-Prenell compression feature with in the CSEc feature
set.
status_t CSEC_DRV_EncryptECBAsync (csec_key_id_t keyld, const uint8_t xplainText, uint32_t length,
uint8_t xcipherText)
Asynchronously performs the AES-128 encryption in ECB mode.
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« status_t CSEC_DRV_DecryptECBAsync (csec_key id_t keyld, const uint8_t *cipherText, uint32_t length,
uint8_t xplainText)
Asynchronously performs the AES-128 decryption in ECB mode.
« status_t CSEC_DRV_EncryptCBCAsync (csec_key_id_t keyld, const uint8_t *plainText, uint32_t length, con-
st uint8_t *iv, uint8_t xcipherText)
Asynchronously performs the AES-128 encryption in CBC mode.
« status_t CSEC_DRV_DecryptCBCAsync (csec_key_id_t keyld, const uint8_t *cipherText, uint32_t length,
const uint8_t xiv, uint8_t *plainText)
Asynchronously performs the AES-128 decryption in CBC mode.
« status_t CSEC_DRV_GenerateMACAsync (csec_key id_t keyld, const uint8_t xmsg, uint32_t msglLen,
uint8_t xcmac)
Asynchronously calculates the MAC of a given message using CMAC with AES-128.
« status_t CSEC_DRV_VerifyMACAsync (csec_key_id_t keyld, const uint8_t xmsg, uint32_t msglLen, const
uint8_t «mac, uint16_t maclLen, bool *verifStatus)
Asynchronously verifies the MAC of a given message using CMAC with AES-128.
+ status_t CSEC_DRV_GetAsyncCmdStatus (void)
Checks the status of the execution of an asynchronous command.
» void CSEC_DRV_InstallCallback (security_callback_t callbackFunc, void xcallbackParam)

Installs a callback function which will be invoked when an asynchronous command finishes its execution.
+ void CSEC_DRV_CancelCommand (void)

Cancels a previously launched asynchronous command.

16.6.2 Data Structure Documentation

16.6.2.1 struct csec_state_t

Internal driver state information.

Note

The contents of this structure are internal to the driver and should not be modified by users. Also, contents of
the structure are subject to change in future releases.

Implements : csec_state_t_Class

Definition at line 183 of file csec_driver.h.

Data Fields

» bool cmdInProgress

* csec_cmd_tcmd

+ const uint8_t * inputBuff

+ uint8_t x outputBuff

» uint32_t index

* uint32_t fullSize

* uint32_t partSize

» csec_key_id_t keyld

« status_t errCode

e const uint8_t x iv

» csec_call_sequence_t seq
* uint32_t msglLen

* bool * verifStatus

* bool macWritten

« const uint8_t x mac

* uint32_t maclLen

* security_callback_t callback
« void * callbackParam
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Field Documentation
16.6.2.1.1 security_callback_t callback

The callback invoked when an asynchronous command is completed

Definition at line 200 of file csec_driver.h.
16.6.2.1.2 void: callbackParam

User parameter for the command completion callback

Definition at line 201 of file csec_driver.h.
16.6.2.1.3 csec_cmd_tcmd

Specifies the type of the command in execution

Definition at line 185 of file csec_driver.h.
16.6.2.1.4 bool cmdinProgress

Specifies if a command is in progress

Definition at line 184 of file csec_driver.h.
16.6.2.1.5 status_t errCode

Specifies the error code of the last executed command

Definition at line 192 of file csec_driver.h.
16.6.2.1.6 uint32_t fullSize

Specifies the size of the input of the command in execution

Definition at line 189 of file csec_driver.h.
16.6.2.1.7 uint32_t index

Specifies the index in the input buffer of the command in execution

Definition at line 188 of file csec_driver.h.
16.6.2.1.8 const uint8_t inputBuff

Specifies the input of the command in execution

Definition at line 186 of file csec_driver.h.

16.6.2.1.9 const uint8_tx iv

Specifies the IV of the command in execution (for encryption/decryption using CBC mode)

Definition at line 193 of file csec_driver.h.
16.6.2.1.10 csec_key_id_t keyld

Specifies the key used for the command in execution

Definition at line 191 of file csec_driver.h.
16.6.2.1.11 const uint8_tx mac

Specifies the MAC to be verified for a MAC verification command

Definition at line 198 of file csec_driver.h.
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16.6.2.1.12 uint32_t macLen

Specifies the number of bits of the MAC to be verified for a MAC verification command

Definition at line 199 of file csec_driver.h.
16.6.2.1.13  bool macWritten

Specifies if the MAC to be verified was written in CSE_PRAM for a MAC verification command

Definition at line 197 of file csec_driver.h.
16.6.2.1.14 uint32_t msglLen

Specifies the message size (in bits) for the command in execution (for MAC generation/verification)

Definition at line 195 of file csec_driver.h.
16.6.2.1.15 uint8_t* outputBuff

Specifies the output of the command in execution

Definition at line 187 of file csec_driver.h.
16.6.2.1.16 uint32_t partSize

Specifies the size of the chunck of the input currently processed

Definition at line 190 of file csec_driver.h.
16.6.2.1.17 csec_call_sequence_t seq

Specifies if the information is the first or a following function call.

Definition at line 194 of file csec_driver.h.
16.6.2.1.18 boolx verifStatus

Specifies the result of the last executed MAC verification command

Definition at line 196 of file csec_driver.h.

16.6.3 Macro Definition Documentation

16.6.3.1 #define CSEC_STATUS_BOOT_FINISHED (0x8U)

The bit is set when the secure booting has been finished by calling either CMD_BOOT_FAILURE or CMD_BOO«
T_OK or if CMD_SECURE_BQOT failed in verifying BOOT_MAC.

Definition at line 70 of file csec_driver.h.
16.6.3.2 #define CSEC_STATUS_BOOT_INIT (0x4U)

The bit is set if the secure booting has been personalized during the boot sequence.

Definition at line 66 of file csec_driver.h.
16.6.3.3 #define CSEC_STATUS_BOOT_OK (0x10U)

The bit is set if the secure booting (CMD_SECURE_BOQOT) succeeded. If CMD_BOOT_FAILURE is called the bit
is erased.

Definition at line 73 of file csec_driver.h.
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16.6.3.4 #define CSEC_STATUS_BUSY (0x1U)

The bit is set whenever SHE is processing a command.

Definition at line 61 of file csec_driver.h.
16.6.3.5 #define CSEC_STATUS_EXT_DEBUGGER (0x40U)

The bit is set if an external debugger is connected to the chip.

Definition at line 77 of file csec_driver.h.

16.6.3.6 #define CSEC_STATUS_INT_DEBUGGER (0x80U)

The bit is set if the internal debugging mechanisms of SHE are activated.

Definition at line 80 of file csec_driver.h.
16.6.3.7 #define CSEC_STATUS_RND_INIT (0x20U)

The bit is set if the random number generator has been initialized.

Definition at line 75 of file csec_driver.h.
16.6.3.8 #define CSEC_STATUS_SECURE_BOOT (0x2U)

The bit is set if the secure booting is activated.

Definition at line 63 of file csec_driver.h.

16.6.4 Typedef Documentation

16.6.4.1 typedef uint8_t csec_status_t

Represents the status of the CSEc module. Provides one bit for each status code as per SHE specification. CSE«

C_STATUS_x masks can be used for verifying the status.
Implements : csec_status_t_Class

Definition at line 89 of file csec_driver.h.

16.6.5 Enumeration Type Documentation

16.6.5.1 enum csec_boot_flavor._t

Specifies the boot type for the BOOT_DEFINE command.

Implements : csec_boot_flavor_t_Class

Enumerator

CSEC_BOOT_STRICT
CSEC_BOOT_SERIAL
CSEC_BOOT_PARALLEL
CSEC_BOOT_NOT_DEFINED

Definition at line 167 of file csec_driver.h.
16.6.5.2 enum csec_call_sequence_t

Specifies if the information is the first or a following function call.

Implements : csec_call_sequence_t_Class
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Enumerator

CSEC_CALL_SEQ_FIRST
CSEC_CALL _SEQ SUBSEQUENT

Definition at line 157 of file csec_driver.h.
16.6.5.3 enum csec_cmd_t

CSEc commands which follow the same values as the SHE command definition.

Implements : csec_cmd_t_Class

Enumerator
CSEC_CMD_ENC_ECB
CSEC_CMD_ENC_CBC
CSEC_CMD_DEC_ECB
CSEC_CMD_DEC_cCBC
CSEC_CMD_GENERATE_MAC
CSEC_CMD_VERIFY_MAC
CSEC_CMD_LOAD_KEY
CSEC_CMD_LOAD_PLAIN_KEY
CSEC_CMD_EXPORT_RAM_KEY
CSEC_CMD_INIT_RNG
CSEC_CMD_EXTEND_SEED
CSEC_CMD_RND
CSEC_CMD_RESERVED_1
CSEC_CMD_BOOT_FAILURE
CSEC_CMD_BOOT_OK
CSEC_CMD_GET_ID
CSEC_CMD_BOOT_DEFINE
CSEC_CMD_DBG_CHAL
CSEC_CMD_DBG_AUTH
CSEC_CMD_RESERVED 2
CSEC_CMD_RESERVED_3
CSEC_CMD_MP_COMPRESS

Definition at line 127 of file csec_driver.h.

16.6.5.4 enum csec_key id t

Specify the KeyID to be used to implement the requested cryptographic operation.

Implements : csec_key_id_t_Class

Enumerator

CSEC_SECRET_KEY
CSEC_MASTER_ECU
CSEC_BOOT_MAC_KEY
CSEC_BOOT_MAC
CSEC _KEY_1
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CSEC_KEY 2
CSEC_KEY_3
CSEC_KEY_4
CSEC_KEY_ 5
CSEC _KEY_ 6
CSEC KEY_ 7
CSEC_KEY_8
CSEC_KEY_9
CSEC_KEY_10
CSEC_RAM_KEY
CSEC _KEY_11
CSEC_KEY_12
CSEC_KEY_13
CSEC_KEY_14
CSEC _KEY_15
CSEC _KEY_16
CSEC_KEY 17

Definition at line 97 of file csec_driver.h.

16.6.6 Function Documentation

16.6.6.1 status_t CSEC_DRV_BootDefine ( uint32_t bootSize, csec_boot_flavor_t bootFlavor )

Implements an extension of the SHE standard to define both the user boot size and boot method.

The function implements an extension of the SHE standard to define both the user boot size and boot method.

Parameters
in bootSize | Number of blocks of 128-bit data to check on boot. Maximum size is 512k«
Bytes.
in bootFlavor | The boot method.
Returns

Error Code after command execution.

Definition at line 928 of file csec_driver.c.
16.6.6.2 status_t CSEC_DRV_BootFailure ( void )
Signals a failure detected during later stages of the boot process.

The function is called during later stages of the boot process to detect a failure.

Returns

Error Code after command execution.

Definition at line 860 of file csec_driver.c.
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16.6.6.3 status_t CSEC_DRV_BootOK ( void )

Marks a successful boot verification during later stages of the boot process.

The function is called during later stages of the boot process to mark successful boot verification.

Returns

Error Code after command execution.
Definition at line 894 of file csec_driver.c.

16.6.6.4 void CSEC_DRV_CancelCommand ( void )

Cancels a previously launched asynchronous command.

Definition at line 1784 of file csec_driver.c.
16.6.6.5 status_t CSEC_DRV_DbgAuth ( const uint8_t * authorization )

Erases all keys (actual and outdated) stored in NVM Memory if the authorization is confirmed by CSEc.
This function erases all keys (actual and outdated) stored in NVM Memory if the authorization is confirmed by CSEc.

Parameters

in authorization \ Pointer to the 128-bit buffer containing the authorization value.

Returns

Error Code after command execution.

Definition at line 1059 of file csec_driver.c.
16.6.6.6 status_t CSEC_DRV_DbgChal ( uint8_t « challenge )
Obtains a random number which the user shall use along with the MASTER_ECU_KEY and UID to return an

authorization request.

This function obtains a random number which the user shall use along with the MASTER_ECU_KEY and UID to
return an authorization request.

Parameters

out challenge | Pointer to the 128-bit buffer where the challenge data will be stored.

Returns

Error Code after command execution. Output parameters are valid if the error code is STATUS_SUCCESS.

Definition at line 1019 of file csec_driver.c.

16.6.6.7 status_t CSEC_DRV_DecryptCBC ( csec_key_id_t keyld, const uint8_t « cipherText, uint32_t length, const uint8_t
* iy, uint8_t x plainText, uint32_t timeout )

Performs the AES-128 decryption in CBC mode.

This function performs the AES-128 decryption in CBC mode of the input cipher text buffer.

Parameters
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in keyld | KeylD used to perform the cryptographic operation.
in cipherText | Pointer to the cipher text buffer.
in length | Number of bytes of cipher text message to be decrypted. It should be multiple
of 16 bytes.
in iv | Pointer to the initialization vector buffer.
out plainText | Pointer to the plain text buffer. The buffer shall have the same size as the
cipher text buffer.
in timeout | Timeout in milliseconds.
Returns

Error Code after command execution. Output parameters are valid if the error code is STATUS_SUCCESS.

Definition at line 327 of file csec_driver.c.

16.6.6.8 status_t CSEC_DRV_DecryptCBCAsync ( csec_key_id_t keyld, const uint8_t * cipherText, uint32_t length, const
uint8_t « iv, uint8_t * plainText )

Asynchronously performs the AES-128 decryption in CBC mode.

This function performs the AES-128 decryption in CBC mode of the input cipher text buffer, in an asynchronous

manner.
Parameters
in keyld | KeylD used to perform the cryptographic operation.
in cipherText | Pointer to the cipher text buffer.
in length | Number of bytes of cipher text message to be decrypted. It should be multiple
of 16 bytes.
in iv | Pointer to the initialization vector buffer.
out plainText | Pointer to the plain text buffer. The buffer shall have the same size as the
cipher text buffer.
Returns

STATUS_SUCCESS if the command was successfully launched, STATUS_BUSY if another command was
already launched. CSEC_DRV_GetAsyncCmdStatus can be used in order to check the execution status.

Definition at line 1282 of file csec_driver.c.

16.6.6.9 status_t CSEC_DRV_DecryptECB ( csec_key id_t keyld, const uint8_t x cipherText, uint32_t length, uint8_t x

plainText, uint32_t timeout )

Performs the AES-128 decryption in ECB mode.

This function performs the AES-128 decryption in ECB mode of the input cipher text buffer.

Parameters
in keyld | KeylD used to perform the cryptographic operation
in cipherText | Pointer to the cipher text buffer.
in length | Number of bytes of cipher text message to be decrypted. It should be multiple
of 16 bytes.
out plainText | Pointer to the plain text buffer. The buffer shall have the same size as the
cipher text buffer.
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in

timeout

Timeout in milliseconds.

Returns

Error Code after command execution. Output parameters are valid if the error code is STATUS_SUCCESS.

Definition at line 219 of file csec_driver.c.

16.6.6.10 status_t CSEC_DRV_DecryptECBAsync ( csec_key_id_t keyld, const uint8_t * cipherText, uint32_t length,
uint8_t « plainText )

Asynchronously performs the AES-128 decryption in ECB mode.

This function performs the AES-128 decryption in ECB mode of the input cipher text buffer, in an asynchronous

manner.
Parameters
in keyld | KeylID used to perform the cryptographic operation
in cipherText | Pointer to the cipher text buffer.
in length | Number of bytes of cipher text message to be decrypted. It should be multiple
of 16 bytes.
out plainText | Pointer to the plain text buffer. The buffer shall have the same size as the
cipher text buffer.
Returns

STATUS_SUCCESS if the command was successfully launched, STATUS_BUSY if another command was
already launched. CSEC_DRV_GetAsyncCmdStatus can be used in order to check the execution status.

Definition at line 1215 of file csec_driver.c.

16.6.6.11

void CSEC_DRV_Deinit ( void )

Clears the internal state of the driver and disables the FTFC interrupt.

Definition at line 151 of file csec_driver.c.

16.6.6.12 status_t CSEC_DRV_EncryptCBC ( csec_key_id_t keyld, const uint8_t * plainText, uint32_t length, const uint8_t
* iy, uint8_t x cipherText, uint32_t timeout )

Performs the AES-128 encryption in CBC mode.

This function performs the AES-128 encryption in CBC mode of the input plaintext buffer.

Parameters
in keyld | KeylID used to perform the cryptographic operation.
in plainText | Pointer to the plain text buffer.
in length | Number of bytes of plain text message to be encrypted. It should be multiple
of 16 bytes.
in iv | Pointer to the initialization vector buffer.
in timeout | Timeout in milliseconds.
out cipherText | Pointer to the cipher text buffer. The buffer shall have the same size as the
plain text buffer.
in timeout | Timeout in milliseconds.
Returns

Error Code after command execution. Output parameters are valid if the error code is STATUS_SUCCESS.

Definition at line 271 of file csec_driver.c.
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16.6.6.13 status_t CSEC_DRV_EncryptCBCAsync ( csec_key_id_t keyld, const uint8_t * plainText, uint32_t length, const
uint8_t x iy, uint8_t x cipherText )
Asynchronously performs the AES-128 encryption in CBC mode.

This function performs the AES-128 encryption in CBC mode of the input plaintext buffer, in an asynchronous
manner.

Parameters
in keyld | KeylD used to perform the cryptographic operation.
in plainText | Pointer to the plain text buffer.
in length | Number of bytes of plain text message to be encrypted. It should be multiple
of 16 bytes.
in iv | Pointer to the initialization vector buffer.
out cipherText | Pointer to the cipher text buffer. The buffer shall have the same size as the
plain text buffer.
Returns

STATUS_SUCCESS if the command was successfully launched, STATUS_BUSY if another command was
already launched. CSEC_DRV_GetAsyncCmdStatus can be used in order to check the execution status.

Definition at line 1247 of file csec_driver.c.

16.6.6.14 status_t CSEC_DRV_EncryptECB ( csec_key_id_t keyld, const uint8_t « plainText, uint32_t length, uint8_t x
cipherText, uint32_t timeout )

Performs the AES-128 encryption in ECB mode.
This function performs the AES-128 encryption in ECB mode of the input plain text buffer

Parameters
in keyld | KeylD used to perform the cryptographic operation.
in plainText | Pointer to the plain text buffer.
in length | Number of bytes of plain text message to be encrypted. It should be multiple
of 16 bytes.
out cipherText | Pointer to the cipher text buffer. The buffer shall have the same size as the
plain text buffer.
in timeout | Timeout in milliseconds.
Returns

Error Code after command execution. Output parameters are valid if the error code is STATUS_SUCCESS.

Definition at line 166 of file csec_driver.c.

16.6.6.15 status_t CSEC_DRV_EncryptECBAsync ( csec_key_id_t keyld, const uint8_t x plainText, uint32_t length, uint8_t
* cipherText )

Asynchronously performs the AES-128 encryption in ECB mode.

This function performs the AES-128 encryption in ECB mode of the input plain text buffer, in an asynchronous
manner.

Parameters
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in keyld | KeylD used to perform the cryptographic operation.
in plainText | Pointer to the plain text buffer.
in length | Number of bytes of plain text message to be encrypted. It should be multiple
of 16 bytes.
out cipherText | Pointer to the cipher text buffer. The buffer shall have the same size as the
plain text buffer.
Returns

STATUS_SUCCESS if the command was successfully launched, STATUS_BUSY if another command was
already launched. CSEC_DRV_GetAsyncCmdStatus can be used in order to check the execution status.

Definition at line 1183 of file csec_driver.c.

16.6.6.16 status_t CSEC_DRV_ExportRAMKey ( uint8_t x m1, uint8_t « m2, uint8_t « m3, uint8_t + m4, uint8_t x m5 )

Exports the RAM_KEY into a format protected by SECRET_KEY.
This function exports the RAM_KEY into a format protected by SECRET_KEY.

Parameters
out m1 | Pointer to a buffer where the M1 parameter will be exported.
out m2 | Pointer to a buffer where the M2 parameter will be exported.
out m3 | Pointer to a buffer where the M3 parameter will be exported.
out m4 | Pointer to a buffer where the M4 parameter will be exported.
out m5 | Pointer to a buffer where the M5 parameter will be exported.
Returns

Error Code after command execution. Output parameters are valid if the error code is STATUS_SUCCESS.

Definition at line 693 of file csec_driver.c.

16.6.6.17 status_t CSEC_DRV_ExtendSeed ( const uint8_t  entropy )

Extends the seed of the PRNG.

Extends the seed of the PRNG by compressing the former seed value and the supplied entropy into a new seed.
This new seed is then to be used to generate a random number by invoking the CMD_RND command. The random
number generator must be initialized by CMD_INIT_RNG before the seed may be extended.

Parameters

in

entropy

Pointer to a 128-bit buffer containing the entropy.

Returns

Error Code after command execution. Output parameters are valid if the error code is STATUS_SUCCESS.

Definition at line 782 of file csec_driver.c.

16.6.6.18 status_t CSEC_DRV_GenerateMAC ( csec_key_id_t keyld, const uint8_t « msg, uint32_t msgLen, uint8_t x cmac,

uint32_t timeout )

Calculates the MAC of a given message using CMAC with AES-128.

This function calculates the MAC of a given message using CMAC with AES-128.
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Parameters

in keyld | KeylD used to perform the cryptographic operation.

in msg | Pointer to the message buffer.

in msgLen | Number of bits of message on which CMAC will be computed.

out cmac | Pointer to the buffer containing the result of the CMAC computation.

in timeout | Timeout in milliseconds.
Returns

Error Code after command execution. Output parameters are valid if the error code is STATUS_SUCCESS.

Definition at line 383 of file csec_driver.c.

16.6.6.19 status_t CSEC_DRV_GenerateMACAddrMode ( csec_key_id_t keyld, const uint8_t x msg, uint32_t msgLen,
uint8_t « cmac )

Calculates the MAC of a given message (located in Flash) using CMAC with AES-128.

This function calculates the MAC of a given message using CMAC with AES-128. It is different from the CSEC_+«
DRV_GenerateMAC function in the sense that it does not involve an extra copy of the data on which the CMAC is
computed and the message pointer should be a pointer to Flash memory.

Parameters

in keyld | KeylD used to perform the cryptographic operation.

in msg | Pointer to the message buffer (pointing to Flash memory).

in msgLen | Number of bits of message on which CMAC will be computed.

out cmac | Pointer to the buffer containing the result of the CMAC computation.
Returns

Error Code after command execution. Output parameters are valid if the error code is STATUS_SUCCESS.

Definition at line 439 of file csec_driver.c.

16.6.6.20 status_t CSEC_DRV_GenerateMACAsync ( csec_key_id_t keyld, const uint8_t x msg, uint32_t msgLen, uint8_t *

Asynchronously calculates the MAC of a given message using CMAC with AES-128.

This function calculates the MAC of a given message using CMAC with AES-128, in an asynchronous manner.

Parameters

in keyld | KeylD used to perform the cryptographic operation.

in msg | Pointer to the message buffer.

in msgLen | Number of bits of message on which CMAC will be computed.

out cmac | Pointer to the buffer containing the result of the CMAC computation.
Returns

STATUS_SUCCESS if the command was successfully launched, STATUS_BUSY if another command was
already launched. CSEC_DRV_GetAsyncCmdStatus can be used in order to check the execution status.

Definition at line 1317 of file csec_driver.c.

16.6.6.21

status_t CSEC_DRV_GenerateRND ( uint8_t * rnd )

Generates a vector of 128 random bits.

The function returns a vector of 128 random bits. The random number generator has to be initialized by calling
CSEC_DRV_InitRNG before random numbers can be supplied.
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Parameters
out rnd | Pointer to a 128-bit buffer where the generated random number has to be
stored.
Returns

Error Code after command execution. Output parameters are valid if the error code is STATUS_SUCCESS.

Definition at line 820 of file csec_driver.c.
16.6.6.22 status_t CSEC_DRV_GetAsyncCmdStatus ( void )

Checks the status of the execution of an asynchronous command.

This function checks the status of the execution of an asynchronous command. If the command is still in progress,
returns STATUS_BUSY.

Returns

Error Code after command execution.
Definition at line 1390 of file csec_driver.c.

16.6.6.23 status_t CSEC_DRV_GetID ( const uint8_t  challenge, uint8_t x uid, uint8_t  sreg, uint8_t x mac )

Returns the identity (UID) and the value of the status register protected by a MAC over a challenge and the data.

This function returns the identity (UID) and the value of the status register protected by a MAC over a challenge and
the data.

Parameters
in challenge | Pointer to the 128-bit buffer containing Challenge data.
out uid | Pointer to 120 bit buffer where the UID will be stored.
out sreg | Value of the status register.
out mac | Pointer to the 128 bit buffer where the MAC generated over challenge and UID
and status will be stored.
Returns

Error Code after command execution. Output parameters are valid if the error code is STATUS_SUCCESS.

Definition at line 967 of file csec_driver.c.
16.6.6.24 static csec_status_t CSEC_DRV_GetStatus ( void ) [inline], [static]

Returns the content of the status register.

The function shall return the content of the status register.

Returns

Value of the status register.
Implements : CSEC_DRV_GetStatus_Activity
Definition at line 526 of file csec_driver.h.
16.6.6.25 void CSEC_DRV_Init ( csec_state_t x state )

Initializes the internal state of the driver and enables the FTFC interrupt.
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Parameters

in state | Pointer to the state structure which will be used for holding the internal state of
the driver.

Definition at line 131 of file csec_driver.c.
16.6.6.26 status_t CSEC_DRV_InitRNG ( void )

Initializes the seed and derives a key for the PRNG.

The function initializes the seed and derives a key for the PRNG. The function must be called before CMD_RND
after every power cycle/reset.

Returns
Error Code after command execution.
Definition at line 745 of file csec_driver.c.
16.6.6.27 void CSEC_DRV _InstallCallback ( security_callback_t callbackFunc, void x callbackParam )

Installs a callback function which will be invoked when an asynchronous command finishes its execution.

Parameters
in callbackFunc | The function to be invoked.
in callbackParam | The parameter to be passed to the callback function.

Definition at line 1769 of file csec_driver.c.

16.6.6.28 status_t CSEC_DRV_LoadKey ( csec_key_id_t keyld, const uint8_t x m1, const uint8_t x m2, const uint8_t x m3,
uint8_t « m4, uint8_t x m5 )

Updates an internal key per the SHE specification.

This function updates an internal key per the SHE specification.

Parameters
in keyld | KeylD of the key to be updated.
in m1 | Pointer to the 128-bit M1 message containing the UID, Key ID and Authentica-
tion Key ID.
in m2 | Pointer to the 256-bit M2 message contains the new security flags, counter
and the key value all encrypted using a derived key generated from the Au-
thentication Key.
in m3 | Pointer to the 128-bit M3 message is a MAC generated over messages M1
and M2.
out m4 | Pointer to a 256 bits buffer where the computed M4 parameter is stored.
out m5 | Pointer to a 128 bits buffer where the computed M5 parameters is stored.
Returns

Error Code after command execution. Output parameters are valid if the error code is STATUS_SUCCESS.

Definition at line 602 of file csec_driver.c.
16.6.6.29 status_t CSEC_DRV_LoadPlainKey ( const uint8_t « plainKey )

Updates the RAM key memory slot with a 128-bit plaintext.

The function updates the RAM key memory slot with a 128-bit plaintext. The key is loaded without encryption and
verification of the key, i.e. the key is handed over in plaintext. A plain key can only be loaded into the RAM_KEY
slot.
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Parameters
in plainKey | Pointer to the 128-bit buffer containing the key that needs to be copied in R«
AM_KEY slot.
Returns

Error Code after command execution.

Definition at line 656 of file csec_driver.c.

16.6.6.30 status_t CSEC_DRV_MPCompress ( const uint8_t x msg, uint16_t msglLen, uint8_t « mpCompress, uint32_t timeout
)

Compresses the given messages by accessing the Miyaguchi-Prenell compression feature with in the CSEc feature
set.

This function accesses a Miyaguchi-Prenell compression feature within the CSEc feature set to compress the given
messages.

Parameters
in msg | Pointer to the messages to be compressed. Messages must be pre-processed
per SHE specification if they do not already meet the full 128-bit block size
requirement.
in msglLen | The number of 128 bit messages to be compressed.
out mpCompress | Pointer to the 128 bit buffer storing the compressed data.
in timeout | Timeout in milliseconds.
Returns

Error Code after command execution. Output parameters are valid if the error code is STATUS_SUCCESS.

Definition at line 1096 of file csec_driver.c.

16.6.6.31 status_t CSEC_DRV_VerifyMAC ( csec_key_id_t keyld, const uint8_t x msg, uint32_t msgLen, const uint8_t x
mac, uint16_t macLen, bool x verifStatus, uint32_t timeout )

Verifies the MAC of a given message using CMAC with AES-128.
This function verifies the MAC of a given message using CMAC with AES-128.

Parameters
in keyld | KeylD used to perform the cryptographic operation.
in msg | Pointer to the message buffer.
in msglLen | Number of bits of message on which CMAC will be computed.
in mac | Pointer to the buffer containing the CMAC to be verified.
in macLen | Number of bits of the CMAC to be compared. A maclLength value of zero
indicates that all 128-bits are compared.
out verifStatus | Status of MAC verification command (true: verification operation passed,
false: verification operation failed).
in timeout | Timeout in milliseconds.
Returns

Error Code after command execution. Output parameters are valid if the error code is STATUS_SUCCESS.

Definition at line 484 of file csec_driver.c.
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16.6.6.32 status_t CSEC_DRV_VerifyMACAddrMode ( csec_key_id_t keyld, const uint8_t x msg, uint32_t msgLen, const
uint8_t « mac, uint16_t macLen, bool x verifStatus )

Verifies the MAC of a given message (located in Flash) using CMAC with AES-128.

This function verifies the MAC of a given message using CMAC with AES-128. It is different from the CSEC_DRV+«
_VerifyMAC function in the sense that it does not involve an extra copy of the data on which the CMAC is computed
and the message pointer should be a pointer to Flash memory.

Parameters
in keyld | KeylID used to perform the cryptographic operation.
in msg | Pointer to the message buffer (pointing to Flash memory).
in msgLen | Number of bits of message on which CMAC will be computed.
in mac | Pointer to the buffer containing the CMAC to be verified.
in macLen | Number of bits of the CMAC to be compared. A maclLength value of zero
indicates that all 128-bits are compared.
out verifStatus | Status of MAC verification command (true: verification operation passed,
false: verification operation failed).
Returns

Error Code after command execution. Output parameters are valid if the error code is STATUS_SUCCESS.

Definition at line 547 of file csec_driver.c.

16.6.6.33 status_t CSEC_DRV_VerifyMACAsync ( csec_key_id_t keyld, const uint8_t « msg, uint32_t msgLen, const

uint8_t « mac, uint16_t macLen, bool x verifStatus )

Asynchronously verifies the MAC of a given message using CMAC with AES-128.

This function verifies the MAC of a given message using CMAC with AES-128, in an asynchronous manner.

Parameters
in keyld | KeylD used to perform the cryptographic operation.
in msg | Pointer to the message buffer.
in msgLen | Number of bits of message on which CMAC will be computed.
in mac | Pointer to the buffer containing the CMAC to be verified.
in macLen | Number of bits of the CMAC to be compared. A macLength value of zero
indicates that all 128-bits are compared.
out verifStatus | Status of MAC verification command (true: verification operation passed,
false: verification operation failed).
Returns

STATUS_SUCCESS if the command was successfully launched, STATUS_BUSY if another command was
already launched. CSEC_DRV_GetAsyncCmdStatus can be used in order to check the execution status.

Definition at line 1350 of file csec_driver.c.
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16.7 Clock

16.7.1 Detailed Description

Dynamic clock setting

« status_t CLOCK_DRV_GetFreq (clock_names_t clockName, uint32_t xfrequency)

Gets the clock frequency for a specific clock name.
« status_t CLOCK_DRV_Init (clock_user_config_t const xconfig)

Set clock configuration according to pre-defined structure.

16.7.2 Function Documentation

16.7.2.1 status_t CLOCK_DRV_GetFreq ( clock_names_t clockName, uint32_t x frequency )

Gets the clock frequency for a specific clock name.

This function checks the current clock configurations and then calculates the clock frequency for a specific clock
name defined in clock_names_t. Clock modules must be properly configured before using this function. See
features.h for supported clock names for different chip families. The returned value is in Hertz. If it cannot find
the clock name or the name is not supported for a specific chip family, it returns an STATUS_UNSUPPORTED. If
frequency is required for a peripheral and the module is not clocked, then STATUS_MCU_GATED_OFF status is
returned. Frequency is returned if a valid address is provided. If frequency is required for a peripheral that doesn't
support protocol clock, the zero value is provided.

Parameters
in clockName | Clock names defined in clock_names t
out frequency | Returned clock frequency value in Hertz
Returns

status Error code defined in status_t

Definition at line 1902 of file clock_S32K1xx.c.

16.7.2.2 status_t CLOCK_DRV_lInit ( clock_user_config_t const x config )

Set clock configuration according to pre-defined structure.

This function sets system to target clock configuration; It sets the clock modules registers for clock mode change.

Parameters

in

config

Pointer to configuration structure.

Returns

Error code.

Note

If external clock is used in the target mode, please make sure it is enabled, for example, if the external oscillator

is used, please setup correctly.

If the configuration structure is NULL, the function will set a default configuration for clock.

Definition at line 603 of file clock_S32K1xx.c.
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16.8 Clock Manager
16.8.1 Detailed Description

This module covers the clock management API and clock related functionality.
This section describes the programming interface of the clock_manager driver. Clock_manager achieves its func-
tionality by configuring the hardware modules involved in clock distribution and management.

Driver consideration

The Clock Manager driver is developed on top of an appropriate hardware access layer. The Clock Manager
provides API to handle the clock configuration. The Driver uses structures for configuration. The actual format of
the structure is defined by the underlying device specific header file. These structures may be generated using
S32DS configuration. The user application can use the default for most settings, changing only what is necessary.

This driver provides functions for initializing system clock and peripheral clock.

All methods that access the hardware layer will return an error code to signal if the operation succeeded or failed.
The values are defined by the status_t enumeration, and the possible values include: success, error.

Modules

» Clock Manager Driver

This module covers the device-specific clock_manager functionality implemented for S32K1xx SOC.
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16.9 Clock Manager Driver
16.9.1 Detailed Description

This module covers the device-specific clock_manager functionality implemented for S32K1xx SOC.

The support for S32K1xx consist in the following items:

1. Clock names enumeration clock_names_t is an enumeration which contains all clock names which are rele-
vant for S32K1xx.

2. Submodule configuration structures

» scg_config_t
* pcc_config_t
» sim_clock_config_t

* pmc_config_t

3. Submodule configuration functions The following functions were implemented for S32K1xx:

CLOCK_SYS_SetScgConfiguration

CLOCK_SYS_SetPccConfiguration

CLOCK_SYS_SetSimConfiguration

CLOCK_SYS_SetPmcConfiguration

Hardware background

Features of clock_manager module include the following clock sources:

4 - 40 MHz fast external oscillator (SOSC)
» 48 MHz Fast Internal RC oscillator (FIRC)
+ 8 MHz Slow Internal RC oscillator (SIRC)
» 128 kHz Low Power Oscillator (LPO)

* Upto 112 MHz (HSRUN) System Phased Lock Loop (SPLL)

How to use the CLOCK_MANAGER driver in your application

In order to be able to use the clock_manager in your application, CLOCK_DRV_Init function has to be called. The
same function is called when another configuration is loaded and clock configuration is updated.

Code Example

This is an example for switching between two configurations:

CLOCK_SYS_TInit (g_clockManConfigsArr,
CLOCK_MANAGER_CONFIG_CNT,
g_clockManCallbacksArr,
CLOCK_MANAGER_CALLBACK_CNT) ;

CLOCK_SYS_UpdateConfiguration (O,
CLOCK_MANAGER_POLICY_FORCIBLE) ;

CLOCK_SYS_UpdateConfiguration (1,
CLOCK_MANAGER_POLICY_FORCIBLE) ;
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Notes

Current implementation assumes that the clock configurations are valid and are applied in a valid sequence. Mainly
this means that the configuration doesn't reinitialize the clock used as the system clock.

According to Errata 10777, when the power mode is being switched, the core clock frequency is incorrectly read.
As a result, when switching from VLPR mode to HSRUN, the frequency has to be read twice or after some time has
passed.

The S32DS do not support generate Callbacks configuration. It's alway empty.
Integration guideline

Compilation units

The following files need to be compiled in the project:

${S32SDK_PATH}\platform\drivers\src\clock\S32Klxx\clock_S32Klxx.c

Include path

The following paths need to be added to the include path of the toolchain:

${S32SDK_PATH}\platform\drivers\inc\
${S32SDK_PATH}\platform\drivers\src\clock\
${S32SDK_PATH}\platform\drivers\src\clock\S32K1xx\

Compile symbols
No special symbols are required for this component
Dependencies

Interrupt Manager (Interrupt)

Data Structures

« struct sim_clock_out_config_t

SIM ClockOut configuration. Implements sim_clock_out_config_t_Class. More...
« struct sim_Ipo_clock_config_t

SIM LPO Clocks configuration. Implements sim_Ipo_clock_config_t_Class. More...
« struct sim_tclk_config_t

SIM Platform Gate Clock configuration. Implements sim_tclk_config_t_Class. More...
« struct sim_plat_gate_config_t

SIM Platform Gate Clock configuration. Implements sim_plat_gate config_t Class. More...
« struct sim_qspi_ref_clk_gating_t

SIM QSPI reference clock gating. Implements sim_qspi_ref_clk_gating_t Class. More...
« struct sim_trace_clock_config_t

SIM Debug Trace clock configuration. Implements sim_trace_clock_config_t Class. More...
« struct sim_clock_config_t

SIM configure structure. Implements sim_clock_config_t_Class. More...
« struct scg_system_clock_config_t

SCG system clock configuration. Implements scg_system_clock_config_t_Class. More...
« struct scg_sosc_config_t

SCG system OSC configuration. Implements scg_sosc_config t Class. More...
« struct scg_sirc_config_t

SCG slow IRC clock configuration. Implements scg_sirc_config_t Class. More...
« struct scg_firc_config_t

Generated on Fri Jun 11 2021 08:14:09 for S32SDK User Manual by Doxygen



16.9 Clock Manager Driver 199

SCG fast IRC clock configuration. Implements scg_firc_config_t Class. More...
« struct scg_spll_config_t

SCG system PLL configuration. Implements scg_spll_config_t Class. More...
« struct scg_rtc_config_t

SCG RTC configuration. Implements scg_rtc_config_t Class. More...
+ struct scg_clock_mode_config_t

SCG Clock Mode Configuration structure. Implements scg_clock_mode_config_t Class. More...
« struct scg_clockout_config_t

SCG ClockOut Configuration structure. Implements scg_clockout config_t Class. More...
« struct scg_config_t

SCG configure structure. Implements scg_config_t _Class. More...
« struct peripheral_clock_config_t

PCC peripheral instance clock configuration. Implements peripheral_clock_config_t Class. More...
« struct pcc_config_t

PCC configuration. Implements pcc_config_t _Class. More...
« struct pmc_lIpo_clock_config_t

PMC LPO configuration. Implements pmc_lpo_clock_config_t _Class. More...
« struct pmc_config_t

PMC configure structure. Implements pmc_config_t_Class. More...
« struct clock_manager_user_config_t

Clock configuration structure. Implements clock_manager_user_config_t _Class. More...
« struct module_clk_config_t

module clock configuration. Implements module_clk_config_t _Class More...
« struct sys_clk_config_t

System clock configuration. Implements sys_clk_config_t Class. More...
« struct clock_source_config_t

Clock source configuration. Implements clock_source _config t Class. More...
« struct clock_notify_struct_t

Clock notification structure passed to clock callback function. Implements clock_notify_struct t Class. More...
« struct clock_manager_callback_user_config_t

Structure for callback function and its parameter. Implements clock_manager_callback_user_config t Class. More...
« struct clock_manager_state_t

Clock manager state structure. Implements clock_manager_state t Class. More...

Macros

+ #define NUMBER_OF_TCLK_INPUTS 3U

TClk clock frequency.
« #define SYS_CLK_MAX_NO 3U

The maximum number of system clock dividers and system clock divider indexes.
« #define CORE_CLK_INDEX 0U
« #define BUS_CLK_INDEX 1U
« #define SLOW_CLK_INDEX 2U
+ #define CLK_SRC_OFF 0x00U
+ #define CLK_SRC_SOSC 0x01U
* #define CLK_SRC_SIRC 0x02U
« #define CLK_SRC_FIRC 0x03U
« #tdefine CLK_SRC_SPLL 0x06U
« #define CLK_SRC_SOSC_DIV1 0x01U
« #define CLK_SRC_SIRC_DIV1 0x02U
« #define CLK_SRC_FIRC_DIV1 0x03U
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+ #define CLK_SRC_SPLL_DIV1 0x06U
« #define CLK_SRC_SOSC_DIV2 0x01U
+ #define CLK_SRC_SIRC_DIV2 0x02U
« #define CLK_SRC_FIRC_DIV2 0x03U
» #define CLK_SRC_SPLL_DIV2 0x06U

Typedefs

+ typedef uint8_t peripheral_clock_source_t

PCC clock source select Implements peripheral _clock_source t Class.
« typedef clock_manager_user_config_t clock_user_config_t
« typedef status_t(x clock_manager_callback_t) (clock_notify_struct_t xnotify, void xcallbackData)

Type of clock callback functions.

Enumerations

« enum sim_rtc_clk_sel_src_t{ SIM_RTCCLK_SEL_SOSCDIV1_CLK = 0x0U, SIM_RTCCLK_SEL_LPO 32K
= 0x1U, SIM_RTCCLK_SEL_RTC_CLKIN = 0x2U, SIM_RTCCLK_SEL_FIRCDIV1_CLK = 0x3U }

SIM CLK32KSEL clock source select Implements sim_rtc_clk_sel_src t Class.
» enum sim_Ipoclk_sel_src_t { SIM_LPO_CLK_SEL_LPO_128K = 0x0, SIM_LPO_CLK_SEL_NO_CLOCK
0x1, SIM_LPO_CLK_SEL_LPO_32K = 0x2, SIM_LPO_CLK_SEL_LPO_1K = 0x3 }
SIM LPOCLKSEL clock source select Implements sim_Ipoclk_sel_src t Class.
» enum sim_clkout_src_t{
SIM_CLKOUT_SEL SYSTEM_SCG_CLKOUT = 0U, SIM_CLKOUT_SEL SYSTEM SOSC DIV2 CLK
2U, SIM_CLKOUT _SEL_SYSTEM SIRC DIV2 CLK = 4U, SIM_CLKOUT_SEL_SYSTEM_ FIRC _DIV2 «+
CLK =6U,
SIM_CLKOUT_SEL _SYSTEM_HCLK = 7U, SIM_CLKOUT_SEL_SYSTEM_SPLL_DIV2 _CLK =8U, SIM_+
CLKOUT_SEL_SYSTEM_BUS CLK =9U, SIM_CLKOUT_SEL_SYSTEM_LPO_128K CLK = 10U,
SIM_CLKOUT_SEL_SYSTEM_LPO_CLK = 12U, SIM_CLKOUT_SEL_SYSTEM_RTC_CLK = 14U }

SIM CLKOUT select Implements sim_clkout_src_t Class.
» enum sim_clkout_div_t {
SIM_CLKOUT DIV_BY_ 1 = 0x0U, SIM_CLKOUT _DIV_BY_2 = 0x1U, SIM_CLKOUT _DIV_BY_3 = 0x2U,
SIM_CLKOUT _DIV_BY_4 = 0x3U,
SIM_CLKOUT _DIV_BY_5 = 0x4U, SIM_CLKOUT DIV_BY 6 = 0x5U, SIM_CLKOUT DIV _BY_7 = 0x6U,
SIM_CLKOUT_DIV_BY_8 = 0x7U }

SIM CLKOUT divider Implements sim_clkout div_t Class.
» enum clock_trace_src_t { CLOCK_TRACE_SRC_CORE_CLK = 0x0 }

Debug trace clock source select Implements clock_trace _src_t Class.
» enum scg_system_clock_src_t { SCG_SYSTEM_CLOCK_SRC_SYS 0OSC = 1U, SCG_SYSTEM_CLO«
CK_SRC_SIRC = 2U, SCG_SYSTEM_CLOCK_SRC_FIRC = 3U, SCG_SYSTEM_CLOCK_SRC_NONE =
255U }

SCG system clock source. Implements scg_system_clock_src_t Class.

» enum scg_system_clock_div_t {
SCG_SYSTEM_CLOCK_DIV_BY_1 =0U, SCG_SYSTEM_CLOCK_DIV_BY_2 = 1U, SCG_SYSTEM_CL«
OCK_DIV_BY_3 =2U, SCG_SYSTEM_CLOCK_DIV_BY_4 = 3U,
SCG_SYSTEM_CLOCK_DIV_BY_5 = 4U, SCG_SYSTEM_CLOCK_DIV_BY_6 = 5U, SCG_SYSTEM_CL+«
OCK_DIV_BY_7 =6U, SCG_SYSTEM_CLOCK_DIV_BY_8 = 7U,
SCG_SYSTEM_CLOCK_DIV_BY_9 = 8U, SCG_SYSTEM_CLOCK_DIV_BY_10 = 9U, SCG_SYSTEM_C+«
LOCK_DIV_BY_11 = 10U, SCG_SYSTEM_CLOCK_DIV_BY_12 = 11U,
SCG_SYSTEM_CLOCK_DIV_BY_13 = 12U, SCG_SYSTEM_CLOCK_DIV_BY_14 = 13U, SCG_SYSTE«
M_CLOCK_DIV_BY_15 = 14U, SCG_SYSTEM_CLOCK_DIV_BY_16 = 15U}

SCG system clock divider value. Implements scg_system clock_div_t Class.
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» enum scg_async_clock_div_t {
SCG_ASYNC_CLOCK_DISABLE = 0U, SCG_ASYNC_CLOCK _DIV_BY_1=1U, SCG_ASYNC_CLOCK_«-
DIV_BY 2 =2U, SCG_ASYNC_CLOCK_DIV_BY_4 = 3U,
SCG_ASYNC_CLOCK_DIV_BY_8 = 4U, SCG_ASYNC_CLOCK_DIV_BY_16 = 5U, SCG_ASYNC_CLOC+
K_DIV_BY_32 = 6U, SCG_ASYNC_CLOCK_DIV_BY_64 =7U}

SCG asynchronous clock divider value. Implements scg_async_clock_div_t Class.
* enum scg_sosc_monitor_mode_t { SCG_SOSC_MONITOR_DISABLE = 0U, SCG_SOSC_MONITOR_INT =
1U, SCG_SOSC_MONITOR_RESET =2U }

SCG system OSC monitor mode. Implements scg_sosc_monitor_mode_t Class.
» enum scg_sosc_range_t { SCG_SOSC_RANGE_MID = 2U, SCG_SOSC_RANGE_HIGH =3U}

SCG OSC frequency range select Implements scg_sosc_range_t Class.
* enum scg_sosc_gain_t { SCG_SOSC_GAIN_LOW = 0x0, SCG_SOSC_GAIN_HIGH = 0x1 }

SCG OSC high gain oscillator select. Implements scg_sosc_gain t Class.
» enum scg_sosc_ext_ref_t { SCG_SOSC_REF_EXT = 0x0, SCG_SOSC_REF_OSC = 0x1}

SCG OSC external reference clock select. Implements scg_sosc_ext _ref t _Class.
» enum scg_sirc_range_t { SCG_SIRC_RANGE_HIGH = 1U }

SCG slow IRC clock frequency range. Implements scg_sirc_range_t Class.
» enum scg_firc_range_t { SCG_FIRC_RANGE_48M }

SCG fast IRC clock frequency range. Implements scg_firc_range t Class.

» enum scg_spll_monitor_mode_t { SCG_SPLL_MONITOR_DISABLE = 0U, SCG_SPLL_MONITOR_INT =
1U, SCG_SPLL_MONITOR_RESET = 2U }

SCG system PLL monitor mode. Implements scg_spll_monitor_mode_t Class.

» enum scg_spll_clock_prediv_t {
SCG_SPLL_CLOCK_PREDIV_BY_1 = 0U, SCG_SPLL_CLOCK_PREDIV_BY_2 = 1U, SCG_SPLL_CLO+«
CK_PREDIV_BY_3 =2U, SCG_SPLL_CLOCK_PREDIV_BY_4 = 3U,
SCG_SPLL_CLOCK_PREDIV_BY_5 = 4U, SCG_SPLL_CLOCK_PREDIV_BY_6 = 5U, SCG_SPLL_CLO+
CK_PREDIV_BY_7 =6U, SCG_SPLL_CLOCK_PREDIV_BY_8 =7U}

SCG system PLL predivider.

» enum scg_spll_clock_multiply_t {
SCG_SPLL_CLOCK_MULTIPLY_BY_16 = 0U, SCG_SPLL_CLOCK_MULTIPLY_BY_17 = 1U, SCG_SPL«
L CLOCK_MULTIPLY_BY_18 = 2U, SCG_SPLL_CLOCK_MULTIPLY_BY_19 = 3U,
SCG_SPLL_CLOCK_MULTIPLY_BY_20 = 4U, SCG_SPLL_CLOCK_MULTIPLY_BY_21 = 5U, SCG_SPL+«
L_CLOCK_MULTIPLY_BY_22 =6U, SCG_SPLL_CLOCK_MULTIPLY_BY_23 = 7U,
SCG_SPLL_CLOCK_MULTIPLY_BY_24 =8U, SCG_SPLL_CLOCK_MULTIPLY_BY_25 =9U, SCG_SPL+
L CLOCK_MULTIPLY_BY_26 = 10U, SCG_SPLL_CLOCK_MULTIPLY_BY_27 = 11U,
SCG_SPLL_CLOCK_MULTIPLY_BY_28 = 12U, SCG_SPLL_CLOCK_MULTIPLY_BY_29 = 13U, SCG_S«
PLL_CLOCK_MULTIPLY_BY_30 = 14U, SCG_SPLL_CLOCK_MULTIPLY_BY_31 = 15U,
SCG_SPLL_CLOCK_MULTIPLY_BY_32 = 16U, SCG_SPLL_CLOCK_MULTIPLY_BY_33 =17U, SCG_S+«
PLL_CLOCK_MULTIPLY_BY_34 = 18U, SCG_SPLL_CLOCK_MULTIPLY_BY_35 = 19U,
SCG_SPLL_CLOCK_MULTIPLY_BY_36 = 20U, SCG_SPLL_CLOCK_MULTIPLY_BY_37 = 21U, SCG_S«
PLL_CLOCK_MULTIPLY_BY_38 = 22U, SCG_SPLL_CLOCK_MULTIPLY_BY_39 = 23U,
SCG_SPLL_CLOCK_MULTIPLY_BY_40 = 24U, SCG_SPLL_CLOCK_MULTIPLY_BY_41 = 25U, SCG_S«
PLL_CLOCK_MULTIPLY_BY_ 42 = 26U, SCG_SPLL_CLOCK_MULTIPLY_BY_ 43 = 27U,
SCG_SPLL_CLOCK_MULTIPLY_BY_44 = 28U, SCG_SPLL_CLOCK_MULTIPLY_BY_45 = 29U, SCG_S+«
PLL_CLOCK_MULTIPLY_BY_46 = 30U, SCG_SPLL_CLOCK_MULTIPLY_BY_47 =31U}

SCG system PLL multiplier.
» enum peripheral_clock_frac_t { MULTIPLY_BY_ONE = 0x00U, MULTIPLY_BY_TWO = 0x01U }

PCC fractional value select Implements peripheral_clock_frac t Class.
» enum peripheral_clock_divider_t {
DIVIDE_BY_ONE = 0x00U, DIVIDE_BY_TWO = 0x01U, DIVIDE_BY_ THREE = 0x02U, DIVIDE_BY_FOUR
= 0x03U,
DIVIDE_BY_ FIVE = 0x04U, DIVIDE_BY_SIX = 0x05U, DIVIDE_BY_ SEVEN = 0x06U, DIVIDE_BY_EIGTH =
0x07U }

PCC divider value select Implements peripheral_clock_divider_t_Class.
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* enum pwr_modes_t {
NO_MODE = 0U, RUN_MODE = (1U<<0U), VLPR_MODE = (1U<<1U), HSRUN_MODE = (1U<<2U),
STOP_MODE = (1U<<3U), VLPS_MODE = (1U<<4U), ALL_MODES = 0x7FFFFFFF }
Power mode. Implements pwr_modes _t Class.
» enum xosc_ref_t { XOSC_EXT_REF = 0U, XOSC_INT_OSC =1U}
XOSC reference clock select (internal oscillator is bypassed or not) Implements xosc_ref t Class.
» enum clock_manager_notify_t { CLOCK_MANAGER_NOTIFY_RECOVER = 0x00U, CLOCK_MANAGER«
_NOTIFY_BEFORE = 0x01U, CLOCK_MANAGER_NOTIFY_AFTER = 0x02U }
The clock notification type. Implements clock_manager_notify_t Class.
» enum clock_manager_callback_type_t { CLOCK_MANAGER_CALLBACK_BEFORE = 0x01U, CLOCK_M«-
ANAGER_CALLBACK_AFTER = 0x02U, CLOCK_MANAGER_CALLBACK_BEFORE_AFTER = 0x03U }
The callback type, indicates what kinds of notification this callback handles. Implements clock_manager._callback«
_type_t Class.
» enum clock_manager_policy_t { CLOCK_MANAGER_POLICY_AGREEMENT, CLOCK_MANAGER_POL«
ICY_FORCIBLE }

Clock transition policy. Implements clock_manager_policy t Class.

Functions

+ void CLOCK_DRV_SetModuleClock (clock_names_t peripheralClock, const module_clk_config_t *module«
ClkConfig)

Configures module clock.

+ status_t CLOCK_DRV_SetSystemClock (const pwr_modes_t xmode, const sys_clk_config_t *sysCIlkConfig)
Configures the system clocks.

 void CLOCK_DRV_GetSystemClockSource (sys_clk_config_t «sysClkConfig)

Gets the system clock source.
« status_t CLOCK_DRV_SetClockSource (clock_names_t clockSource, const clock_source_config_t *clk«—
SrcConfig)

This function configures a clock source.
« status_t CLOCK_SYS_Init (clock_manager_user_config_t const xxclockConfigsPtr, uint8_t configsNumber,
clock_manager_callback_user_config_t sxcallbacksPtr, uint8_t callbacksNumber)

Install pre-defined clock configurations.
« status_t CLOCK_SYS_UpdateConfiguration (uint8_t targetConfigindex, clock_manager_policy_t policy)

Set system clock configuration according to pre-defined structure.
« status_t CLOCK_SYS_SetConfiguration (clock_manager_user_config_t const xconfig)

Set system clock configuration.
» uint8_t CLOCK_SYS_GetCurrentConfiguration (void)

Get current system clock configuration.
« clock_manager_callback_user_config_t «* CLOCK_SYS_GetErrorCallback (void)

Get the callback which returns error in last clock switch.
« status_t CLOCK_SYS_GetFreq (clock_names_t clockName, uint32_t «frequency)

Wrapper over CLOCK_DRV_GetFreq function. It's part of the old API.

Variables

« const uint8_t peripheralFeaturesList [CLOCK_NAME_COUNT]
Peripheral features list Constant array storing the mappings between clock names of the peripherals and feature lists.
» uint32_t g_TCIkFreq [NUMBER_OF_TCLK_INPUTS]
+ uint32_t g_xtalOClkFreq
EXTALO clock frequency.
 uint32_t g_RtcClkinFreq
RTC _CLKIN clock frequency.
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SCG Clockout.

» enum scg_clockout_src_t {

SCG_CLOCKOUT_SRC_SCG_SLOW = 0U, SCG_CLOCKOUT_SRC_SOSC = 1U, SCG_CLOCKOUT_S+

RC_SIRC =2U, SCG_CLOCKOUT_SRC_FIRC = 3U,
SCG_CLOCKOUT_SRC_SPLL =6U}

SCG ClockOut type. Implements scg_clockout_src_t Class.

16.9.2 Data Structure Documentation

16.9.2.1 struct sim_clock_out_config_t

SIM ClockOut configuration. Implements sim_clock_out_config_t_Class.

Definition at line 142 of file clock_S32K1xx.h.
Data Fields

* bool initialize

* bool enable

» sim_clkout_src_t source
« sim_clkout_div_t divider

Field Documentation
16.9.2.1.1 sim_clkout_div_t divider

SIM ClockOut divide ratio.
Definition at line 147 of file clock_S32K1xx.h.

16.9.2.1.2 bool enable

SIM ClockOut enable.
Definition at line 145 of file clock_S32K1xx.h.

16.9.2.1.3 bool initialize

Initialize or not the ClockOut clock.

Definition at line 144 of file clock_S32K1xx.h.
16.9.2.1.4 sim_clkout_src t source

SIM ClockOut source select.

Definition at line 146 of file clock_S32K1xx.h.

16.9.2.2 struct sim_Ipo_clock_config_t

SIM LPO Clocks configuration. Implements sim_Ipo_clock_config_t_Class.

Definition at line 155 of file clock_S32K1xx.h.
Data Fields

* bool initialize

» sim_rtc_clk_sel_src_t sourceRtcClk
» sim_lpoclk_sel_src_t sourceLpoClk
* bool enableLpo32k

* bool enableLpo1k
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Field Documentation
16.9.2.2.1 bool enableLpo1k

MSCM Clock Gating Control enable.
Definition at line 161 of file clock_S32K1xx.h.

16.9.2.2.2 bool enableLpo32k

MSCM Clock Gating Control enable.
Definition at line 160 of file clock_S32K1xx.h.

16.9.2.2.3 bool initialize

Initialize or not the LPO clock.

Definition at line 157 of file clock_S32K1xx.h.
16.9.2.2.4 sim_lpoclk_sel_src_t sourceLpoClk

LPO clock source select.

Definition at line 159 of file clock_S32K1xx.h.
16.9.2.25 sim_rtc_clk_sel_src t sourceRtcClk

RTC_CLK source select.
Definition at line 158 of file clock _S32K1xx.h.

16.9.2.3 struct sim_tclk_config_t

SIM Platform Gate Clock configuration. Implements sim_tclk_config_t_Class.

Definition at line 168 of file clock_S32K1xx.h.
Data Fields
* bool initialize

* uint32_t tclkFreq [NUMBER_OF_TCLK_INPUTS]
+ uint32_t extPinSrc [FTM_INSTANCE_COUNT]

Field Documentation
16.9.2.3.1 uint32_t extPinSrc[FTM_INSTANCE_COUNT]

FTMx frequency.
Definition at line 172 of file clock_S32K1xx.h.

16.9.2.3.2 bool initialize

Initialize or not the TCLK clock.

Definition at line 170 of file clock_S32K1xx.h.
16.9.2.3.3 uint32_t tclkFreqNUMBER_OF_TCLK_INPUTS]

TCLKXx frequency.
Definition at line 171 of file clock_S32K1xx.h.
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16.9.2.4 struct sim_plat_gate_config_t

SIM Platform Gate Clock configuration. Implements sim_plat_gate_config_t_Class.

Definition at line 179 of file clock_S32K1xx.h.
Data Fields

* bool initialize

* bool enableMscm
* bool enableMpu
* bool enableDma
* bool enableErm
* bool enableEim

Field Documentation
16.9.2.4.1 bool enableDma

DMA Clock Gating Control enable.
Definition at line 184 of file clock_S32K1xx.h.

16.9.2.4.2 bool enableEim

EIM Clock Gating Control enable.
Definition at line 186 of file clock_S32K1xx.h.

16.9.2.4.3 bool enableErm

ERM Clock Gating Control enable.
Definition at line 185 of file clock_S32K1xx.h.

16.9.2.4.4 bool enableMpu

MPU Clock Gating Control enable.
Definition at line 183 of file clock_S32K1xx.h.

16.9.2.4.5 bool enableMscm

MSCM Clock Gating Control enable.
Definition at line 182 of file clock_S32K1xx.h.

16.9.2.4.6 bool initialize

Initialize or not the Trace clock.

Definition at line 181 of file clock_S32K1xx.h.
16.9.2.5 struct sim_gspi_ref_clk_gating_t

SIM QSPI reference clock gating. Implements sim_qgspi_ref_clk_gating_t_Class.

Definition at line 193 of file clock _S32K1xx.h.
Data Fields

* bool enableQspiRefClk

Field Documentation
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16.9.2.5.1 bool enableQspiRefClk

gspi internal reference clock gating control enable.

Definition at line 195 of file clock_S32K1xx.h.
16.9.2.6 struct sim_trace_clock_config_t

SIM Debug Trace clock configuration. Implements sim_trace_clock_config_t_Class.
Definition at line 213 of file clock_S32K1xx.h.
Data Fields

* bool initialize

* bool divEnable

« clock _trace_src_t source
* uint8_t divider

* bool divFraction

Field Documentation
16.9.2.6.1 bool divEnable

Trace clock divider enable.

Definition at line 216 of file clock_S32K1xx.h.
16.9.2.6.2 bool divFraction

Trace clock divider fraction.

Definition at line 219 of file clock_S32K1xx.h.
16.9.2.6.3 uint8_t divider

Trace clock divider divisor.

Definition at line 218 of file clock_S32K1xx.h.
16.9.2.6.4 bool initialize

Initialize or not the Trace clock.

Definition at line 215 of file clock_S32K1xx.h.
16.9.2.6.5 clock trace src_t source

Trace clock select.

Definition at line 217 of file clock_S32K1xx.h.
16.9.2.7 struct sim_clock_config_t

SIM configure structure. Implements sim_clock_config_t_Class.

Definition at line 226 of file clock_S32K1xx.h.

Data Fields

» sim_clock_out_config_t clockOutConfig

+ sim_lIpo_clock_config_t IpoClockConfig

+ sim_tclk_config_t tclkConfig

» sim_plat_gate_config_t platGateConfig

+ sim_trace_clock_config_t traceClockConfig
» sim_qspi_ref_clk_gating_t gspiRefClkGating
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Field Documentation
16.9.2.7.1 sim_clock_out_config_t clockOutConfig

Clock Out configuration.

Definition at line 228 of file clock_S32K1xx.h.
16.9.2.7.2 sim_Ipo_clock_config_t IpoClockConfig

Low Power Clock configuration.

Definition at line 229 of file clock_S32K1xx.h.
16.9.2.7.3 sim_plat_gate_config_t platGateConfig

Platform Gate Clock configuration.

Definition at line 231 of file clock_S32K1xx.h.
16.9.2.7.4 sim_gspi_ref_clk_gating_t qspiRefClkGating

Qspi Reference Clock Gating.
Definition at line 233 of file clock_S32K1xx.h.

16.9.2.7.5 sim_tclk_config_t tclkConfig

TCLK, FTM option Clock configuration.
Definition at line 230 of file clock _S32K1xx.h.

16.9.2.7.6 sim_trace_clock_config_t traceClockConfig

Trace clock configuration.

Definition at line 232 of file clock_S32K1xx.h.
16.9.2.8 struct scg_system_clock_config_t

SCG system clock configuration. Implements scg_system_clock_config_t_Class.

Definition at line 280 of file clock_S32K1xx.h.
Data Fields

» scg_system_clock_div_t divSlow
 scg_system_clock_div_t divBus
» scg_system_clock_div_t divCore
» scg_system_clock_src_t src

Field Documentation
16.9.2.8.1 scg_system_clock_div_t divBus

BUS clock divider.
Definition at line 283 of file clock_S32K1xx.h.

16.9.2.8.2 scg_system_clock_div_t divCore

Core clock divider.

Definition at line 284 of file clock_S32K1xx.h.
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16.9.2.8.3 scg_system_clock_div_t divSlow

Slow clock divider.

Definition at line 282 of file clock_S32K1xx.h.
16.9.2.8.4 scg_system_clock_src_tsrc

System clock source.

Definition at line 285 of file clock_S32K1xx.h.
16.9.2.9 struct scg_sosc_config_t

SCG system OSC configuration. Implements scg_sosc_config_t_Class.

Definition at line 370 of file clock_S32K1xx.h.
Data Fields

* uint32_t freq

* scg_sosc_monitor_mode_t monitorMode
» scg_sosc_ext_ref t extRef
* sCg_sosc_gain_t gain

+ scg_sosc_range_t range

» scg_async_clock_div_t div1
» scg_async_clock_div_t div2
* bool enableInStop

* bool enablelnLowPower

* bool locked

* bool initialize

Field Documentation

16.9.2.9.1 scg_async_clock_div_t div1

Asynchronous peripheral source.

Definition at line 381 of file clock_S32K1xx.h.
16.9.2.9.2 scg_async_clock_div_t div2

Asynchronous peripheral source.

Definition at line 382 of file clock_S32K1xx.h.
16.9.2.9.3 bool enableinLowPower

System OSC is enable or not in low power mode.

Definition at line 385 of file clock_S32K1xx.h.
16.9.2.9.4 bool enablelnStop

System OSC is enable or not in stop mode.

Definition at line 384 of file clock_S32K1xx.h.
16.9.2.9.5 scg_sosc_ext_ref_t extRef

System OSC External Reference Select.

Definition at line 376 of file clock_S32K1xx.h.
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16.9.2.9.6 uint32_t freq

System OSC frequency.
Definition at line 372 of file clock_S32K1xx.h.

16.9.2.9.7 scg_sosc_gain_t gain

System OSC high-gain operation.
Definition at line 377 of file clock_S32K1xx.h.

16.9.2.9.8 bool initialize

Initialize or not the System OSC module.

Definition at line 389 of file clock_S32K1xx.h.
16.9.2.9.9 bool locked

System OSC Control Register can be written.

Definition at line 387 of file clock_S32K1xx.h.
16.9.2.9.10 scg_sosc_monitor_mode_t monitorMode

System OSC Clock monitor mode.
Definition at line 374 of file clock_S32K1xx.h.

16.9.2.9.11 scg_sosc_range_trange

System OSC frequency range.
Definition at line 379 of file clock_S32K1xx.h.

16.9.2.10 struct scg_sirc_config_t

SCG slow IRC clock configuration. Implements scg_sirc_config_t_Class.

Definition at line 405 of file clock_S32K1xx.h.
Data Fields

+ scg_sirc_range_t range

» scg_async_clock_div_t div1
» scg_async_clock_div_t div2
* bool initialize

* bool enableInStop

* bool enablelnLowPower

* bool locked

Field Documentation
16.9.2.10.1 scg_async_clock_div_t div1

Asynchronous peripheral source.

Definition at line 409 of file clock_S32K1xx.h.
16.9.2.10.2 scg_async_clock_div_t div2

Asynchronous peripheral source.

Definition at line 410 of file clock_S32K1xx.h.
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16.9.2.10.3 bool enableinLowPower

SIRC is enable or not in low power mode.

Definition at line 414 of file clock_S32K1xx.h.

16.9.2.10.4 bool enablelnStop

SIRC is enable or not in stop mode.

Definition at line 413 of file clock_S32K1xx.h.

16.9.2.10.5 Dbool initialize

Initialize or not the SIRC module.

Definition at line 412 of file clock_S32K1xx.h.

16.9.2.10.6 bool locked

SIRC Control Register can be written.

Definition at line 416 of file clock_S32K1xx.h.
16.9.2.10.7 scg_sirc_range_t range

Slow IRC frequency range.

Definition at line 407 of file clock_S32K1xx.h.

16.9.2.11 struct scg_firc_config_t

SCG fast IRC clock configuration. Implements scg_firc_config_t_Class.

Definition at line 432 of file clock_S32K1xx.h.

Data Fields

» scg_firc_range_t range

» scg_async_clock_div_t div1
» scg_async_clock_div_t div2
* bool enableInStop

* bool enablelnLowPower

* bool regulator

* bool locked

* bool initialize

Field Documentation
16.9.2.11.1 scg_async_clock_div_t divi

Asynchronous peripheral source.

Definition at line 436 of file clock_S32K1xx.h.
16.9.2.11.2 scg_async_clock_div_t div2

Asynchronous peripheral source.

Definition at line 437 of file clock_S32K1xx.h.
16.9.2.11.3 bool enablelnLowPower

FIRC is enable or not in lowpower mode.

Definition at line 440 of file clock_S32K1xx.h.
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16.9.2.11.4 bool enablelnStop

FIRC is enable or not in stop mode.

Definition at line 439 of file clock_S32K1xx.h.
16.9.2.11.5 bool initialize

Initialize or not the FIRC module.

Definition at line 444 of file clock_S32K1xx.h.
16.9.2.11.6 bool locked

FIRC Control Register can be written.

Definition at line 442 of file clock_S32K1xx.h.
16.9.2.11.7 scg_firc_range_t range

Fast IRC frequency range.

Definition at line 434 of file clock_S32K1xx.h.
16.9.2.11.8 bool regulator

FIRC regulator is enable or not.

Definition at line 441 of file clock_S32K1xx.h.

16.9.2.12 struct scg_spll_config_t

SCG system PLL configuration. Implements scg_spll_config_t_Class.

Definition at line 518 of file clock_S32K1xx.h.

Data Fields

* scg_spll_monitor_mode_t monitorMode
* uint8_t prediv

e uint8_t mult

e uint8 tsrc

» scg_async_clock_div_t div1

» scg_async_clock_div_t div2

* bool enablelnStop

* bool locked

* bool initialize

Field Documentation
16.9.2.12.1 scg_async_clock_div_t div1

Asynchronous peripheral source.

Definition at line 526 of file clock_S32K1xx.h.
16.9.2.12.2 scg_async_clock_div_t div2

Asynchronous peripheral source.

Definition at line 527 of file clock _S32K1xx.h.

16.9.2.12.3 bool enablelnStop

System PLL clock is enable or not in stop mode.
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Definition at line 529 of file clock _S32K1xx.h.
16.9.2.12.4 bool initialize

Initialize or not the System PLL module.

Definition at line 532 of file clock_S32K1xx.h.
16.9.2.12.5 bool locked

System PLL Control Register can be written.

Definition at line 531 of file clock_S32K1xx.h.
16.9.2.12.6 scg_spll_monitor_mode_t monitorMode

Clock monitor mode selected.

Definition at line 520 of file clock_S32K1xx.h.
16.9.2.12.7 uint8_t mult

System PLL multiplier.
Definition at line 523 of file clock_S32K1xx.h.

16.9.2.12.8 uint8_t prediv

PLL reference clock divider.

Definition at line 522 of file clock_S32K1xx.h.
16.9.2.12.9 uint8_t src

System PLL source.

Definition at line 524 of file clock_S32K1xx.h.

16.9.2.13 struct scg_rtc_config_t

SCG RTC configuration. Implements scg_rtc_config_t_Class.

Definition at line 539 of file clock_S32K1xx.h.
Data Fields

 uint32_t rtcClkInFreq
* bool initialize

Field Documentation
16.9.2.13.1 bool initialize

Initialize or not the RTC.

Definition at line 542 of file clock_S32K1xx.h.
16.9.2.13.2  uint32_t rtcClkinFreq

RTC_CLKIN frequency.
Definition at line 541 of file clock _S32K1xx.h.

16.9.2.14 struct scg_clock_mode_config_t

SCG Clock Mode Configuration structure. Implements scg_clock_mode_config_t_Class.
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Definition at line 549 of file clock_S32K1xx.h.

Data Fields

» scg_system_clock_config_t rccrConfig
+ scg_system_clock_config_t vccrConfig
+ scg_system_clock_config_t hcerConfig
» scg_system_clock_src_t alternateClock
* bool initialize

Field Documentation
16.9.2.14.1 scg_system_clock_src_t alternateClock

Alternate clock used during initialization

Definition at line 554 of file clock_S32K1xx.h.
16.9.2.14.2 scg_system_clock_config_t hcerConfig

HSRUN Clock Control configuration.
Definition at line 553 of file clock_S32K1xx.h.

16.9.2.14.3 bool initialize

Initialize or not the Clock Mode Configuration.

Definition at line 555 of file clock_S32K1xx.h.
16.9.2.14.4 scg_system_clock_config_t rccrConfig

Run Clock Control configuration.

Definition at line 551 of file clock _S32K1xx.h.
16.9.2.14.5 scg_system_clock_config_t vccrConfig

VLPR Clock Control configuration.
Definition at line 552 of file clock_S32K1xx.h.

16.9.2.15 struct scg_clockout_config_t

SCG ClockOut Configuration structure. Implements scg_clockout_config_t_Class.

Definition at line 562 of file clock_S32K1xx.h.

Data Fields

» scg_clockout_src_t source
* bool initialize

Field Documentation
16.9.2.15.1 bool initialize

Initialize or not the ClockOut.

Definition at line 565 of file clock_S32K1xx.h.
16.9.2.15.2 scg_clockout_src_t source

ClockOut source select.

Definition at line 564 of file clock_S32K1xx.h.
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16.9.2.16 struct scg_config_t

SCG configure structure. Implements scg_config_t_Class.

Definition at line 572 of file clock_S32K1xx.h.
Data Fields

* scg_sirc_config_t sircConfig

« scg_firc_config_t fircConfig
 scg_sosc_config_t soscConfig

+ scg_spll_config_t spliConfig

* scg_rtc_config_t rtcConfig

* scg_clockout_config_t clockOutConfig
 scg_clock_mode_config_t clockModeConfig

Field Documentation
16.9.2.16.1 scg_clock_mode_config_t clockModeConfig

SCG Clock Mode Configuration.
Definition at line 580 of file clock_S32K1xx.h.

16.9.2.16.2 scg_clockout_config_t clockOutConfig

SCG ClockOut Configuration.
Definition at line 579 of file clock_S32K1xx.h.

16.9.2.16.3 scg_firc_config_t fircConfig

Fast internal reference clock configuration.

Definition at line 575 of file clock_S32K1xx.h.
16.9.2.16.4 scg_rtc_config_t ricConfig

Real Time Clock configuration.

Definition at line 578 of file clock_S32K1xx.h.
16.9.2.16.5 scg_sirc_config_t sircConfig

Slow internal reference clock configuration.

Definition at line 574 of file clock_S32K1xx.h.
16.9.2.16.6 scg_sosc_config_t soscConfig

System oscillator configuration.

Definition at line 576 of file clock_S32K1xx.h.
16.9.2.16.7 scg_spll_config_t spliConfig

System Phase locked loop configuration.

Definition at line 577 of file clock_S32K1xx.h.

16.9.2.17  struct peripheral_clock_config_t

PCC peripheral instance clock configuration. Implements peripheral_clock_config_t_Class.

Definition at line 632 of file clock_S32K1xx.h.
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Data Fields

« clock_names_t clockName
bool clkGate

* peripheral_clock_source_t clkSrc
* peripheral_clock_frac_t frac
* peripheral_clock_divider_t divider

Field Documentation

16.9.2.17.1 bool clkGate

Peripheral clock gate.

Definition at line 642 of file clock_S32K1xx.h.
16.9.2.17.2 peripheral_clock_source_t clkSrc

Peripheral clock source.

Definition at line 643 of file clock_S32K1xx.h.
16.9.2.17.3 clock_names_t clockName

Definition at line 641 of file clock_S32K1xx.h.
16.9.2.17.4 peripheral_clock_divider_t divider

Peripheral clock divider value.

Definition at line 645 of file clock_S32K1xx.h.
16.9.2.17.5 peripheral_clock_frac_t frac

Peripheral clock fractional value.

Definition at line 644 of file clock_S32K1xx.h.

16.9.2.18 struct pcc_config_t

PCC configuration. Implements pcc_config_t_Class.

Definition at line 651 of file clock_S32K1xx.h.
Data Fields

e uint32_t count

* peripheral_clock_config_t * peripheralClocks

Field Documentation

16.9.2.18.1 uint32_t count

Number of peripherals to be configured.

Definition at line 653 of file clock_S32K1xx.h.

16.9.2.18.2 peripheral_clock_config_tx peripheralClocks

Pointer to the peripheral clock configurations array.

Definition at line 654 of file clock_S32K1xx.h.
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16.9.2.19 struct pmc_Ipo_clock_config_t

PMC LPO configuration. Implements pmc_lIpo_clock_config_t_Class.

Definition at line 660 of file clock_S32K1xx.h.
Data Fields

* bool initialize
* bool enable
* int8_t trimValue

Field Documentation
16.9.2.19.1 bool enable

Enable/disable LPO
Definition at line 663 of file clock_S32K1xx.h.

16.9.2.19.2 bool initialize

Initialize or not the PMC LPO settings.
Definition at line 662 of file clock_S32K1xx.h.

16.9.2.19.3 int8_t trimValue

LPO trimming value

Definition at line 664 of file clock_S32K1xx.h.
16.9.2.20 struct pmc_config_t

PMC configure structure. Implements pmc_config_t_Class.

Definition at line 671 of file clock_S32K1xx.h.
Data Fields

» pmc_lpo_clock_config_t IpoClockConfig

Field Documentation
16.9.2.20.1 pmec_Ipo_clock_config_t IpoClockConfig

Low Power Clock configuration.

Definition at line 673 of file clock_S32K1xx.h.
16.9.2.21 struct clock_manager_user_config_t

Clock configuration structure. Implements clock_manager_user_config_t_Class.

Definition at line 680 of file clock_S32K1xx.h.
Data Fields

+ scg_config_t scgConfig

+ sim_clock_config_t simConfig
* pcc_config_t pccConfig

» pmc_config_t pmcConfig
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Field Documentation
16.9.2.21.1 pcc_config_t pccConfig

PCC Clock configuration.
Definition at line 684 of file clock_S32K1xx.h.

16.9.2.21.2 pmc_config_t pmcConfig

PMC Clock configuration.
Definition at line 685 of file clock_S32K1xx.h.

16.9.2.21.3 scg_config_t scgConfig

SCG Clock configuration.
Definition at line 682 of file clock_S32K1xx.h.

16.9.2.21.4 sim_clock_config_t simConfig

SIM Clock configuration.
Definition at line 683 of file clock_S32K1xx.h.

16.9.2.22 struct module_clk_config_t

module clock configuration. Implements module_clk_config_t_Class

Definition at line 720 of file clock_S32K1xx.h.

Data Fields

* bool gating
 clock_names_t source
e uint16_t mul
* uint16_t div

Field Documentation

16.9.2.22.1 uint16_t div

Divider (some modules don't have divider)

Definition at line 725 of file clock_S32K1xx.h.
16.9.2.22.2 bool gating

Clock gating.
Definition at line 722 of file clock_S32K1xx.h.

16.9.2.22.3 uint16_t mul

Multiplier (some modules don't have fractional)

Definition at line 724 of file clock_S32K1xx.h.
16.9.2.22.4 clock_names_t source

Clock source input (some modules don't have protocol clock)

Definition at line 723 of file clock_S32K1xx.h.
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16.9.2.23 struct sys_clk_config_t

System clock configuration. Implements sys_clk_config_t_Class.

Definition at line 733 of file clock_S32K1xx.h.

Data Fields

 clock_names_t src
* uint16_t dividers [SYS_CLK_MAX_NO]

Field Documentation
16.9.2.23.1 uint16_t dividers[SYS_CLK_MAX_NO]

System clock dividers. Value by which system clock is divided. 0 means that system clock is not divided.

Definition at line 736 of file clock_S32K1xx.h.
16.9.2.23.2 clock_names_t src

System clock source.

Definition at line 735 of file clock_S32K1xx.h.
16.9.2.24 struct clock_source_config_t

Clock source configuration. Implements clock_source_config_t_Class.

Definition at line 743 of file clock_S32K1xx.h.

Data Fields

* bool enable

» xosc_ref_t refClk
 uint32_t refFreq

e uint16_t mul

e uint16_t div

* uint16_t outputDiv1
* uint16_t outputDiv2

Field Documentation
16.9.2.24.1 uint16_t div

Divider. It applies to PLL clock sources. Valid range is 1-8.

Definition at line 749 of file clock_S32K1xx.h.
16.9.2.24.2 bool enable

Enable/disable clock source.

Definition at line 745 of file clock_S32K1xx.h.
16.9.2.24.3 uint16_t mul

Multiplier. It applies to PLL clock sources. Valid range is 16 - 47.
Definition at line 748 of file clock_S32K1xx.h.

16.9.2.24.4 uint16_t outputDiv1

First output divider. It's used as protocol clock by modules. Zero means that divider is disabled. / Possible values
O(disabled), 1, 2, 4, 8, 16, 32, 64; all the other values are not valid. /
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Definition at line 751 of file clock_S32K1xx.h.
16.9.2.24.5 uint16_t outputDiv2

Second output divider. It's used as protocol clock by modules. Zero means that divider is disabled. / Possible values
O(disabled), 1, 2, 4, 8, 16, 32, 64; all the other values are not valid. /

Definition at line 754 of file clock_S32K1xx.h.
16.9.2.24.6 xosc_ref trefClk

Bypass option. It applies to external oscillator clock sources

Definition at line 746 of file clock_S32K1xx.h.
16.9.2.24.7 uint32_t refFreq

Frequency of the input reference clock. It applies to external oscillator clock sources

Definition at line 747 of file clock_S32K1xx.h.
16.9.2.25 struct clock_notify_struct_t

Clock notification structure passed to clock callback function. Implements clock_notify_struct_t_Class.

Definition at line 797 of file clock_S32K1xx.h.
Data Fields

« uint8_t targetClockConfiglndex

« clock_manager_policy_t policy

« clock_manager_notify_t notify Type
Field Documentation

16.9.2.25.1 clock_manager_notify_t notifyType

Clock notification type.

Definition at line 801 of file clock_S32K1xx.h.
16.9.2.25.2 clock_manager_policy_t policy

Clock transition policy.

Definition at line 800 of file clock_S32K1xx.h.
16.9.2.25.3 uint8_t targetClockConfigindex

Target clock configuration index.

Definition at line 799 of file clock_S32K1xx.h.
16.9.2.26 struct clock_manager_callback_user_config_t

Structure for callback function and its parameter. Implements clock_manager_callback_user_config_t_Class.

Definition at line 814 of file clock _S32K1xx.h.
Data Fields

« clock_manager_callback_t callback
+ clock_manager_callback_type_t callbackType
« void * callbackData
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Field Documentation
16.9.2.26.1 clock_manager_callback_t callback

Entry of callback function.

Definition at line 816 of file clock_S32K1xx.h.
16.9.2.26.2 voidx callbackData

Parameter of callback function.

Definition at line 818 of file clock_S32K1xx.h.
16.9.2.26.3 clock_manager_callback_type_t callbackType

Callback type.
Definition at line 817 of file clock_S32K1xx.h.

16.9.2.27 struct clock_manager_state_t

Clock manager state structure. Implements clock_manager_state_t_Class.

Definition at line 825 of file clock_S32K1xx.h.

Data Fields

» clock_manager_user_config_t const xx configTable

+ uint8_t clockConfigNum

* uint8_t curConfigindex

« clock_manager_callback_user_config_t *x callbackConfig
* uint8_t callbackNum

 uint8_t errorCallbackindex

Field Documentation
16.9.2.27.1 clock_manager_callback_user_config_t:x callbackConfig

Pointer to callback table.

Definition at line 830 of file clock_S32K1xx.h.
16.9.2.27.2 uint8_t callbackNum

Number of clock callbacks.

Definition at line 831 of file clock_S32K1xx.h.
16.9.2.27.3  uint8_t clockConfigNum

Number of clock configurations.

Definition at line 828 of file clock _S32K1xx.h.
16.9.2.27.4 clock_manager_user_config_t constxx configTable

Pointer to clock configure table.

Definition at line 827 of file clock_S32K1xx.h.
16.9.2.27.5 uint8_t curConfigindex

Index of current configuration.

Definition at line 829 of file clock_S32K1xx.h.
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16.9.2.27.6 uint8_t errorCallbackindex

Index of callback returns error.

Definition at line 832 of file clock_S32K1xx.h.

16.9.3 Macro Definition Documentation

16.9.3.1 #define BUS_CLK_INDEX 1U
Definition at line 69 of file clock_S32K1xx.h.
16.9.3.2 #define CLK_SRC_FIRC 0x03U

SCGFIRCLK - Fast IRC Clock

Definition at line 591 of file clock_S32K1xx.h.

16.9.3.3 #define CLK_SRC_FIRC_DIV1 0x03U

SCGFIRCLK - Fast IRC Clock

Definition at line 595 of file clock_S32K1xx.h.

16.9.3.4 #define CLK_SRC_FIRC_DIV2 0x03U

SCGFIRCLK - Fast IRC Clock

Definition at line 599 of file clock_S32K1xx.h.

16.9.3.5 #define CLK_SRC_OFF 0x00U

Clock is off

Definition at line 588 of file clock _S32K1xx.h.

16.9.3.6 #define CLK_SRC_SIRC 0x02U

SCGIRCLK - Slow IRC Clock

Definition at line 590 of file clock_S32K1xx.h.

16.9.3.7 #define CLK_SRC_SIRC_DIV1 0x02U

SCGIRCLK - Slow IRC Clock

Definition at line 594 of file clock_S32K1xx.h.

16.9.3.8 #define CLK_SRC_SIRC_DIV2 0x02U

SCGIRCLK - Slow IRC Clock

Definition at line 598 of file clock _S32K1xx.h.

16.9.3.9 #define CLK_SRC_SOSC 0x01U

OSCCLK - System Oscillator Bus Clock

Definition at line 589 of file clock_S32K1xx.h.

16.9.3.10 #define CLK_SRC_SOSC_DIV1 0x01U

OSCCLK - System Oscillator Bus Clock

Definition at line 593 of file clock_S32K1xx.h.
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16.9.3.11 #define CLK_SRC_SOSC_DIV2 0x01U

OSCCLK - System Oscillator Bus Clock
Definition at line 597 of file clock_S32K1xx.h.

16.9.3.12 #define CLK_SRC_SPLL 0x06U

SCGPCLK System PLL clock
Definition at line 592 of file clock_S32K1xx.h.

16.9.3.13 #define CLK_SRC_SPLL_DIV1 0x06U

SCGPCLK System PLL clock
Definition at line 596 of file clock_S32K1xx.h.

16.9.3.14 #define CLK_SRC_SPLL_DIV2 0x06U

SCGPCLK System PLL clock
Definition at line 600 of file clock_S32K1xx.h.

16.9.3.15 #define CORE_CLK_INDEX 0U
Definition at line 68 of file clock_S32K1xx.h.
16.9.3.16 #define NUMBER_OF_TCLK_INPUTS 3U

TClIk clock frequency.
Definition at line 57 of file clock_S32K1xx.h.

16.9.3.17 #define SLOW_CLK_INDEX 2U
Definition at line 70 of file clock_S32K1xx.h.

16.9.3.18 #define SYS_CLK_MAX_NO 3U

The maximum number of system clock dividers and system clock divider indexes.

Definition at line 67 of file clock_S32K1xx.h.

16.9.4 Typedef Documentation

16.9.4.1 typedef status_t( clock_manager_callback_t) (clock_notify_struct_t xnotify, void xcallbackData)

Type of clock callback functions.

Definition at line 807 of file clock_S32K1xx.h.

16.9.4.2 typedef clock_manager_user_config_t clock_user_config_t

Definition at line 688 of file clock _S32K1xx.h.

16.9.4.3 typedef uint8_t peripheral_clock_source_t

PCC clock source select Implements peripheral_clock_source_t_Class.

Definition at line 586 of file clock_S32K1xx.h.

16.9.5 Enumeration Type Documentation
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16.9.5.1 enum clock_manager_callback_type_t

The callback type, indicates what kinds of notification this callback handles. Implements clock_manager_callback«
_type_t_Class.

Enumerator

CLOCK_MANAGER_CALLBACK_BEFORE Callback handles BEFORE notification.
CLOCK_MANAGER_CALLBACK_AFTER Callback handles AFTER notification.
CLOCK_MANAGER_CALLBACK_BEFORE_AFTER Callback handles BEFORE and AFTER notification

Definition at line 776 of file clock_S32K1xx.h.
16.9.5.2 enum clock_manager_notify_t

The clock notification type. Implements clock_manager_notify_t_Class.

Enumerator

CLOCK_MANAGER_NOTIFY_RECOVER Notify IP to recover to previous work state.
CLOCK_MANAGER_NOTIFY_BEFORE Notify IP that system will change clock setting.
CLOCK_MANAGER_NOTIFY_AFTER Notify IP that have changed to new clock setting.

Definition at line 765 of file clock_S32K1xx.h.
16.9.5.3 enum clock_manager_policy_t

Clock transition policy. Implements clock_manager_policy_t_Class.
Enumerator
CLOCK_MANAGER_POLICY_AGREEMENT Clock transfers gracefully.
CLOCK_MANAGER_POLICY_FORCIBLE Clock transfers forcefully.
Definition at line 787 of file clock_S32K1xx.h.

16.9.5.4 enum clock_trace src t

Debug trace clock source select Implements clock_trace_src_t_Class.

Enumerator

CLOCK_TRACE_SRC_CORE_CLK core clock
Definition at line 203 of file clock_S32K1xx.h.
16.9.5.5 enum peripheral_clock_divider_t

PCC divider value select Implements peripheral_clock_divider_t_Class.

Enumerator

DIVIDE_BY_ONE Divide by 1 (pass-through, no clock divide)
DIVIDE_BY _TWO Divide by 2

DIVIDE_BY _THREE Divide by 3

DIVIDE_BY _FOUR Divide by 4

DIVIDE_BY _FIVE Divide by 5

DIVIDE_BY_SIX Divide by 6

DIVIDE_BY_SEVEN Divide by 7

DIVIDE_BY _EIGTH Divide by 8

Definition at line 617 of file clock_S32K1xx.h.
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16.9.5.6 enum peripheral_clock_frac_t
PCC fractional value select Implements peripheral_clock_frac_t_Class.

Enumerator

MULTIPLY_BY_ONE Fractional value is zero
MULTIPLY_BY _TWO Fractional value is one

Definition at line 608 of file clock _S32K1xx.h.
16.9.5.7 enum pwr_modes_t
Power mode. Implements pwr_modes_t_Class.

Enumerator

NO_MODE
RUN_MODE
VLPR_MODE
HSRUN_MODE
STOP_MODE
VLPS_MODE
ALL _MODES

Definition at line 694 of file clock _S32K1xx.h.
16.9.5.8 enum scg_async_clock_div_t
SCG asynchronous clock divider value. Implements scg_async_clock_div_t_Class.

Enumerator

SCG_ASYNC_CLOCK_DISABLE Clock output is disabled.
SCG_ASYNC_CLOCK _DIV_BY_1 Divided by 1.
SCG_ASYNC _CLOCK_DIV_BY 2 Divided by 2.
SCG_ASYNC _CLOCK _DIV_BY 4 Divided by 4.
SCG_ASYNC_CLOCK_DIV_BY_8 Divided by 8.
SCG_ASYNC CLOCK _DIV_BY 16 Divided by 16.
SCG_ASYNC _CLOCK_DIV_BY_32 Divided by 32.
SCG_ASYNC _CLOCK _DIV_BY 64 Divided by 64.

Definition at line 312 of file clock_S32K1xx.h.
16.9.5.9 enum scg_clockout_src_t
SCG ClockOut type. Implements scg_clockout_src_t_Class.

Enumerator

SCG_CLOCKOUT_SRC_SCG_SLOW SCG SLOW.
SCG_CLOCKOUT_SRC_SOSC System OSC.
SCG_CLOCKOUT_SRC_SIRC Slow IRC.
SCG_CLOCKOUT_SRC_FIRC Fast IRC.
SCG_CLOCKOUT_SRC_SPLL System PLL.

Definition at line 297 of file clock_S32K1xx.h.
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16.9.5.10 enum scg_firc_range_t

SCG fast IRC clock frequency range. Implements scg_firc_range_t_Class.

Enumerator

SCG_FIRC_RANGE_48M Fast IRC is trimmed to 48MHz.
Definition at line 423 of file clock_S32K1xx.h.
16.9.5.11 enum scg_sirc_range_t
SCG slow IRC clock frequency range. Implements scg_sirc_range_t_Class.
Enumerator
SCG_SIRC_RANGE_HIGH Slow IRC high range clock (8 MHz).
Definition at line 396 of file clock_S32K1xx.h.
16.9.5.12 enum scg_sosc_ext_ref _t

SCG OSC external reference clock select. Implements scg_sosc_ext_ref_t_Class.

Enumerator

SCG_SOSC _REF_EXT External reference clock requested
SCG_SOSC_REF_OSC Internal oscillator of OSC requested.

Definition at line 360 of file clock_S32K1xx.h.
16.9.5.13 enum scg_sosc_gain_t

SCG OSC high gain oscillator select. Implements scg_sosc_gain_t_Class.

Enumerator

SCG_SOSC_GAIN_LOW Configure crystal oscillator for low-power operation
SCG _SOSC _GAIN_HIGH Configure crystal oscillator for high-gain operation

Definition at line 350 of file clock_S32K1xx.h.
16.9.5.14 enum scg_sosc_monitor_mode_t

SCG system OSC monitor mode. Implements scg_sosc_monitor_mode_t_Class.

Enumerator

SCG_SOSC_MONITOR_DISABLE Monitor disable.
SCG_SOSC_MONITOR_INT Interrupt when system OSC error detected.
SCG _SOSC_MONITOR_RESET Reset when system OSC error detected.

Definition at line 329 of file clock_S32K1xx.h.
16.9.5.15 enum scg_sosc_range_t

SCG OSC frequency range select Implements scg_sosc_range_t_Class.

Enumerator

SCG_SOSC_RANGE_MID Medium frequency range selected for the crystal OSC (4 Mhz to 8 Mhz).
SCG_SOSC_RANGE_HIGH High frequency range selected for the crystal OSC (8 Mhz to 40 Mhz).

Definition at line 340 of file clock_S32K1xx.h.
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16.9.5.16 enum scg_spll_clock_multiply_t

SCG system PLL multiplier.

Enumerator

SCG_SPLL _CLOCK _MULTIPLY_BY_16
SCG_SPLL _CLOCK_MULTIPLY _BY 17
SCG_SPLL_CLOCK_MULTIPLY_BY_18
SCG_SPLL CLOCK _MULTIPLY _BY 19
SCG_SPLL_CLOCK_MULTIPLY_BY_20
SCG_SPLL_CLOCK_MULTIPLY_BY 21
SCG_SPLL CLOCK_MULTIPLY_BY 22
SCG_SPLL_CLOCK_MULTIPLY_BY_23
SCG_SPLL CLOCK MULTIPLY_BY 24
SCG_SPLL_CLOCK_MULTIPLY_BY 25
SCG_SPLL_CLOCK_MULTIPLY_BY_26
SCG_SPLL _CLOCK_MULTIPLY_BY 27
SCG_SPLL_CLOCK_MULTIPLY_BY_28
SCG_SPLL _CLOCK _MULTIPLY_BY 29
SCG_SPLL_CLOCK_MULTIPLY_BY_30
SCG_SPLL_CLOCK_MULTIPLY_BY_31
SCG_SPLL CLOCK _MULTIPLY _BY 32
SCG_SPLL_CLOCK_MULTIPLY_BY_33
SCG_SPLL _CLOCK _MULTIPLY_BY 34
SCG_SPLL_CLOCK_MULTIPLY_BY_35
SCG_SPLL_CLOCK_MULTIPLY_BY_36
SCG_SPLL CLOCK_MULTIPLY _BY 37
SCG_SPLL_CLOCK_MULTIPLY_BY_38
SCG_SPLL_CLOCK_MULTIPLY_BY 39
SCG_SPLL_CLOCK_MULTIPLY_BY 40
SCG_SPLL_CLOCK_MULTIPLY_BY_41
SCG_SPLL CLOCK _MULTIPLY_BY 42
SCG_SPLL_CLOCK_MULTIPLY_BY_ 43
SCG_SPLL _CLOCK _MULTIPLY_BY 44
SCG_SPLL _CLOCK_MULTIPLY_BY 45
SCG_SPLL_CLOCK_MULTIPLY_BY_46
SCG_SPLL _CLOCK_MULTIPLY_BY 47

Definition at line 478 of file clock_S32K1xx.h.
16.9.5.17 enum scg_spll_clock_prediv_t

SCG system PLL predivider.

Enumerator

SCG_SPLL_CLOCK_PREDIV_BY_1
SCG_SPLL_CLOCK_PREDIV_BY 2
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SCG_SPLL_CLOCK_PREDIV_BY 3
SCG_SPLL_CLOCK_PREDIV_BY_4
SCG_SPLL_CLOCK_PREDIV_BY 5
SCG_SPLL_CLOCK_PREDIV_BY_6
SCG_SPLL_CLOCK_PREDIV_BY_7
SCG_SPLL _CLOCK_PREDIV_BY 8

Definition at line 462 of file clock_S32K1xx.h.
16.9.5.18 enum scg_spll_monitor_mode_t

SCG system PLL monitor mode. Implements scg_spll_monitor_mode_t_Class.

Enumerator

SCG_SPLL_MONITOR_DISABLE Monitor disable.
SCG_SPLL_MONITOR_INT Interrupt when system PLL error detected.
SCG_SPLL _MONITOR_RESET Reset when system PLL error detected.

Definition at line 451 of file clock_S32K1xx.h.
16.9.5.19 enum scg_system_clock_div_t

SCG system clock divider value. Implements scg_system_clock_div_t_Class.

Enumerator

SCG_SYSTEM_CLOCK_DIV_BY_1 Divided by 1.
SCG_SYSTEM_CLOCK_DIV_BY_2 Divided by 2.

SCG_SYSTEM_CLOCK _DIV_BY 3
SCG_SYSTEM_CLOCK_DIV_BY 4
SCG_SYSTEM_CLOCK _DIV_BY 5
SCG_SYSTEM_CLOCK_DIV_BY_6
SCG_SYSTEM_CLOCK_DIV_BY 7
SCG_SYSTEM_CLOCK_DIV_BY_ 8
SCG_SYSTEM_CLOCK_DIV_BY_9
SCG_SYSTEM_CLOCK_DIV_BY 10
SCG_SYSTEM_CLOCK_DIV_BY_11
SCG_SYSTEM_CLOCK _DIV_BY 12
SCG_SYSTEM_CLOCK_DIV_BY 13
SCG_SYSTEM_CLOCK_DIV_BY_14
SCG_SYSTEM_CLOCK_DIV_BY 15
SCG_SYSTEM_CLOCK_DIV_BY_16

Divided by 3.
Divided by 4.
Divided by 5.
Divided by 6.
Divided by 7.
Divided by 8.
Divided by 9.

Divided by 10.
Divided by 11.
Divided by 12.
Divided by 13.
Divided by 14.
Divided by 15.
Divided by 16.

Definition at line 256 of file clock_S32K1xx.h.
16.9.5.20 enum scg_system_clock_src_t

SCG system clock source. Implements scg_system_clock_src_t_Class.

Enumerator

SCG_SYSTEM_CLOCK_SRC_SYS_0OSC System OSC.
SCG_SYSTEM_CLOCK_SRC_SIRC Slow IRC.
SCG_SYSTEM_CLOCK_SRC_FIRC Fast IRC.
SCG_SYSTEM_CLOCK_SRC _NONE MAX value.

Definition at line 241 of file clock_S32K1xx.h.
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16.9.5.21 enum sim_clkout_div_t

SIM CLKOUT divider Implements sim_clkout_div_t_Class.

Enumerator
SIM_CLKOUT_DIV_BY 1 Divided by 1
SIM_CLKOUT_DIV_BY _2 Divided by 2
SIM_CLKOUT_DIV_BY_3 Divided by 3
SIM_CLKOUT_DIV_BY 4 Divided by 4
SIM_CLKOUT_DIV_BY_5 Divided by 5
SIM_CLKOUT_DIV_BY_6 Divided by 6
SIM_CLKOUT_DIV_BY_7 Divided by 7
SIM_CLKOUT_DIV_BY_8 Divided by 8

Definition at line 125 of file clock_S32K1xx.h.
16.9.5.22 enum sim_clkout_src_t

SIM CLKOUT select Implements sim_clkout_src_t_Class.

Enumerator
SIM_CLKOUT_SEL_SYSTEM_SCG_CLKOUT SCG CLKOUT
SIM_CLKOUT_SEL_SYSTEM_SOSC _DIV2 CLK SOSC DIV2 CLK
SIM_CLKOUT_SEL_SYSTEM_SIRC_DIV2 CLK SIRC DIV2 CLK
SIM_CLKOUT_SEL_SYSTEM_FIRC_DIV2 CLK FIRC DIV2 CLK
SIM_CLKOUT_SEL_SYSTEM_HCLK HCLK
SIM_CLKOUT_SEL_SYSTEM_SPLL_DIV2 CLK SPLL DIV2 CLK
SIM_CLKOUT_SEL_SYSTEM_BUS CLK BUS_CLK
SIM_CLKOUT_SEL_SYSTEM_LPO_128K_CLK LPO_CLK 128 Khz
SIM_CLKOUT_SEL_SYSTEM_LPO_CLK LPO_CLK as selected by SIM LPO CLK Select
SIM_CLKOUT_SEL_SYSTEM_RTC_CLK RTC CLK as selected by SIM CLK 32 KHz Select

Definition at line 100 of file clock_S32K1xx.h.
16.9.5.23 enum sim_Ipoclk_sel_src_t
SIM LPOCLKSEL clock source select Implements sim_Ipoclk_sel_src_t_Class.
Enumerator
SIM_LPO_CLK_SEL_LPO_128K 128 kHz LPO clock
SIM_LPO_CLK_SEL_NO_CLOCK No clock

SIM_LPO_CLK_SEL_LPO_32K 32 kHz LPO clock which is divided by the 128 kHz LPO clock
SIM_LPO_CLK_SEL_LPO_1K 1 kHz LPO clock which is divided by the 128 kHz LPO clock

Definition at line 88 of file clock_S32K1xx.h.

Generated on Fri Jun 11 2021 08:14:09 for S32SDK User Manual by Doxygen



16.9 Clock Manager Driver 229

16.9.5.24 enum sim_rtc_clk_sel_src_t
SIM CLK32KSEL clock source select Implements sim_rtc_clk_sel_src_t_Class.
Enumerator
SIM_RTCCLK_SEL_SOSCDIV1_CLK SOSCDIV1 clock
SIM_RTCCLK_SEL_LPO 32K 32 kHz LPO clock

SIM_RTCCLK_SEL_RTC_CLKIN RTC_CLKIN clock
SIM_RTCCLK_SEL_FIRCDIV1_CLK FIRCDIV1 clock

Definition at line 76 of file clock_S32K1xx.h.

16.9.5.25 enum xosc_ref t

XOSC reference clock select (internal oscillator is bypassed or not) Implements xosc_ref _t_Class.
Enumerator

XOSC_EXT_REF Internal oscillator is bypassed, external reference clock requested.

XOSC_INT_OSC Internal oscillator of XOSC requested.

Definition at line 711 of file clock_S32K1xx.h.

16.9.6 Function Documentation

16.9.6.1 void CLOCK_DRV_GetSystemClockSource ( sys_clk_config_t x sysClkConfig )
Gets the system clock source.

This function gets the current system clock source.

Returns

Value of the current system clock source.

Definition at line 3713 of file clock_S32K1xx.c.

16.9.6.2 status_t CLOCK_DRV_SetClockSource ( clock_names_t clockSource, const clock_source_config_t x
clkSrcConfig )
This function configures a clock source.

The clock source is configured based on the provided configuration. All values from the previous configuration of
clock source are overwritten. If no configuration is provided, then a default one is used.

Parameters
in clockSource | Clock name of the configured clock source
in clkSrcConfig | Pointer to the configuration structure
Returns

Status of clock source initialization

Definition at line 4065 of file clock_S32K1xx.c.
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16.9.6.3 void CLOCK_DRV_SetModuleClock ( clock_names_t peripheralClock, const module_clk_config_t x
moduleClkConfig )

Configures module clock.

This function configures a module clock according to the configuration. If no configuration is provided (moduleClk«
Config is null), then a default one is used moduleClkConfig must be passed as null when module doesn't support
protocol clock.
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Parameters
in peripheralClock | Clock name of the configured module clock
in moduleClk«— | Pointer to the configuration structure.
Config

Definition at line 3490 of file clock_S32K1xx.c.
16.9.6.4 status_t CLOCK_DRV_SetSystemClock ( const pwr_modes_t « mode, const sys_clk_config_t x sysClkConfig )

Configures the system clocks.

This function configures the system clocks (core, bus and flash clocks) in the specified power mode. If no power
mode is specified (null parameter) then it is the current power mode.

Parameters
in mode | Pointer to power mode for which the configured system clocks apply
in sysClkConfig | Pointer to the system clocks configuration structure.

Definition at line 3644 of file clock_S32K1xx.c.
16.9.6.5 uint8_t CLOCK_SYS_GetCurrentConfiguration ( void )
Get current system clock configuration.

Returns

Current clock configuration index.
Definition at line 4292 of file clock_S32K1xx.c.
16.9.6.6 clock_manager_callback_user_config_t« CLOCK_SYS_GetErrorCallback ( void )

Get the callback which returns error in last clock switch.

When graceful policy is used, if some IP is not ready to change clock setting, the callback will return error and
system stay in current configuration. Applications can use this function to check which IP callback returns error.

Returns

Pointer to the callback which returns error.
Definition at line 4304 of file clock_S32K1xx.c.
16.9.6.7 status_t CLOCK_SYS_GetFreq ( clock_names_t clockName, uint32_t « frequency )

Wrapper over CLOCK_DRV_GetFreq function. It's part of the old API.

Parameters
in clockName | Clock names defined in clock_names_t
out frequency | Returned clock frequency value in Hertz
Returns

status Error code defined in status_t

Definition at line 4327 of file clock_S32K1xx.c.

16.9.6.8 status_t CLOCK_SYS_Init ( clock_manager_user_config_t const xx clockConfigsPtr, uint8_t configsNumber,
clock_manager_callback_user_config_t «x callbacksPtr, uint8_t callbacksNumber )

Install pre-defined clock configurations.

This function installs the pre-defined clock configuration table to clock manager.
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Parameters
in clockConfigsPtr | Pointer to the clock configuration table.
in configsNumber | Number of clock configurations in table.
in callbacksPtr | Pointer to the callback configuration table.
in callbacks«— | Number of callback configurations in table.

Number

Returns

Error code.

Definition at line 4140 of file clock_S32K1xx.c.
16.9.6.9 status_t CLOCK_SYS_SetConfiguration ( clock_manager_user_config_t const x config )

Set system clock configuration.

This function sets the system to target configuration, it only sets the clock modules registers for clock mode change,
but not send notifications to drivers. This function is different by different SoCs.

Parameters

in config | Target configuration.

Returns

Error code.

Note

If external clock is used in the target mode, please make sure it is enabled, for example, if the external oscillator
is used, please setup EREFS/HGO correctly and make sure OSCINIT is set. This function should be called
only on run mode.

Definition at line 4339 of file clock_S32K1xx.c.
16.9.6.10 status_t CLOCK_SYS_UpdateConfiguration ( uint8_t fargetConfigindex, clock_manager_policy_t policy )

Set system clock configuration according to pre-defined structure.

This function sets system to target clock configuration; before transition, clock manager will send notifications to all
drivers registered to the callback table. When graceful policy is used, if some drivers are not ready to change, clock
transition will not occur, all drivers still work in previous configuration and error is returned. When forceful policy is
used, all drivers should stop work and system changes to new clock configuration. The function should be called
only on run mode.

Parameters
in targetConfig— | Index of the clock configuration.
Index
in policy | Transaction policy, graceful or forceful.
Returns
Error code.
Note

If external clock is used in the target mode, please make sure it is enabled, for example, if the external oscillator
is used, please setup EREFS/HGO correctly and make sure OSCINIT is set.

Definition at line 4173 of file clock_S32K1xx.c.
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16.9.7 Variable Documentation

16.9.7.1 uint32_t g_RtcClkinFreq

RTC_CLKIN clock frequency.

Definition at line 81 of file clock_S32K1xx.c.
16.9.7.2 uint32_t g_TClkFreqNUMBER_OF_TCLK_INPUTS]

TCLKXx clocks
Definition at line 78 of file clock_S32K1xx.c.

16.9.7.3 uint32_t g_xtal0ClkFreq

EXTALDO clock frequency.
Definition at line 84 of file clock_S32K1xx.c.

16.9.7.4 const uint8_t peripheralFeaturesListfCLOCK_NAME_COUNT]

Peripheral features list Constant array storing the mappings between clock names of the peripherals and feature
lists.

Definition at line 432 of file clock_S32K1xx.c.
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16.10 Common Core API.
16.10.1 Detailed Description

This group contains general core APIs that used for both protocol LIN 2.1 and J2602.

Modules

* Driver and cluster management

APl perform the initialization of the LIN core.
* Interface management

This group contains APls that help users manage interface(s) in LIN node.
+ Notification

This group contains APls that let users know when a signal’s value changed.
+ Schedule management

This group contains APIs that help users manage schedule tables in master node only.
+ Signal interaction

This group contains APls that help users interract with signals of LIN node.
» User provided call-outs

This group contains APIs which may be called from within the LIN module in order to enable/disable LIN communica-
tion interrupts.

Macros

+ #define SAVE_CONFIG_SET 0x0040U

* #define EVENT_TRIGGER_COLLISION_SET 0x0020U
+ #define BUS_ACTIVITY_SET 0x0010U

+ #define GO_TO_SLEEP_SET 0x0008U

+ #define OVERRUN 0x0004U

* #define SUCCESSFULL_TRANSFER 0x0002U

+ #define ERROR_IN_RESPONSE 0x0001U

16.10.2 Macro Definition Documentation

16.10.2.1 #define BUS_ACTIVITY_SET 0x0010U

Bus activity

Definition at line 32 of file lin_common_api.h.
16.10.2.2 #define ERROR_IN_RESPONSE 0x0001U

Error in response

Definition at line 36 of file lin_common_api.h.
16.10.2.3 #define EVENT_TRIGGER_COLLISION_SET 0x0020U

Event triggered frame collision

Definition at line 31 of file lin_common_api.h.
16.10.2.4 #define GO_TO_SLEEP_SET 0x0008U

Go to sleep

Definition at line 33 of file lin_common_api.h.
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16.10.2.5 #define OVERRUN 0x0004U

Overrun

Definition at line 34 of file lin_common_api.h.
16.10.2.6 #define SAVE_CONFIG_SET 0x0040U

Save configuration

Definition at line 30 of file lin_common_api.h.
16.10.2.7 #define SUCCESSFULL_TRANSFER 0x0002U

Successful transfer

Definition at line 35 of file lin_common_api.h.
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16.11 Common Transport Layer API
16.11.1 Detailed Description

Contains Transport Layer APIs that used for both protocols LIN 2.1 and J2602.

Modules

« Cooked API
Cooked processing of diagnostic messages manages one complete message at a time.
* Initialization
Initialize transport layer (queues, status, ...).
* Raw API
The raw APl is operating on PDU level and it is typically used to gateway PDUs between CAN and LIN.

Macros

- #define LD_READ_OK 0x33U

« #define LD_LENGTH_TOO_SHORT 0x34U

- #define LD_DATA_ERROR 0x43U

- #define LD_LENGTH_NOT_CORRECT 0x44U
« #define LD_SET OK 0x45U

- #define SERVICE_TARGET RESET 0xB5U

- #define RES_POSITIVE 0x40U

« #define LIN_PRODUCT _ID 0x00U

« #define LIN_SERIAL_NUMBER 0x01U

- #define LD_BROADCAST 0x7FU

- #define LD_FUNCTIONAL_NAD 0x7EU

- #define LD_ANY_SUPPLIER Ox7FFFU

- #define LD_ANY_FUNCTION OxFFFFU

- #define LD_ANY_ MESSAGE OxFFFFU

- #define RES_NEGATIVE 0x7FU

- #define GENERAL_REJECT 0x10U

- #define SERVICE_NOT_SUPPORTED 0x11U
« #define SUBFUNCTION_NOT SUPPORTED 0x12U
- #define NEGATIVE 0U

- #define POSITIVE 1U

« #define TRANSMITTING 0U

« #define RECEIVING 1U

- #define DIAG_SERVICE_CALLBACK_HANDLER(iii, sid) lin_diag_service_callback((iii), (sid))

Functions

+ void lin_diag_service_callback (I_ifc_handle iii, |_u8 sid)

16.11.2 Macro Definition Documentation

16.11.2.1 #define DIAG_SERVICE_CALLBACK_HANDLER( iii, sid )lin_diag_service_callback((iii), (sid))

Definition at line 86 of file lin_commontl_api.h.
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16.11.2.2 #define GENERAL_REJECT 0x10U

Error code raised when request for service not supported comes

Definition at line 71 of file lin_commontl_api.h.
16.11.2.3 #define LD_ANY_FUNCTION OxFFFFU

Function

Definition at line 66 of file lin_commontl_api.h.
16.11.2.4 #define LD_ANY_MESSAGE 0xFFFFU

Message

Definition at line 67 of file lin_commontl_api.h.
16.11.2.5 #define LD_ANY_SUPPLIER 0x7FFFU

Supplier

Definition at line 65 of file lin_commont|_api.h.
16.11.2.6 #define LD_BROADCAST 0x7FU

Broadcast NAD

Definition at line 63 of file lin_commontl_api.h.
16.11.2.7 #define LD_DATA_ERROR 0x43U

Data error

Definition at line 50 of file lin_commontl_api.h.
16.11.2.8 #define LD_FUNCTIONAL_NAD 0x7EU

Functional NAD

Definition at line 64 of file lin_commont|_api.h.
16.11.2.9 #define LD_LENGTH_NOT_CORRECT 0x44U

Length not correct

Definition at line 51 of file lin_commontl_api.h.
16.11.2.10 #define LD_LENGTH_TOO_SHORT 0x34U

Length too short

Definition at line 48 of file lin_commontl_api.h.
16.11.2.11  #define LD_READ_OK 0x33U

Read OK

Definition at line 47 of file lin_commontl_api.h.
16.11.2.12  #define LD_SET_OK 0x45U

Set OK

Definition at line 52 of file lin_commontl_a